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FOREWORD

The Punjab Cwriculum Framework (PCF 2013) which is based on National
Curriculum Framework (NCF) 2005 recommends that the child's knowledge must be
connected to their life outside the school, It indicates a departure from the legacy of
bookish learning and ensures that lecarning is shifted from rote methods to activity based

learning and also provides an opportunity for the holistic development of the students.

Over the years, Computer Science as a discipline has evolved and emerged asa
driving force for socio-economic activities, Computer technologies are widely used in
diverse arcas of modern life such as education, business, health, transport and all other
sectors also, With the advent of computer and communication technologies, there has
been a paradigm shift in teaching at the school level. The role and relevance of this
discipline 1s in focus because the expectations from the school pass-outs have grown Lo
meet the challenges of the contemporary world. Today, we are living in an
mterconnected world where computer-based applications influence the way we learn,
communicate, commute or even socialise in day to day life.

Keeping in view these requirements, Punjab School Education Board has
introduced Computer Science as a compulsory subject from class 6th to 12th as per
guidelines of Punjab Government. Every eflort has been made to include each requisite
information according to level of class 12th in this book. | hope it will be useful for
students and teachers.

This book focuses on the fundamental concepts and problem-solving skills
while opening a window to the emerging and advanced areas of computer science. The
newly developed syllabus has dealt with the dual challenge of reducing curricular load
as well as introducing this everevolving discipline.

Punjab School Education Board welcomes and look forward to feedback and
suggestions for the improvement of its subsequent editions.

Chairman
Punjab School Education Board
(iii)
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OFFICE AUTOMATION

m & TYPING

OBJECTIVES OF THIS CHAPTER

1.1  Word Processor

1.2 Document Writing and Editing in MS Word
1.3 Working with Fonts

1.4  Proofing

1.5 Find and Replace

1.6  Page Setup

1.7 Page Borders

1.8 Print Preview & Print

1.9  MS Excel - Spread sheet Soliware
1.10 Formula Bar

1.11  Working with Formulas

1.12 Working with Functions

1.13  Border and Shading

1.14 Custom Filter

1.15 Custom Sort

1.16 Freeze Panes

1.17 Page Setup and Printing Options
1.18 File Conversion

1.19  Typing Technique

1.20 Font Conversion Tools

INTRODUCTION

(Office automation refers to the integration of office functions usually related to managing
information. Raw data storage, electronic data transfer and the management of electronic
business information comprise the basic activities of an office automation system. It involves
using computers and software to digilize, store, process and communicale most routine tasks
and processes in a standard office. Most common and user friendly software and tools in
offices are word processors and electronic spread sheets.
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1.1 WORD PROCESSOR
A word processor is a software that allows users to create, edit and print documents. It
enables us to write text, store il electronically, display it on a screen, modify it by entering

commands and characters from the keyboard and print it,
1.1.1 MS Word

In previous classes, we have already studied about various features of M5 Word such as
creating, editing and formatting a document, inserting tables, pictures, used the feature of mail
merge. spell- check and thesaurus etc. and also leamt to create a resume document. Microsoft
Word ¢an be used for the following purposes:

«  To create business documents having various graphics including pictures, charts, and

diagrams.

= To store and reuse readymade content and formatted elements such as cover pages

and sidebars.

«  To create letterheads for personal and business purpose.

«  To design different documents such as resumes or invitation cards etc.

Microsoft Word allows us to create professional-quality documents, reports, letters and
resumes. Unlike a plain text editor, Microsoft Word has features including spell check, graramar
check, text and font formatting, HTML support, image support, advanced page layout and

many more setlings.

1.2 DOCUMENT WRITING AND EDITING IN MS WORD
Editing a word file is one of the most basic MS office word operations. Editing a word file
means making changes in the contents of in the existing document. Evervone needs to edit a
word document at some point or other to incorporate the changes which may arise from time to
time.
Editing a Word Document covers these basic concepts:
»  Adding new text : To add text in a document, place the cursor at the required portion
and start typing.
. Deleting a part of the text : Select the text that you want to delete and just press the
Del/Backspace key from the keyboard.
«  Copy-Paste a text : Select the text that you want to copy and then use Copy (Ctrl+C)
and Paste (Cirl+V) commands.
= Moving text : Select the text that you want to move and then use Cut (Ctrl+X) and
Paste (Ctrl+V) commands to move the text.
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Formaitting text : Formatting refers to changing the font style, size{Ctl+[ and Cirl+]),
color, hold (Ctrl+B), italic (Ctrl+I), underline (Ctrl+U) and other related parameters.
We can also use Format Pamter option available at Home tab to apply existing formats
to other text. To clear the existing formats on the text, we can also use the Clear
Format (Ctrl+Space) option available at the Home tab ribbon.

Alignment : Alignment determines the appearance and orientation of the edges of the
text of paragraph. There are four types of paragraph alignment you can set within
Word: Left (Ctrl+L), Center (Ctrl+E), Right (Corl+R) and Justify (Ctrl+lI).

Line Spacing : Tt is the space between each line in a paragraph. Word allow you to
customize the line spacing to be single spaced (Ctrl+1), double spaced (Ctrl+2), one
and half line spaced (Ctrl+5) or any other amount you want.

Bullets and Numbering : These options are used to make bulleted (Ctrl+Shift+1.)
and numbered lists in the documents.

1.3 WORKING WITH FONTS
A font is a graphical representation of text that may include different typeface, point, size

or color. We can change the font of text in a document using different ways:

1.3.1 Change the Font
Click the Font drop down Menu in Font Group of Home tab and Select the desired Font.

‘mmmﬂu A A | A | W 5{
Theme Fonts -
Cambria (Headings) | =
Calilbri Body)
All Fonts
(}_Adobe Arabic Sad oal |
Fig, 1.1

1.3.2 Change the Default Font Settings

Go to Home, and then select the Font Dialog Box Launcher or use keyboard shortcut key
Ctrl+Shift+F or Ctrl+D to open the Font dialog box:

We can set the font, font style (normal, bold, italic etc.) and font size using this dialog

box as shown in the figure 1.2.

Font Color : We can change the color of the font as per our requirement.

To change the color of text:

. Select the text whose color you want to change and open the Font dialog box
(Crl + O).

. Click the downwuard-pointing arrow of the Font Color option on the Formatting
toolbar. A color palette appears.

Orrice Automarion & Tyrma 3



. Click the color you want to apply.
Word changes the color of your text.

Fant ? b 4
Font | Adganced
Eont: Font styfe: b
IFH-',!“ el 1
- - . -~
Bk ﬁ 4 anl
Acdobe Arshic 10
b Caglon Pro Boled 1tabe F
dlobes Caslon Prio Bokd ¥ il o FENNE. <
Font color: Urderine styles Underkne color;
[ sueomete  [w] [(pone) [w] [ Avtomese  [&]
Effacis -
[ strigegwough [ Sl caps
[C] Dbt sriietiwanigh [ i caee
[ sugmrsaript [l Hidden
[ Suiaeript
Prmdew
+Body
This is tha body thema font. The ourent document theme defines which fonk will be used,
SetAsQefolt | | Textpffecs.., | [Tox || cne
Fig. 1.2

Underline Style : M5Word contain multiple types of Underline's styles. For changing
it, Click on the drop down option of underline style and select one.

Underline Color : Click Underline Color to change its color, you can pick one from
a color palette.

Effects : There are other options as well, like strikethrough, Double strikethrough,
superscript, subscript, shadow, outline, small caps, All caps and hidden. Thus, this
was all about basic editing in a word file.

After changing settings as per our requirement, we can also set them as default setting
of the document. To do this, click on = SetAspefault  button. Select one of the following:
. This document only.

All documents based on the Normal template.

. Now Click OK button.
1.4 PROOFING

Word can also proofread our document to highlight other

possible problems. such as misplaced commas or correctly

Page:10f1 | Words1 | B | F

spelled words that may be used incorrectly. To make word

proofread our document, follow these steps:

Prouml-.-gm

Fig. 1.3
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Click the Proofing icon at the bottom of the document window. Word highlights a possible
error and displays a pop-up menu offering options similar to the options displayed and then
chooze one of the following:

1.4.1 Auto Correct

To reach the Auto Correct optlions, click
on File, then Options, When the "Word Options™
Dialog box pops up, choose Proofing in the
sidebar. You can now click the "Auto Correct
Options" button. We will now see a list of words
that will be identified and replaced with a different

term,

Add entry to an Auto Correct list:

1.
2

4,

Go to the AutoCorrect tab.

In the Replace box, type a word or
phrase that you often misspell.

With in the box, type the correct
spelling of the word.

Select Add.

1.4.2 Spelling & Grammar
MS Word provides the feature to check the spelling & grammatical errors, It shows red

wavy underline for spelling errors and the green wavy underline for grammatical errors. The

latest wavy underline introeduced in Word is blue, which shows formatting inconsistencies.

tafgrmat
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[+7] Cagetation Bret lomer of talie et

(] Captatirm garmves of doye

] canrect noridenad usage af GAPS LOCK toy

[] mepacs st om v by
Bepace: W el Fareated led

o
. E:III“(:' L L

:

] mstamencay e saqgesmins froem the sping cucker

Fig. 1.4

To start a check of the spelling and grammar in ouwr file just press F7 (Spelling & Grammar
checker) or follow these steps:

L.
2.

Click the Review tab on the ribbon.

Click Spelling or Spelling & Grammar.

{a) If document contains finds
spelling mistakes, a dialog box
appears with the [irst
misspelled word found by the
spelling checker.

(b) After you decide how to
resolve the misspelling
{1gnoring 1t, adding it to the
program's dictionary, or
changing 1t), the program
moves to the next misspelled
word.,

Orrice Avrosmarion & Tyrmo
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1.5 FIND AND REPLACE "I

Find and Replace feature in Ms- Word
helps us to find words or formats in a document
and allow us to replace all instances of a word
or format. Tlus 1s particularly handy in long CLI I Ot
documents. We can use the following steps for

Fig. 1.6

this purpose:

1.

2
3.
4

Click on Replace option in the Editing Group of Home tab or press Cirl+H.
Enter the word or phrase you want to locate in the Find box.
Enter your new text in the Replace box.

Click Find Next until we come to the word we want to update and then click
Replace. To update all instances at once, click Replace AllL

1.6 PAGE SETUP (s}

Page Setup allows us to change the structure and layout of pages in a document. The "Page
Setup” group on the "Page Layout” tab contains buttons that allows us to make changes in the
page setup of document. We can also open the "Page Setup" dialog box by clicking on the

dialog box launcher (present in the lower right corner) of the "Page Setup” group of "Page

Layout" tab, This dialog box consists of three tabs: Margins, Paper and Layout.

1.6.1 Margins

A margin is the space between the text and
the edge of our document. By default, a new
documnent’s margins are set to Normal, which
means il has a one-inch space between the text
and each edge. Depending on our requirements,
Word allows us to change our document’s margin
size.

Steps to change page margins:

1. Click on the Margins tab in the Page

Setup Dialog box.

2. Set the Top, Bottom, Left and Right

margins as per our requirement.

3. Click OK.
1.6.2 Orientation

Page Orientation refers to the direction in
which a document 1s digplayed.

Margin
Tap 1 B pottom f2* !
O o I
o o [ Gatter posttion: Lot I~
Crentation
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Steps to Change Page Orientation:
1. Click on the Margins tab in the Page Setup Dialog box.

2. Set the page orientation - Portrait or Landscape as per requirement.
3. Click OK.

1.6.3 Paper Size

We can set the paper size of our document  [p o, ¥ 5
using this option. Paper size can be of Letter o | i
Size, A4 Size, and Legal Size etc. The default Wit

paper size in Microsoft Word is 8.5 x 11 |as 1+
inches -the standard size (called Letter size) e (827 ¥
Wooht: [1L60° 5]
To change the page size: Pt s
1. Click on the Paper tab in the Page Fﬁ__l fi"‘f‘f__l
Setup Dialog box.

2. Select the Paper size, For example; Fig. 1.8
A4, from the drop down menu.

3. Click OK.

1.7 PAGE BORDERS

MS- Word allows us to put a page border around the text in our document. We can also add
a border Lo either all the pages in our document or certain pages in our document. To add a page
border, put the cursor at the beginning of our document or at the beginning of an existing
section in our document. Then. click the "Design” tab.

«  In the Page Background group, click the Page Borders option.
«  In the Borders and Shading dialog box, click the Page Border (ab.
. Select the page border Setting as per requirement.

«  Select the Style of border we want
on the page, which can be solid,

dotted, or dashed. Sitwe . | -

«  Select the Color and Width of the D == = TS
border. If we want to select att work | L) ™ = =
to use as the border, click the down | B = - | s =
arrow for the Art drop-down menu. B» Mo =

+ By default, the borders are applied | [ @ e gl

to the whole document, which means . — i
every page has the same border. By
clicking the down arrow on Apply to

Fig. 1.9
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gives us the option to select the first page only, selected page, all pages except the first
page, and other options.

«  After setting the page border options. click on the OK button.

1.8 PRINT PREVIEW & PRINT
Print preview is a feature that displays on the screen what a hard copy would look like
when printed. Steps to preview our document are:
1. Click on the File tab.
2. When we click the Print (Ctrl+P) option, it will automatically show the preview of
our document.

7 = B T ol T T A 12th All Chapters - Microsoft Ward ﬂ - 8] x
Home impert Page Layowut Baferenges Rmmngy EEvE = = nrevaFDE FII'I'“{. | =]
we Lay ] : .
el Beve
2 Print -
[ Sawe s Il‘ll
. e Copar: 1 : A
o Oam Pricit P i P . .
i L: el o o e P (e e e S g R
- Printer !: :lr:-.:.h_— ot s T, i s T
ey
aub0F 8 1R
- - e
Regent 'ﬂ"-w}r’ Harm o
i P I r E = b L
o [ ———
Settings i ey
P —.
_ i Print Al Pages et
S “__| Puint ik entire document 1 N s ey "'"-"::"'L"""""
e e e e
Help Pant Ome Sided e
i & ol PR w1
5] Gk pret e anevide g, *_-;-----;*_;:F |
) Option - : TRl S
Cppy Sellated e ==
£ b 1, . " st
e B it o e
| ek i
|] porat ientstien iE iR b
a - .
LIrs N8
-
1 Moeml Masgirs - B o
] B lh:ht r T ol 48 ok B s |
Flg.1.10 [
Fig. 1.10

3. Now select printing options such as number of copies, page range, collate elc.
4, Now, click on the Print button to get the hardcopy of our document.

1.9 MS EXCEL-SPREADSHEET SOFTWARE ml

Microsofl Excel 15 a powerful electromic spreadsheet program used Lo create results, doing
mathematical calculations and representing data i pictonal view with the help of charts. We
can use it to automate accounting work, organize data, and perform a wide variety of tasks.
Excel is designed to perform calculations, analyse information, and visualize data in a
spreadsheet. Also, this application includes database and charting features,

8 ComMPUTER SCIENCE



1.10 FORMULA BAR

Formula Bar is one of the most important components in MS Excel. The Formula Bar is
the area at the top of the Excel window, just below the ribbon area or the Formatting toolbar,
The Formula Bar has two parts: Name Box at the left and right side are the contents of the
currently selected cell as shown below

Formula in Cell

FAR™ B R ot
Home Insart Page Layout Formulas Data Raye e novaPDH
Ty
= & Cut Calibri S TIRIE e | &+  SiwmpTe
“— 4 Copy ~ I |
Pa:'t! J Format Paintes LM E Or- ‘&- EE FF EH*H“&
Clipboard r] Font Alignment
, «a C A
| A 8 c D E F G H
SRR
2
Name Box 3|
Fig. 1.11

The formula bar gets activated as soon as you type an equal sign in any cell or chick
anywhere within the bar. The formula bar displays formulas located in cells rather than the
formula results. The formula bar can also be used to edit formulas or other data located in the
active cell by clicking on the data m the formula bar with the cursor. It can also be used to
modify the ranges for individual data series that are selected in an Excel chart.

1.11 WORKING WITH FORMULAS

Microsoft Excel is an electronic spread sheet that antomates the caleulations involved in
School resull, Grading & Students Fee ete, Formula always starls with = sign. Excel can
perform the mathematical calculations for you. You will leam how to create formulas and
functions to perform calculations in a spread sheet.

Example formulas are:
= D15+D18+D21, = B4-B12, = A10/B15, = (B16+C16)*1.07

When creating formulas, we may choose to either type the cell address or use the mouse to
select the cell address.

1.11.1 Mathematical Operators for Formulas +;tl-_

We can create any type of mathematical calculation on our own using the following
mathematical operators:

Orrice Automarion & Tyrma 9



= equals - used to begin a calculation

+ addition

- subtraction

* multiplication

/ division

o5 exponentiation

( open parenthesis - used to begin a grouping
)} close parenthesis - used Lo close a grouping

1.11.2 Basic steps for creating a formula

1. Click in the empty cell which will contamm the formula,

2. Type an equal sign (=).

3. Type the cell address or click the cell that contains the first number.

4. Type the math operator (+ - / * A).

5. Type the cell address or click the cell that contains the second number.

6. Continue in this manner until the formula is complete.

7. Use parenthesis for clanfication, A 8

8. Press the Enter key. '—;:

34

1.11.3 Manual Formula r""":':;

The given Figure shows the use of formula with cell references |27 T i esiqens

and mathematical operations.

1.12 WOREKING WITH FUNCTIONS

A Function provides an automated method for creating formulas. A function is a predefined
formula that performs calculations using specific values in a particular order. Excel includes
many common functions that can be used to quickly find the sum, average, count, maximum

value, and minimum value for a range of cells.

1.12.1 Steps for using a function

Select an empty cell.

2. Type an equal sign = and then type a functon.
For example, =SUM for getting the total

3. Type an opening parenthesis i.e. (

10
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=l
Fig. 1.13

4, Select the range of cells, and then type a closing parenthesis i.e. )
5. Press Enter to get the resull.

1.12.2 AutoSum Y,
Addition is the most common math operation performed in Excel. The Home ribbon

includes an AutoSum button for adding. This button provides a shortcut way for typing SUM

function in the current cell.

1.12.3 Commonly Used Functions

Now, let's discuss some commonly used functions:
1.12.3.1 SUM : The Excel SUM function returns the sum of values supplied. The SUM

function adds values. You can add individual values, cell references or ranges or a mix of all
three.
Syntax:
=SUM (numberl, [number2], [number3], ...)
Arguments:

numberl - The first value to sum

number2 - [optional] The second value to sum

number3 - [optional] The third value to sum

For example:

FAEAA[EETIEET D | E
112 25 56 =SUM{A1L:cC1)

It will add the values in cells Al to C1 (A1:C1) and show 93
1.12.3.2 COUNT : The COUNT function counts the number of cells that contain numbers,
It also counts numbers within the list of arguments. Use the COUNT function to get the number

of entries in 4 number field that is in a range or amray of numbers.
Syntax:
=COUNT (valuel, [value2], ...)

Orrice Automarion & Tyrma 11



Arguments:
valuel - An item, cell reference, or range
value2 - [optional] An item, cell reference, or range
For example:

A A eS| D ] E
112 25 56  =COUNT(ALCI)

It will count the numbers in the range A1:Cl and show 3

1.12.3.3 MAX : The Excel MAX function returns the largest numeric value in a range of
values. The MAX function ignores empty cells, the logical values TRUE and FALSE, and text
values.

Syntax:
=MAX (numberl, [number2], ...)
Arguments:
numberl - Number, reference to numeric value, or range that contains numeric
values

number2 - [optional] Number, reference to numeric value, or range that contains
numeric values
For example:

[ 4] A B C D E
112 25 56  =MAX{ALC1)

It will display the largest number in the range A1:C1, i.e. 56
1.12.34 MIN : The Excel MIN function retuns the smallest numeric value n a range of
values. The MIN function ignores empty cells, the logical values TRUE and FALSE, and text
values.
Syntax:
=MIN (numberl, [number2], ..)
Arguments:
numberl - Number, reference to numeric value, or range that contains numeric
values
number2 - [optional] Number, reference to numeric value, or range that contains
numeric values

For example:

112 25 56  =MIN(AL:C1)

It will display the smallest number in the range A1:C1, ie. 12
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1.12.3.5 AVERAGE : The Excel AVERAGE function returns the average of values provided.
AVERAGE can handle uwp to 235 individual arguments, which can include numbers, cell
references, range, arrays and constants.
Syntax:
=AVERAGE (numberl, [numberl], ...)
Arguments:
numberl - A number or cell reference that refers (o numeric values
number2 - [optional] A number or cell reference that refers to numeric values
For example:

| A B e | D _ E
112 25 56  =AVERAGE(AL:C1)

It will display the average value of the numbers in the range A1:C1 . 1e. 31

1.12.3.6 NOW : The Excel NOW function returns the current date and time, updated
continuously when a worksheet is changed or opened. The NOW function takes no arguments.
You can format the value returned by NOW as a date or as a date with time by applying a
number format.

Syntax/Example:

A B
1 =NOW()

It will display the current date and time.

1.12.3.7 TODAY : The Excel TODAY function returns the current date, updated
continnously when a worksheet is changed or opened. The TODAY function takes no arguments.
You can format the value returned by TODAY usine any standard date format. If you need
gurrent date and tme. use the WOW function

Syntax/Example:

A B
1 =TODAY{)

It will display the current date only.
1.12.3.8 CONCATENATE : The CONCATENATE function in Excel is designed to join
different pieces of text together or combine values from several cells into one cell.
Syntax:
CONCATENATE(textl, [text2], ...)
Arguments:
textl - The first text value to join together

text2 - The second text value to join together
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For Example:

A | ¢ | D
__1_|Helln Students =CONCATENATE(A1,"",B1)

It will display the text Hello Students after combining text of cells Al and B1
1.12.3.9 UPPER : The Excel UPPER function returns a upper-case version of a given lext
string. Numbers and punctuation are not affected.
Syntax:
=UPPER (text)
Argument:

text - The text that to convert to upper case.
For Example:

. A | B C
1 |Hello =UPPER(A1)

It will display the text HELLO in capital letters.

1.12.3.10 PROPER : The Excel PROPER function capitalizes the first letter of each word
in the given text/string. Numbers and punctuation are not allected.
Syntax:
=FPROPER (rext)
Argument:
text - The text that should be converted to proper case.

For Example:

| A | B C ]
1 [HELLO STUDENTS =PROPER(AL)

It will display the text Hello Students in which first letter of each word is wrilten in
capital letter,

Relational Operators for Conditional/Logical Functions

When we are constructing a test condition for conditional functions like IF, SUMIF,
COUNTIF etc. we can use any one of the following relational operators in excel:

Operator Meaning Example
i equal to Al=DI1
= greater than Al=DI

p greater than or equal to Al>=Dl
< less than Al<DI
o= less than or equal to Al<=D1
<> not equal to Al<=Dl
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1.12.3.11 IF : We use an IF statement to ask Excel to test a condition and to return one
value if the condition is true, and another value if condition is false. For example:
=[F(Al1>=33"Pass","Fail"), This function will show Pass if the value of cell Al is greater than
or equals to 33 otherwise it will show Fail. More than one condition can be tested by nesting IF
functions, The IF function can be combined with logical functions like AND and OR.

Syntax:
=IF (cnteria, value if true, [value if false])
Arguments:
criteria - A value or logical expression that can be evaluated as TRUE or
FALSE.

value_if true-The value to return when criteria evaluates to TRUE
value_if false - |optional] The value to return when criteria evaluates to FALSE.
1.12.3.12 SUMIF : SUMIF is the function used to sum the values according to a single
criterion. Using this function, we can find the sum of numbers that meet certain criferia within
a range. Thig function comes under Math & Trigonometry functions.
Syntax:
=SUMIF(range, criteria, [sum range])
Arguments:
range - the range of cells to be evaluated by our criteria, required.
criteria - the condition that must be met, required.
sum_range-|optional] the cells to sum if the condition is met
1.12.3.13 COUNTIF : COUNTIF is another powerful and useful condition function that
can be used in excel. This function is used to count cells that meet certain criteria. COUNTIF
can be used to count cells with dates, numbers, and text that meet specific criteria.
Syntax:
=COUNTIF (range, criteria)
Arguments:
range - The ringe of cells to count.
criteria - The criteria that controls which cells should be counted.
Following Example shows the usage of conditional functions IE, SUMIF and COUNTIF:

] e e e e B E P 4 A B: cilo| E | F
1 H;ollm-] Name | Math| 5d Total Result 1 RellMo|  Mame  [Math | S | Total | Result
21 RAMSINGH |56 |78 [SUMIF{CRDE,"»=33") |=IF{E2==6h,"Pass", "Fall") 2 1 |RAMEINGH 56 | 78 | 14 |Pass
a2 MOHALLAL |12 |56 [=SUMIFICRD3, »=33") |=IF(F1o=58,"Pass", Fail") 3§ |MOHALLAL 12 | %5 [ % |FEl
_ﬁ__! RAHIMEHAN |56 |13 =SUMIF¢C-I:M,':'=33’] =IF!:E4->=EE..'Fasi"."FJII"' 4 1 |RAHIMEHAN | 56 | 13 | 56 |Fail
54 SAMGEETA |23 |56 :SIJMIF:II‘.E:BS,'ME'] :IF:M'Paﬂ"."FaIﬂ 5 4 |SANGEETA 23 | 5| 55 |F
6|5 SHANKAR |89 [0 [=SUMIF({CH:DS,">=33") |=IF{EG==66, Pass", "Fail") _E %5 |SHAMKAR B9 | 90 | 179 |Pass
7 7
& | Mo of Passed Students =COUNTIF[FLFS,"Fass”) & Mool Pasced Students 2
9 |Noof Failed Students  =COUNTIF(FLFS, Fail") -9 Noof Failed Students - 3
Fig. 1.14
15
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1.13 BORDER AND SHADING

e e b

E.E,alilm R 2
Border and Shading is used to differentiate various i B ru-[@F & A E== .g.i
areas of the spreadsheet. Borders can be applied to one | F Borders g
i ﬁ 5 Bottom Border ¥
cell or a range of cells or entire spreadsheet. Use the :',ZI 2 | o s !
Borders button, on the Home ribbon to apply border {5 | |= ytsorder H
styles. Also. the Fill Colour button will add or remove | (| Bgmt Border I
. T e L 4 , i H3 | Mo Bonder |
colour/shading for a cell or range. | it et |
' |
1.14 CUSTOM FILTER ' E :::”;:f:; fl
If our worksheet contains a lot of content, it can be “ =k .
difficult to find information quickly. Filters can he used Fig. 1.15
to narrow down the data in our worksheet, allowing us to
view only the mformation we need. EWTA _
L. Select the Data tab, then click the Filter  * &) [TF] Y b Cleat
command. A drop-down arrow will appear in 3] Sort : REspply
the header cell for each column. e
: Sort & Filte
2. Click the drop-down arrow for the column we ? '
wanl to filter, for example: Subject, e 134
3. The Filter menu will appear.
4. Click on the custom filter. Option in the sub menu of Texl. Filter or Number filter
option.
5. The Custom AutoFilter dialog box will appear.
6.  Select Filter Criteria and type its value {e.g. Math).
7. The data will be filtered by the selected text filter as shown in the following figure.
(] B C
1| Rall 5] Meme Subject
P_I 1J!_“"""""I Biology P —— 3
3| 2 [5HAM Pty P A t L
a4 3| WOHAN Hiology Totsject: 1 Roll - MName - Subject s
5 & |SUNIL Rath *ratn - mm ~] 3 2|sHAM Bllath
L 5 [SUSHMA Math it i = 5 A Math
i & IATIN Math - f 5[SUSHMA Math
ia T!HANJE{T Biology !thﬁmhﬁl;-;::m 7 B|IATIN Mt
g E!JUHN H. | [ ] L L] - 1_1, — EE_ ...__h
10 o|MaZlA a:zlzz i i - — —
1 10 [SUKHVEER Math
as Fig: Custom Filter in Excel
Fig. 1.17

1.15 CUSTOM SORT

Sorting refers (o the operation of arranging sets of data in some specific order. Sorting of
data can be in ascending or descending order. It may be applied on alphabetic and numeric
values. Following steps can be used to sort data in Excel:

1. Select the data we want to be sorted,

2. Click the Data tab and then the Sort button.

3. In the Sort box click Custom List under Order.
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| A B C D E
| 2 320{AADIGIL RAJ KUMAR GILL KASHISH GILL 4-Dec-06
3 A73|AAKASH JOGINDER YADAV PREM SHEELA DEVI g-lan-06
| 4 B22{AANCHAL RAKESH KUMAR BABITA RANI 11-0ct-03
| 5 103|AARMAN RAJ KUMAR SEEMA 28-Apr-08
| 6  864|AARTI HEERA LAL SAREMA DEVI 23-0ct-00
| 7 _321|AARTI LALIT LAXMI 2-5ep-03
| 8 | 823|AARTI KUMARI ARUN KUMAR TANTI PRATIMA DEVI 4-Sep-04
9 | 322|AASHISH RAM KUMAR ARCHANA DEVI 31-Jan-08
110 213|AASNA BABLU KUMAR SANGITA DEVI 16-Mar-07
£ 11| 104]AASTHA GAGAN RENU 10-Feb-11
12 928|AASTHA SANTOSH TIWARI NEELAM TIWARI 2-Jul-02
13 | 105|AASTHA SONI NARESH KUMAR SONI POOJA SONI 20-Nov-10
Fig. 1.18

4. In the List entries box, enter how you want the data to be sorted. For example, we've
sorted Name (Column B) and then by Father name (Column C) in A-Z sort order,

5. Once completed entering the data into List entries then click Ok,

Sort 7 X
"'ﬂ Add Level | X Delete Leve| . [Eﬂ Capy Level I[| | 8 Options.., [ My data has headers
Column Sart On Cirdes
Sorthy Mame fawe ! | Values v AtQZ w

Then by Values w :A toZ v

| Gancel
Fig. 1.19

1.16 FREEZE PANES

Whenever we are working with a lot of data in Excel, it can be difficult to compare
information in our workbook. Fortunately, Excel includes several tools that make 11 easier Lo
view content from different parts ol our workbook at the same time, such ag the ability Lo
freeze panes.

To keep an area of a worksheet visible while we scroll to another area of the worksheet, go
to the View tab, where we can Freeze Panes (o lock specific rows and columns in place, or we
can Split panes to create separate windows of the same worksheet.

When we freeze panes, Microsoft Excel keeps specific rows or columns visible when we
scroll in the worksheet. For example, if the first row in our spreadsheet contains headers, we

Orrice Automarion & Tyrma 17



might freeze that row to make sure that the column headers remain visible as we scroll down in

our spreadsheet.
Review View | novaFDF Team
| I T !
= Q @ #'} % E @ B spiit Ly view Side by Side E E
=y | Hide 3] Synenronous Seralling |
Zoom 1005 Ioomto New  Amange |Fresze Save Switch
Selection | Window Al [Panes~|J Unhide ' s Reset Window Position  warkspace Windows »
Zoom Fresze Panes
@ Keep rows and columns wisible while the rest of
the worksheet scrolls [based on current selection].
D | E | F | G Freeze TopRow . K
Keep the top row visible while scrolling through
the rest of the worksheet.
Freeze First Column
@ Keep the first column visible while serolling
through the rest of the worksheet.

Fig.

1.20

1.17 PAGE SETUP AND PRINTING OPTIONS

When viewing our workbook in Excel, page setup can make a world of difference, Excel
gives us lots of options for setting up our page. The Page Setup group of the Page Layoul 1ab
containg the following important command buttons in Exeel:

= Margins : It can be used to
select one of three pre-set
margins for the report or to
set custom marging on the
Margins tab of the Page Setup
dialog box.

*»  Orientation : It is used to
swilch between Portrail and
Landscape mode for printing.

. Size : It is used to select one
of the pre-set paper sizes or
get a custom size.

*«  Print Area : It is used to set
and clear the print area.

B cotars -
L J mm+

Themes

- [O]Efrects =

Insen J Fage Layout | Formulas  Data

Orientation  Size
|

B D= &

Primt  SrEeks Background

Themes Mormal

Top 1.51 tm

Al el 178

Right 178 em

Footer: 0.76 cm

Headen .76 om

]

A

Wide

T T T
_|u-mlu|m-m.n|m!mp.

Borttom:
Right:
Faoter

.54 om
.54 em
1.27 em

Topr 2%4m
Lefl: .54 tm
Headén 1.27 em

IMarnow

Top: 1.1 cm
Left: 64 £m
Headen .76 tm

r 187 gm
0,64 em
076 em

Right
Fooler

Custom Margins..

Botlom: 191 em |

Raview VI

G
Prirt
Titdesy

s

o]

Fig. 1.21

«  Breaks : It is used to insert or remove page breaks.

= Background : It is used to open the Sheet Background dialog box where we can
select a nmew graphic image or pholo lo use as a background for the current
worksheet, (This button changes to Delete Background as soon as we select a

background image.)

18
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«  Print Titles : It is used to open the Sheet tab of the Page Setup dialog box where you
can define rows of the worksheet to repeat at the top and columns of the worksheet to
repeat at the left as print titles for the report.

1.18 FILE CONVERSION
File conversion is the process of

[ iy -
i ; HE (R ®
converting a file into another type. For 1
5 - i Tl w WPNEE] » Bock Dhupter | w | learch Fosk Chapter | B
example, transferring a file used in Lo footite - ®
Microsoft Word to PDF or PDF to Excel | [ swower e . — Tree
or Word. We can also convert our .docx | " 0 100 Sobed M T o ARSI POFFie
H 2 B ey Panes anid Vew Dptions 1MAATAP PIF e
or .x1s fle to PDF here are some SIEPS to [T e tabhe 1A M PO iy
¥ i Bging 14372000 th AM PIF File
make our file to PDF as below:
il Oealliive

How to convert an Excel file to a 3 BTk

PDT: SR w eF ‘
1. Open Microsoft Excel file. e e .
2. Click on File then Save as. ek i s i
3.  Type Desired File name. “”""““":i‘ﬂ’!&"‘p“iﬁ‘:ﬁ it
4. Change Save As type to PDE :M;%
5 Click on Save. R Py III _—@:
There are many good websites

Fig. 1.22

available to convert various types of
documents online.
1.19 TYPING TECHNIQUE

Typing is the process of writing or inputting text by pressing kevs on a typewriter, computer
keyboard, cell phone, or calculator. Text can be in the form of letters, numbers and other
symbols. User mterface features such as spell checker and auto complete serve to facilitate and
speed up typing and Lo prevent or correct errors the typist may make.

1.19.1 Touch Typing

) |
Touch typing is a technique by which we can learn .. . @
typing with all fingers, step by step, without having to
look down at the keyboard. It will increase the typing
speed. Any typing-tutor software can be used for learning
this technique.

1.19.2 Voice Typing Fig. 1.23
Voice Typing is a type of speech recognition program that converts speech to written
language. Voice-to-text technique was originally developed as an assistive technology for the
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visually impaired or handicapped persons. The
speech-to-text converter is speech recognition softrware

by which the software takes vser’s speech as input
and converts this speech input to text. )) ‘ ' *

1.20 FONT CONVERSION TOOLS Fig. 1.24

Sometimes we are asked to prepare our document using a specific font, but we do not
know how to type in that particular font. In such situations, we can use these converters. For
example, we are asked to prepare our document using Raavi font and we are not familiar with
the key-map of Raavi font. But, we are familiar with Anmeol Lipi Key-map. In such a case, font
converter tool, such as G-Lipi-CA, helps us to type in Raavi font by usimg key-map of
AnmolLip1 font. Following are some examples of such font conversion methods/tools.

= AnmolLipi to Raavi (Unicode Conversion)

. G-Lipi-CA (http://gurmukhifontconverter.comy)

+  Punjabi Gurmukhi Keyboard (https://punjabi-gurmulkhi-keyboard-based-on-anmol L.

software.informer.com/download/)

2> Doits To Remember

L. A word processor 18 software that allows ugers to create, edil, and print documents.

(]

Formatling refers to changing the font style, size, color, bold, italic, underline and other
related parameters.

Alignment determines the appearance and orientation of the edges of the text of paragraph.
4. MS Word provides the feature to check the spelling of the typed text and underlines the
text with red line, if the spelling of any word is wrong.

11
.

Page Setup allows us to change the structure and Iayout of pages in a Microsoft Word

document,

A margin is the space between the text and the edge of your document,

7. Page Orientation refers (o the direction in which a document is displayed.

8.  Print preview is a feature that displays on the screen what a hard copy would look like
when printed.

9. Microsoft Excel is a powerful electronic spreadsheet program used to create results,
doing mathematical calculations and representing data in pictorial view with help of
charts.

10. A function is a predefined formula that performs calculations using specific values in a
particular order.

11. Fillers can be used to narrow down the data in vour worksheet, allowing you to view only

the mformation you need.
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12. Touch typing is a technique by which we can learn typing with all fingers, step by step,

13.

!_-J

without having to look down at the keyboard,
Voice Typing is a type of speech recognition program thal converts speech to writien
language.

EXERCISESS

Part-A
Multiple Choice Questions:
L is word processor software.
a.  MS Window b. MS Excel
¢. M5 PowerPoint d. MS Word
II. To check spelling and grammar key is uszed.
a.  Cirl+F7 b.  Al+F7
c. F7 d.  Shift F7
1. option in MS-word changes the structure and layout of pages.
a.  Format b.  Prnt and Print Preview
c. Page Setup d. Proofing
I'V. is electronic spread sheet software used for automated calculations.
4. MS Window b. MS Excel
¢. MS PowerPoint d. MS Word
V. refers to changing the font style, size, color, bold, italic, underline
and other related parameters.
a.  Formatting b.  Alignment
¢. Proofing d.  Filtering
Fill in the Blanks:
E and functions are used to find the minimum and maximum
value in range.
II.  Filter option is available in tab of Excel,
[M. If the cursor is placed at the end of the file, then button is
pressed to delete the text.
IV. Two options of orientations for page setup are and
V. Symbol 15 used to start any formula (function) in excel calculations.

Write shortcut keys :

I.  For copying contents
[I.  For Paste

. For Bold
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1..h

IV. For Underline

V.  For Centre alignment

V1. For Justify alignment

VII. For Double line spacing

VIII, For Replace

IX. For Printing

X. For Spelling & Grammar check

Part-B

Short Answer Type Questions. (Write the answers in 4-5 lines)
L  'Whatis Excel?

I. Explain formatting in details.

OI.  Explain Print & Print Preview options,

IV. What are formulas in MS Excel?

V.  What do you know about the formula bar in Excel?

VI What are Margins?

Part-C

Long Answer Type Questions. (Write the answers in 10-15 lines)

L What are word processors? Explain their uses.

II.  Describe the Proofing options in MS Word.

[1l.  What are functions in Excel? Explain any two functions with example.

I'V. Explain the various methods of Typing.
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Lab Activity-1

Create Resume in MS Word for job and also prepare lollowing task.

. Correct the mistakes (if shown in docurent) with the help of Spelling and Grarmmar
Check.

. Set the Page Border.
. Save your Resume as PDF file,

Lab Activity-2

Prepare Result in MS Excel as given below:

E9-c-Q=
“ Home Insert Fage Layout Formulas Data Review View MNitro Pro 9 Te
== % cut

B Calibri 1 AN = ; P = \irap Text
Paste o il B I U- H- Oy - A- E == :p = EM” BC .
-+ Format Painter M | R e
Clipboard ¥ Fomt ] Alignment .
i H6 Ml R |
| 4] A B " D | E F < H |
e 5.Mo.|Name of Student | Class | Section M s Percentage Result
2 Theory |Practical |Total
3 1|RAM LAL 11th |A 45 40
4 2|SHAM SINGH 11th |A 34 34
[ 2 3|GURMAILSINGH |11th |A a3 38
6 |_ 4{MANPREET KAUR |11th |B 44 40 |
7 S5|RAMIZ RAJA 11th |A 27 32
8 6|HUSANDEEP 11th |B 38 36
f.'EI JISEHAJPREET 1ith |B 438 40|
10 S|MEEMNAKSHI 11th |B 47 38
11 9|SHEHMNAZ 11th |B 48 38
12 10|RAKESH KUMAR |[11th |A 38 35
13

Now do as following:
. Set Border of cells.
. Calculate Total, Percentage and Result with the help of formulas and functions.
. Sort the student data in increasing order according to 'Name of Student' colunn.
. Filter the data of 'Section A' students using Filter option.
. Save the file in PDF format.
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CONTROL

'CHAPTER - 2| STATEMENTS IN C

OBJECTIVES OF THIS CHAPTER

2.1  Introduction

2.2 Control Statements and their types
2.3 Branching Control Staterents

24  Looping Control Statements

25  Jumping Control Statements

2.1 INTRODUCTION

In the 11th class. we have studied about the basics concepis of C Language such as
identifiers, tokens, variables, constants, data lypes, operators and expressions etc. in this
chapter, we are going to discuss some more advanced concepts related to programming in C.
Normally in C programming, a program consists of a number of statements which are usually
executed in sequence. This is called sequential execution. Programs can be much more powerful
if we can control the order in which statements are executed, In this chapter, we shall discuss
about these various powerful control constructs such as branching, looping and jumping.
Using these constructs we can control the execution flow in a C program.

2.2 CONTROL STATEMENTS AND THEIR TYPES

C language includes a wide variety of powerful and flexible control statements., Using
these control statements, we can control the execution flow of program statements. In simple
words, we can say that those statements which are used to control the execution flow in a
program are called Control Statements. We can transfer the contrel point to a desired location
in the program or we can repeat a statement any nurmber of times using these control constructs.
These conirol stalements ¢an be categorized into three divisions:

1. Branching Control Statements

2. Looping Control Staternents

3.  Jumping Control Statements

All these are the powerlul control statements which controls the execution of program
statements in different ways. Branching statements are used to decide which actions to take,

looping statements are used to define how many times to repeat a certain action, and Jumping

24 CoMputER SciENCE



Control Statements

Branching L Looping Jumping
: for break
if E}.Its?_l while continue
switch case de it go to

Fig. : 2.1 Different Types of Control Statements in C
statements are used to transfer unconditional control from one location to other location in the

program. We can use any of these siatements anywhere in the program as per our requirernents.
Following dis¢ussion shows a detailed explanation about these statements.

2.3 BRANCHING CONTROL STATEMENTS

These statemients are branching so called because the program chooses to follow one
branch or another during execution. These statements can be used for decision - making
purpose or for making multi-way selection. Therelore (hese statements can further be categorized
into two major categories which given below:

A. Conditional control Statements

B. Multi-way conditional control Statements

A detailed discussion of these control staternents with suitable examples is given below:

2.3.1 Conditional Control Structures (Decision Making Statement)

These statements are also called decision making statements, In these constructs, two or
more set of statements are written but only one of these sets is executed. Which set of
statements will be executed depends upon a test condition. If the test condition evaluates to
true, we direct the program to take one set of actions, otherwise, we direct the program to do
some other set of actions, For conditional control statements, we use if else statements in the C
programs. There are many variations for using il else statements as show below:

« if statement

« if else statement

« else if staternent

«  nested if statement

2.3.1.1 Simple if statement : It is the simplest form of if ¢lse statement. The 'if statement’
evaluates the test condition and then proceed to carry out the set of actions only if the test
condition is evaluated to true. It is terminated when the test condition evaluates to false, The
syntax for using this statement is given below:

Syntax: il (expression)

{

Block of statements;
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Here, the expression also referred so as test condition must be enclosed in parenthesis,
which causes the expression to be evaluated first. If is evaluaie to true, then the body of the
staternents will be executed otherwise this body of statements will be 1gnored and control will

be passed to the next statement. Consider the following example:
- :

rogram 2.1 VWit program in U Language to hind whether the stodent 1s
1 i Bun 1 'Y I L i PR |
FAsSsE ny lering 1arks throngh the kevboard.
(29 -
S oy s s
T
- - J I

int ¥k
. i1 g i y "
L i (™ 3 m
if({marl
& | W1 f "
a Ounput of Program: 2.1
Pragram:; 2.1

2.3.1.2 if else statement : In if else conditional control statement, statements in if block
gets executed only when the condition is true and statements in else block geis executed only
when the condition is false, The syntax for vsing if else statement 18 given below:

Syntax: il (expression)

i

Block of statements;

else
I
1
Block of statements;
Il-
Program 2.2: Write a program (o find whether the student is "Pass" or "Fail" by

cring marks through Kevboard.

2 void main |

w _:Fl I
1€ (mark
printf(™l
else

peintL ("] Qutput of Pregram: 2.2

PFrogram: 2.2
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2.3.1.3 else if statement : It is a chain of multiple if else statements. Here. statements in
body gel execuled when the corresponding condition 15 true. Statements 1n final else block gels
executed when all other conditions are false. We can use any number of else if blocks between
if and else.
Syntax:
if {(expressionl)
Block 1 of statements:
clse if(expression)
[

Block 2 of statements;

else

Block n of statements:

Program 2.3;: Write a program to ind Grade of the student il marks==8{ then Grade
A, It marks>=060 and marks<sl then Grade B, if marks==40 and marks<6{ then Grade

(, otherwise Grade D.

- F—
s (8 R— . B " sriay  geSmmr
EHP s . o s
B -1 -

vold maini)

S int

5 printf("Ente k™

& scantf ("%d", amarks
Afimarck

B printf ("Grade

alsa if imarks

printf("G

else if (ma

printE(" ia C7)

else

printf(®

Owrtpurt of Program 3.3

Program 2.3

1.3.1.4 Nesied-if statement : Writing the il statement with-in another if is called as
nested-if. Inner if is processed only when outer if condition is true. Hence statermnents of inner
il gels executed when outer if and inner if conditions are true.

27
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Syntax:
if{conditionl)

-!

/* Execules when the conditonlis true #/

if{condition2)
/* Executes when the condition 2 15 true */

Block 1 of Statements:

)

Program 2.4: Write a program to lind largest number between three numbers entered

by the user.

B
]
2 volid
3
1 int b,
] I ntf {"En
anf (" ", &a, &l
if L
A iffa>c)
| printf i1
0 alse
1 ¥Eintl |
3 else
' if
5 seint £ ™  Faest ®) Output of Program: 2.4
else
| { 1
=
Program: 2.4

2.3.2 Multi Way Conditional (Case) Control Structures

A multi-way branching is often the most efficient method of passing control to one of a set
of program labels. For multi-way conditional control statement. we use switch case statement
in C Programs which is explained below with suitable example:

2.3.2.1 switch-case statement : The statement switch-case is similar to else if statement.
It's a matter of preference which we use; switch statement can be slightly more efficient and
easier to read. In switch-case, statements get executed when corresponding case constants are
true only. Statements of defaults block gets executed only when all other cases are false.

28
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Syntax:

switch (variable/expression)

{
case constanil:
stalemenits]; break:
case constani2:
statements2; break:
case constani3:
statements3; break:
delault:
Slalements;
}
Program 2.5: Write a program lo prini name of day ol week corresponding to the

number of the day entered by the nser.

M
volLd i
! imt
i
switch (day]

cage ! i (*Manday") jhraak;
AR i i - " break

11 cases [ ("Hadnesd broak

1d case I 1% il i "1 rbreak
case printl ("Friday") ;hreak
Cane . T i *2at " rbreak
casg ! printl (*Sonday") ;bhreak
default printf (“Wrong | A

Qutput of Program: 2.5
Program: 2.5

2.4 LOOPING CONTROL STATEMENTS

Looping statements are also called Iterative Statements. There may be situations when we
need to execute a block of statements several number of times. In such situations, loops
provide a way to repeat statements and they also control how many times the statements to be
repeated. C provides different types of loops. All these loops can be categorized into (wo
catepories as wiven below:

241 Pre-Test Loops

2411 For loop

2.4.1.2 while loop
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2.4.2 Post-Test Loop

2.4.2.1 Do-while loop

2.4.1 Pre-test Loops

Pre-Test loops are also called Entry-Controlled loops. In these loops, the control conditions
are lested before execution of the body of loop. The 'for' and 'while' loops are the entry-
controlled loops in C. These loops are explained below:

2.4.1.1 for loop : A for loop is a repetition or iterative control structure that allows us to
write a loop that needs to be executed for a specific number of times. The 'for loop' statements
get executed as long as condition is true. For loop contains three expressions:

. Expressionl includes initializing the variables (counter variable),

' Expression 2 includes condition and

«  Expression3 includes increment or decrement of variable (counter variable).

Syntax:
for(Expression (initialization); Expr2 (condition); Expr3 (increment/decrement})
Body of statements:
Program 2.6: Write a program to print first n natoral nombers nsing for loop.
%
g vold main
4 int n, l;
5 printf ("Ente amber: ™
i gcanf ("8d",&n) ;
! for (| I i1
f
5 I intl \ | |
10
11 Qutput of Program: 2.6

Program: 2.6
2.4.1.2 While loop : In while-loop, statements get executed as long as condition 1s true. In
while-loop it checks the condition first and if the condition is true then it executes the

staternents later, So, minimur number of execution times of statements in while loop is 0.

Syntax:
while(condition)
statements;
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Frogram 2.7 YWrie a program to print even numbers beiween 19 to 1 usinge while

]
b i
1
) void main
4 int 1
5 while
G
I i i L 1™ _ 4
i
L= ]
10 Qutput of Program: 2.7

Program: 2.7

2.4.2 Post-Test Loop

Post-Test loopis also called Exit-Controlled loop. In this loop, the control conditions are
tested afier the execution of the statements of the body of loop. The 'do while' loop is the only
one exit-controlled loop in C. This loop is explained below.

2.4.2.1 do while loop : In do-while loop, statements gel execuied as long as condition is
true. In do-while loop, il executes the statements first and checks the condition later. A do-
while loop is similar to a while loop. except that a do-while loop 1s guaranteed to execute at
least once. Therefore in do while loop, the minimum number of executions for the body of the
loop will be 1.

Syntax: do

stalements;

| while{condition);

Procram 2.%: Write a program to print odd numbers from 1 to n {entered by user)
using do 1le 10o]
L]
volid mair
1 Ant i e 1
" I I 1] i (1]
i I il
do
I f '-.II |
| 1 i
]I ] while (i | Cutput of Program: 2.8
|

Program: 2.8
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2.5. JUMPING CONTROL STATEMENTS

Jumping statements in C programming are used for altering the normal flow of a program.
Using these staternents, we can transfer the execution control from one location (o some other
location m the program. Following are the jumping statements that can be used m the C
PrOgriams:

2.5.1 Goto statement

252  Break statement

2.5.3 Contnue statement

All these jumping statements are explained below:
2.5.1 goto statement

A goto in C programming provides an unconditional jump from the goto statement to a
labelled statement in the same function. It transfers control to a labelled location. The label
must reside in the same function and can appear only once in the same function. It 15 a kind of
branching structure. It moves the control flow forward or backward to a label. It 15 condition
dependent.

Syntax:

coto label,

label: statement:

Here label can be any plain text except C keyword and it can be set anywhere above or

below the goto statement with in a function,

Program 2.9 Write a program in C to show the use of goto statement

F
] [
vold maln
/] int i
ZTART: Frlabel fon jots 2tatement
printt{*n%", 1)z
1++F
i€l
' 2 goto START: Qutput for Program: 2.9
11
Program: 2.9
The two more statements built in C programming to alter the normal flow of a program
are:

' break

«  conlinue

Loops perform a sel of repetitive task (statement) until condition becomes false but it is
sometimes desirable (o skip some statements inside loop or terminate the loop mmediately
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without checking the test expression. In such cases, break and continue statements are used.
The break stalement 15 also used in switch stalement to exit switch statement.

2.5.2 break statement
Break statement terminates the loop or switch statement and transfers execution to the
staternent immediately following the loop or switch. The break statement in C programming
language has the following two usages:
1. When the break statement is encountered inside a loop. the loop is immediately
terminated and program control resumes at the next statement following the loop.

2. It can be used to terminate a case in the switch statement.

If we are using nested loop (i.e., one loop inside another loop), the break statement will
stop the execution of the innermost loop and start executing the next line of code after the
block.

Syntax:

2.5.3 continue statement

It is sometimes desirable to skip some statements inside the loop without exiting the loop.
In such cases, continue statements are used. It causes the loop to skip the remaining statements
and immediately re-test its condition prior to reiterating.

Syntax:

‘2 Doiits To Remember

C provides three types of control flow statements: Branching, Looping and Jumping,
Branching is so called because the program chooses to follow one branch or another.

a

LS
.

Loops provide a way to repeat commands and control how many times they are repeated.

o

We can use any number of else if blocks between if and else.

:J'I

Writing the if statement with-in another if is called as nested-if
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Switch-case 1s similar to if-else-if statement.
In Pre-Test loops, the control conditions are tested before the body of loop.
In Post-Test loops, the control conditions are tested aflter the body of loop.

ol el

A for loop is a repetition or iterative control structure that allows us to write a loop that
needs to execute a specific number of times.

10.  for and while loops are the examiples of pre-test loops whereas do while is an example of
post-test loop.
11. Jumping statements in C programming are used for altering the normal flow of a program.

12. A goto in C programuming provides an unconditional jump from the goto, to a labelled
statement in the same [unction.

13. Break statement can be used to terminate a case in the switch statement.
14. continue statement is used to skip some statements inside the loop.

Part-A
1.  Multiple Choice (Questions:
I.  Which of the following statement is also called as conditional statement?

a. for b.  break
c. if d. while

II. switch-case is similar to statement
a. ifelse b. ifelseif
c. break d.  goto

II. Which statement can be used to terminate a case in the switch statement?
4. conlinue b.  goto
c. if d. break

IV.  Which of the following is an example of Post Test loop?
a.  for b.  while
c. do while d. conlinug

V.  Which of the following is not a jumping statement?

a.  while b. continue
c. goto d. break
2.  Fill in the Blanks:
I. In loops, the control conditions are tested before the body of loop.
. In loops, the control conditions are tested after the body of loop.
1. statement is used to skip some statements inside the loop.
IV. is a multi-way conditional control statement.
V.  The break statement can be used to terminate a case in the statement.
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fad
-

YWrile True or False ;

1. Writing if statement with-in another if is called nested loops.

II.  Control statements in C programming are used for altering the normal flow of a
program.

I Continue statement is sometimes desirable to skip some staterments inside the loop.

IV

Looping statements provide a way to repeat commands.
Part-B

4.  Short Answer Type Questions, (Write the answers in 4-5 lines)

[.  Define Branching? Name its different control statements?

F.

What is looping? Name three different types of looping statements?
[l. What is nested if statement? Write its syntax?

[V. What is if-else statement? Write a program of if-else statement?

V. What is while statement? Write its syntax?

Part-C

:...l‘l

Long Answer Type (Questions. (Write the answers in 10-15 lines)
L What are Control Statements? Explain their types.

II.  What is for loop? What are the two different categories of loops?
L. What is jumping statement? Explain its types?

IV.  What is do while loop? How it differs from while loop?

Controt Statemexnt v C 35



Lab Activity

Write the output of the following pregrams:

Program 1:

$#include<stdio.h>

void main()

int a, b;
printf ("Enter two valuss ")
scanf ("%Wd%d", ga, eb):
ifla>rb)
printf("td is greater than %d",a,b}:
else
printf{"td is greater than %d",b,a);

]

Output of Program

Program 2:

fincluyde<stdico.h>

void main()

|

int days:

printf ("Enter number of days in a monbh
scant ("4d", edays) ;

switch (days)

|

cage 24:

printf ("Feb without Leap Year™}:

break:

case L%

printf (*Feb with Leap Year®):

break;

casa 30:

printf ("April, June, Sept, Nov"):
break;

case 1|:

printf (*Jan, March, May, July, Aug, Oct,
break:

default:
printf ("Wrong number of days for a month*);

Dac™) ;

Output of Program

Program 3:

finclude<stdio.h>

Output of Program

void main ()

{
int i,sum =0;

for(i=l;i<=10;1i++)
{
printf("\n%d",1i);
sum=sum+i ;

"
¥

princf("\nSum is: &d4",sum):;
}

36
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COMPUTER NETWORKS

OBJECTIVES OF THIS CHAPTER

3.1  Introduction to Computer Network
3.2 Need of Networking

3.3  The OSI Layers

34  Network Devices

3.5 Communication Media

3.6  Communication Modes

3.7  Network Sharing

3.8  Protocol

3.9  Network Component Addresses

3.1 INTRODUCTION TO COMPUTER NETWORK

Computer networks are the base of
communication in Information Technology.
These are used in a variety of ways and these
can include different types of network. In
simple words, a computer network is a set of
computers that are connected together (using
a media) in a way that they can share

information and complete the process.

3.2 NEED OF NETWOREKEING

To share our files or information from
our computer to another computer we need
Computer networking. In simple terms
Networking means communication and sharing. We can say that a networking means Lo

communicate and sharing an information over a network. In our routine work we use the things

Fig. 3.1 Computer Network

or services where networking plays an important role:
»  Communicating using email, video, instant messaging.
Other methods sharing devices such as printers, scanners and photocopiers.
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Sharing files, sharing software and operating programs on remote systems

«  Allowing network usgers to easily access and maintain information

3.3 OSI LAYERS

OSI stands for Open Systems Interconnection. It has been developed by ISO - Tnternational
Orzanization of Standardization’, in the year 1984, It 15 7-layer architecture, with each layer
having specific functionality to perform. All these

7 layers work collaboratively to transmit the data
from one person to another across the globe, Applialin Ly o

As we have studied that there are the seven
OSI layers. Each layer has different functions. et
A list of seven layers are given below:

i.  Physical Layer

ii. Data-Link Layer

iil. Network Layer

iv, Transport Layer Doty Lin Dits Link Laver

v.  Session Layer

Pmital

vi. Presentation Layer _ :

Vil . ApolicgieL sy Fig. 3.2 OS] Layers

i. Physical Layer : The main function of this layer is to transmit the individual bits (0,1)
from one node(any physical device) to another node. It is the lowest layer of the OSI model. It
establishes, maintains and deactivates the physical connection in a network.

ii. Data-Link Layer : Data-Link layer ig responsible for transferring of data frames (a
sequence of bits or symbols) without any error. It defines the format of the data on the network.
It provides a reliable and efficient communication between two or more devices. It is mainly
responsible for the unique identification of each device that resides on a local network.

iii. Network Layer : Network Layer manages device addressing, tracking the location of
devices on the network. It determines the best path to move data from source to the destination
based on the network conditions, the priority of service. and other factors. The Data link layer
is responsible for routing and forwarding the packets. The protocols used to route the network
traffic are known as Network layer protocols. Examples of protocols are IP and Ipv6.

iv. Transport Layver : The Transport layer ensures that messages are transmitted in the
order in which they are sent and there is no duplication of data. The main responsibility of the
transport layer is to transfer the data completely. It receives the data from the upper layer and
converts them into smaller units known as segmenis. This layer can be termed as an end-to-end
layer as it provides a point-to-point connection between sotirce and destination to deliver the
data reliably.

v. Session Layer : The session layer is the fifth layer, which contrels the ¢connections
between multiple computers. The session layer tracks the dialogs between two processes which
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can be either half-duplex or full-duplex. which are also called sessions. Session layer adds
some checkpoints when transmitting the data in a sequence. If some error occurs in the middle
of the transmission of data, then the transmission takes place again from the checkpoint. Thig
process is known as Synchronization and recovery.

vi. Presentation Layer : A Presentation layer is mainly concerned with the syntax and
semantics of the information exchanged between the two systems. It acts as a data translator
for a network. This layer is a part of the operating system that converts the data from one
presentation format to another format, The Presentation layer is also known as the syntax layer.

vii. Application Layer : An application layer serves as a window [or users and application
processes to access network service. It handles issues such as network transparency, resource
allocation, etc. An application layer 1§ not an application, but it performs the application layer
functions, This layer provides the network services to the end-users.

3.4 NETWORK DEVICES

We have already studied about computer network and OSI layers. Now we will study
aboul the devices thal are uzed in a Network, In simple terms Network Devices are termed the
hardware used in making a network. The networks can be as small as used in office or home
and some are as big as often used in big buildings etc. Devices that filter data traffic are called
Connectivity Devices.

Let's study about various types of Network Devices in detail:
3.4.1 Hub

A netwark hub is a node that is used to broadcast data to every computer or to an Ethernet-
based device connected to it. A hub is Hub
basically a multiport repeater. Wires coming
from different devices are connected to a
Hub. A Hub cannot filter the data so data
packets are sent to all connected devices.
In a computer network the hubs are : ’ &
categorized in three types such as: Fig. 3.3 Hub

Active Hub : These hubs regenerate our signals as well as amplify the signal. These
are used to extend the maximum distance between nodes on a network.

. Passive Hub : These hubs simply distribute the signal coming from the previous
ports. These hubs relay signals onto the network without cleaning and boosting them
and can't be used to extend the distance between nodes.

Intelligence hub : It is an advanced version of hub and it comprises both active and
passive hubs, it provides the ability to manage the network from one central location.
This also helps the administrator to monitor network traffic and you can configure

each port on it individually, due to this advantage it 12 also known as a manageable
hub.

ConruEr NETwOoRKS 39



3.4.2 Switch

It 15 a small device that is used to
transfer data packets between multiple
network devices such as computers,
routers, servers or other switches. In
simple words a switch works like a
multiport bridge, it has a buffer that is
used to boost its efficiency and
performance of a switch The switch can
also perform any type of error-checking
before forwarding the data, this
advantage makes it very efficient as it does not forward packets that have errors and forward
good packets selectively to correct port only.

3.4.3 Routers

Fig. 3.4 Switch

Router is also an important hardware device and il works as a gateway of networks
responsible for keeping data flowing between networks and also keep networks connected to
the Internet. Moreover a router is a device like a switch that routes data packets based on their
1P addresses. Router is mainly a Network Layer device.

-

—_—
1

Fig. 3.5 Router
Functions of a Router : The router basically performs two major functions:
. Forwarding : Router receives the packets from its mput ports, checks it header
information and looks up to the routing table to find the appropriate output port to
dump the packets.

Routing : It is the process by which the router determines that what would be the best
path for the packet to reach at the destination without any logs of information.
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3.4.4 Repeater

A repeater ig a network
device that is used for regenerating ((( )))
the signal and then transmit. It / ' \
regenerale the signal over the h 2 ;

same network before the signal
REPEATER
becomes too weak or gets

corrupted. The repeaters do not N 28 Mg
amplify the signal because when the signal becomes weak, they copy the signal bit by bit and

regenerate it at the original strength, A repeater is only a 2 port Network Device.
3.4.5 Bridge

A bridge is such type of device that can be used in computer nerworks (o interconnect fwo
LANs together and other separate network segments.It uses the MAC address information in
forwarding data packels, Only the data that needs lo be sent across the bridge to the next
network segment is forwarded. [t has a single input and single output port.

Fig, 3.7 Bridge
Types of Bridges :

«  Transparent Basic Bridge : This bridge is the simplest type of bridge. Actually it
stays transparent or invisible to the other devices on the network. Transparent bridge
can store data briefly(the details of its source and destination) before forwarding to
the next network.

. source Ronting Bridge : [n these bridges, routing operation is performed by source
station and the frame specifies which route to follow, This data is transferred by
sending a special frame called discovery frame. which spreads through the entire
network using all possible paths to destination.
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3.4.6 Gateway

A gateway is a component that is part of
two networks. These networks use different
protocols. The gateway translates one protocol
into the other. Therefore galeway is also called
protocol converler and can operate al any
network laver. The activity of a gateway 1s
more complex than that of the router or switch

because router and switch communicates
using more than one protocol.For basic i
Internet connections at home, the gateway is ]

the Internet Service Provider that gives you —
access o the entire Internet. _

3.4.7 Brouter

A Brouter is a combination of a Bridge and a Router. It functions like a bridge and a router,
A Brouter connects the networks which use different protocols. It can be programmed to work
only as a bridge or only as a router, Working as router, it is capable of routing packets across
networks and working as bridge, it is capable of filtering local area network traffic.

3.5 COMMUNICATION MEDIA
The word communication defines the tool or the means of delivering and receiving data or

Fig. 3.8 Gateway

information such as Telecommunication. In telecommunication, these means are transmission
and storage tools or channels for data storage and transmission. Various transmission media can
be used for transfer of data. These transmission media may be of two types:

*  Guided Media

«  Unguided Media

Let's study aboul various types of (ransmission media in brief:
3.5.1 Guided Media

In guided media the data is transmitted using cabling system that has a fixed path. For

example, copper wires, fiber optic wires, etc.

3.5.1.1 Twisted Pair Cable : A twisted pair 1 e 0
\\-{—huhln‘

cable contains two separate insulated copper wires,
which are twisted together and it run in parallel. ;. \ -
Omne of the wires is used to transmit data and the PAIRS

L ]

3| ——
other is the ground reference. The two insulated L
copper wires are twisted around each other just to d =7
. . L L Twisted Pair - Side View
reduce crosstalk or electromagnetic induction
between these pairs of wires. Fig. 3.9 Twisted Pair Cable
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There are two types of twisted pair cables:
' Unshielded Twisted Pair (UTP) : These —5—
. ' . . =
generally comprise of wires and insulators. ——
*  Shielded Twisted Pair ( STP) : They have a
Shialding e BIrOUWN

braided wired mesh that encases each pair of —a _. blue
insulated wires. 'Q"‘_" - orange

: i i ; i T green
Twisted pair comes with each pair uniquely colour

coded when it is packaged in multiple pairs. For
different purposes such as analog, digital and Ethernet, Fig. 310 UTP & STP
different pair 15 required.

ground wire

Copper wires are the most common wires used for transmitting signals because of good
performance at low costs.

Advantages of twisted pair cable : The twisted pair cable is the oldest one used and most
popular cables all over the world, they offer such as:

«  These cables can be used both for analog and digital transmissions.

Least expensive for short distances.

«  Entire network does not go down if a part of network is damaged.

Disadvantages of twisted pair cable : With its many advantages, twisted pair cables offer
some disadvantages (oo such as:-

*  The Signal cannot travel long distances without using repeaters

*  High error rate for distances greater than 100m

«  Very thin and hence breaks easily and not suitable for broadband connections

3.5.1.2 Coaxial Cable : Coaxial

cable is a two conductor electrical cable Coaxial Cable

consisting of a centre conductor and an Outsie Ingintion e

outer conductor with an insulating s
spacer between the two, Coaxial cables 13 4 44 ; 1ié I:".'E
are copper cables with better shielding SRS 44

than twisted pair cables, so that -
lransmitted signals may travel longer
distances at higher speeds, A coaxial
cable consists of these layers, starting

Copper mesh Copper wire

Fig. 3.11 Coaxial (Cable

from the innermost :
1. Core wire is of stiff copper material, so it's not easy to bend it if necessary.
2. Insulating material surrounding the core
3. Closely woven braided mesh of conducting material surrounding the insulator

The coaxial cables are widely used for cable TV connections and LANSs.
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Advantages of Coaxial Cables :
»  No effect on signals of disturbance from outer side.
«  Thick coaxial cable has an extra protective plastic cover that help to keep motsture
away.
These can be used for both analog and digital signals.
*  These are eagy to install and maintain.
Disadvantages of Coaxial Cables :
«  These cables are expensive as compared to (wisted pair cables.
«  These are not compatible with twisted pair cables.
Thick coaxial is that it does not bend easily and is difficult to install.
3.5.1.3 Optical Fibre : An optical fibre cable has a number of optical fibres (a thin flexible
fibre with a glass core) bundled together which are normally covered in plastic covers or
shields. Optical cables are used to transfer digital data signals in the form of light up to the
distances of hundreds of miles with a higher throughput rates in comparison to other electrical
communication cables.

Hegh cencity pahyethylana

inaulatian {17 mm}

Cenper tubing (B3 mm)

St wiren
Wazer-resistart jelly
casng (23 mm)

: |
4, mi\;al
Fig. 3.12 Optical Fibre
Optical fibre cable 1s widely used in fibre optic communications. Light Emitting Diodes
(LEDs) or Laser Diodes (L.Ds) emit light waves at the source, which is read by a detector at the
other end. All optical fibres use a core of hair-like transparent silicon coversd with less refractive
indexed cladding. Optical fibres are very sensitive So, it is normally covered with a high-
strength, lightweight protective maiterial. Each fibre 1s made up of these three layers, starting
with the innermost layer 7
Core made of high quality silica glass or plastic
+  Cladding made of high quality silica zlass or plastic.
«  Extemal protective outer covering called buffer
Advantages of Optical Fibre : Optical fibre is fast replacing copper wires because of
these advantages that it offers 7

«  One single mode fibre can replace a wire made of heavy and large copper.
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*  Higher bandwidth.

*  Suitable for industrial and noisy areas.

. Data Signals can be sent to a long distance without weakening.

Disadvantages of Optical Fibre: Despite long segment lengths and high bandwidth,
using optical fibre may not be a viable option for every one due to these disadvantages :

Optical fibre cables are expensive.
«  The optical fiber are highly polished to allow light to pass with a little loss.
«  Light waves are unidirectional, so two frequencies are required for full duplex

transmission.

3.5.2. Unguided Media

The media that doesn't use any type of directed or guided media is called unguided media.
Unguided media transfer the data using electromagnetic waves without using a physical
conductor. This type of communication is often referred to as wireless communication. Signals
are normally broadcast using through free space(or in a few cases, water) and thus are available
1o anyone who has a device capable of receiving them.

We can categorize wireless transmission into the following groups:

+  Infrared

NFC
Bluetooth

+  Wi-Fi

*  Radio Waves

+  Micro waves

Satellites

Let's study all of these in detail as below:

3.5.2.1 Infrared : Infrared (IR) is a type of wireless mobile technology that is used for
commumcation over a short range of field, IR communication has some major limitations such
as il requires line-of-sight, hag a short transmission range and is unable to penetrate through
obstacles.

[R cannot be used for long - range communication. Because Its use is limited within a
closed space and they do not need any government permissions for their applications.

Applications of Infrared Waves in Communications:

. Remote controls for television, stereos and other home appliances.

Wireless LANs
Wireless modem, keyboard, mouse, printer etc

. Fire detectors
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Night vision systems

*  Intrusion detection systems

n
-

Motion detectors

3.5.2.2 NFC (Near Field Communication)
: NFC technology is a new technology that is
used for data transfer. It is a contactless way in
which NFC devices interact also bears similarity
to Bluetooth.It can be employed in contactless
payment systems. It also provides a compact
way to communicate information, which may
be used for advertising or social media purposes.

NFC
TAG

Fig. 3.13 NFC

NFC tags or cards are passive devices. They store data that can be retrieved by active NFC
devices. The most common example of NFC use involves a contactless payment system, in
which a smartphone can be swiped at an NFC reader (which are increasingly being installed
near a store's cash register) 1o make a contactless payment. The NFC device transrmits information

about the smartphone user's credit card, In this case, the reader is the NFC tag, while the

smartphone acts as an NFC device. Because NFC must occur within short range. the transaction

i5 considered secure.

3.5.2.3 Bluetooth : Bluetooth is a type of radio

communication technology that enables a low-power and a

short distance wireless networking between phones, computers

and other network devices.

Two Bluetooth devices are connected to each other while
using a process called pairing. When you press a bution or
select a menu option on the unit, a Bluetooth device initiates a

new connection, The painng details may vary depending on Fig. 3.14 Bluctooth
the type of device. PCs and other devices can also be enabled

through the use of Bluetooth dongles. Bluetooth
networks use a dynamic topology called Piconet.
Bluetooth cover only short distances, typically up to
30 feet until the most recent standard

3.5.2.4 Wi-Fi : Wi-Fi is one of a popular wireless
networking technology. Wi-Fi stands for "wireless
fidelity”. It is commonly used for wireless LAN (local
area network). Wi-Fi allows local area networks to
operate without cable and wiring, It is becoming
popular choice for home and business networks. By
using this technology we can exchange the information
between two or more devices that are of same network.
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Wi-Fi has been developed for mobile computing devices, such has laptops, but 1t is now using
for mobile applications and consumer electromcs hke televisions, DVD players and even in
digital cameras.

3.5.2.5 Radio waves : Radio waves are
a type of electromagnetic waves. These waves Radio Wave
are famous for their use in communication

Buorihiy g Anbenng
technologies, such as television, mobile Y \ '\\
phones and radios. These devices receive radio \\
waves and convert them to mechanical _/

vibrations in the speaker Lo create sound T___T

waves. When an antenna transports radio
waves they are propagated in all the directions Fig. 3.16 Radio waves
in free space.

It means that, the sending and receiving antennas do not have to be aligned. The frequency

refers to number of waves per second, it is measured in hertz (Hz),

Applications of Radio waves:
Radio waves are useful for multicasting in case where one sender but have many
receivers,

«  Examples of radio waves are television, AM and FM radio. cordless phones, and
paging.

Advaniages and disadvantages of Radio waves:

Radio waves are very powerful waves. These waves are casy to generate and penetrate

through buildings. These waves also can travel at long distances. Radio waves cover a large
area.

3.5.2.6 Micro Waves : Another important type of waves is microwave. Microwave is
defined as the part of the electromagnetic spectrum (I is a type of light, that a human eye can't
see it) with large infrared waves and short radio waves. An example of microwave is a type of
cooking that uses energy waves to cook food i.e. microwave cooking. If we talk about the word
Microwave then the prefix "micro-" indicates that microwaves are "small" because they have
shorter wavelengths ag compared to waves used in typical radio broadcasting.
Microwave Transmission is classified in two categories as follows:
Terrestrial Microwave
Satellite Microwave
Applications of Micro Waves : Due to the unidirectional properties of Micro Waves, they
are very useful when unicast (one-to-one) communication is needed between the sender and
the receiver. Cellular phones, satellite networks, and wireless LANs are using Micro Waves.
Advantages of microwaves : Microwaves are inexpensive for short distance as il requires
a higher tower for a longer distance.
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Microwave transmission 18 cheaper than cables.
«  Microwave transmission provides easy communication.
Disadvantages of microwaves:
Bandwidth is limited in microwave transmission.
= A signal can be moved out of phase and any environmental change such as rain, wind
can distort the signal so these signals are susceptible to weather conditions.
3.5.2.7 Terrestrial Microwave : These microwave transmission are sent between two
microwave stations situated on earth. It is the most common form of long distance
communication.
3.5.2.8 Satellite Microwave : A satelhite i§ an entity that revolves around the earth at a
certain height. Satellite commumication offers more flexibility than fibre optic and cable
systems. We can transmit signals from any point on the globe by using satellite transmission.

Advantages of Satellite Microwave:
Coverage of Satellite Microwave is more that Ground Microwave.
« Itis used in a variety of applications such as radio/TV signal broadcasting, weather
forecasting, radio/TV signal broadcasting, mobile communication etc.
Disadvantages of Satellite Microwave:
The manufacturing cost is very high of satellite and very expensive to launch a
satellite.
»  Transmission can go down in bad weather.

3.6 COMMUNICATION MODES
Communication mode is also called theTransmission Modes. The mechanism of transferring
data or information between two linked devices connected over a network is referred to as
Transmission Modes, It tells the direction of signal flow between the (wo linked devices.
Categories of Transmission Modes: There are three categories of transmission mode:
3.6.1 Simplex Mode
3.6.2 Half-Duplex Mode
3.6.3 Full-Duplex Mode
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3.6.1 Simplex Mode

In this type of transmission mode, communication is unidirectional that is data can be sent
only in one direction. This means you cannot send a message back to the sender just like a one-

way street.

.H’
P

- I Simplex One Direction

:

Fig. 3.18 Simplex Mode

From the two devices, only one can send or transmit on a link and the other can only

receive the data,

Example : A simplex transmission can be seen between a computer and a keyboard a
signal is sent from a keyboard but no signal can't be sent back to keyboard. A television
broadcast, television and remote are also examples of simplex transmission.

Advantage of Simplex mode:

«  In this mode. the station can utilize the entire capacity of the communication channel,
go there can be transmitied more data at a time.

Disadvantage of Simplex mode:

«  Mainly communications require the two-way exchange of data but it is unidirectional,
$0 it has no inter-communication between devices.

3.6.2 Half-Duplex Mode

In a Half-duplex mode, each station can transmit and receive the data as well. The flow of
messages can be in both directions, but not simultaneously, The entire capacity (bandwidth) of

the communication channel is utilized
in one direction at a time. In half-duplex
mode, the sender sends data and wail
for 1ts acknowledgment and 1f there is
any error, receiver can demand it to
retransmit that data. In this way, error
detection is possible in this mode.

An example of half-duplex mode
is Walkie-talkie. In Walkie-talkie, from
one side a speaker speaks, and from
the other side, someone listens. Afler a
pause, the other speaks and first-person
listens.
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Advantage of Half-duplex mode:
«  In half-duplex mode, the entire capacity of a channel is taken over by whichever of
the two devices is transmitting at the same time.
Disadvantage of Half-Duplex mode:
It canses the delay in sending the data at the correct time as when one device is
sending the data, then another has to wait to send data.
3.6.3 Full Duplex Mode
In Full duplex mode, the communication is bi-directional, 1.e., the data flow in both the
directions at the same time,
From both the ends receipt and transmission of data is possible at the same time. Full-
duplex mode has two physically separate transmission paths.It is one of the fastest mode of

communication between devices.
] B

Both A and B can Send and
Receive Simultaneously

Send

Full Dughex Wode
Fig. 3.20
Example : On a mobile phone, two people are communicating with each other both can
talk and listen to each other at the same time, this is the full-duplex transmissiomn.
Advantage of Full-duplex mode:
«  Both the stations can send and receive the data at the same fime, so the capacity of
link can be shared.
Disadvantage of Full-duplex mode:
The bandwidth of the communication channel is divided into two parts if there is no
dedicated path exisis between the devices.

3.7 NETWORK SHARING

Network sharing is a feature of a network
that allows resources to be shared over a
network, that can be fles. documents, folders,
media, elc. These are made accessible to olher
users/computers over a network.

Network sharing enables access (o

information by more than one person through
more than one device at the same or at different

Fig. 3.21 Network Sharing
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times. By connecting a device to a network, other users/devices can share and exchange

information. Network sharing is also known as shared resources.

3.7.1 Printer Sharing

Printer sharing is the process of allowing multiple computers and devices connected 1o the
same network to access one or more printers. Each node or device on the network can print to
any shared printer and, to some extent, make changes to the printer settings. depending on the
permissions set by the administrator for each user.

If a printer is attached to a computer that supports printer sharing, the computer can share
that printer with other computers on the same network. It does not matter whether the shared
printer is old or new.

How to share a printer:

From the Control Panel, open Devices and Printers.

AN it Pared i

- = & [l » ConirolBpnei » &5 Cpnipgl Rpng liems = -

Adyust your computen s settings

) Administrative Tk = audio Control WG Autoblay

A Color Management @ Credential Manager [ Date and Time

& Device Manager € By DevicesandPrintess ) e Ease of Access Center
@ FieHistory ﬂ Flash Player (32-bin A

‘;" Intermet Options . Keyboard .@ Mail (32-bit)

Fig. 3.22 Devices and Printers

Right-click the printer you want to share. Click Printer Properties, and then select the
Sharing tab,
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Fig. 3.23 Printer Sharing
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. Check Share this Printer. Under Share name, select a shared name to identify the
printer. Click OK.

3.8 PROTOCOLS

Network Protocols are a set of rules governing exchange of information in an easy, reliable
and secure way. Before we discuss the most common protocols used to transmit and receive
data over a nelwork, we need lo understand how a network 18 logically orgamized or designed.
The most popular model used Lo establish open communication between two systems is the
Open Systems Interface (OSI) model proposed by ISO.

3.8.1 TCP/IP Protocol :

TCF/IP stands for Transmission Control Protocol/Internet Protocol. TCP/IP is a set of
layered protocols used for communication over the Internet. Its communication model is,
client-server model. A computer that sends a request 1s the client and a computer to which the
request is sent is the server.

TCP/IP has four layers:

«  Application layer : Application layer protocols like HTTP and FTP are used.

*  Transport layer : Data is transmitted in the form of datagrams using the
Transmission Control Protocol (TCP), TCP is responsible for breaking up data at the
client side and then reassembling it on the server side.

*  Network layer : Network layer connection is established using Internet Protocol (IP)
at the network layer. Every machine connected to the Internet is assigned an address
called IP address by the protocol to easily identify source and destination machines.

*  Data link layer : The data link layer is called the second layer of Open System
Interconnection or OS], It is responsible for transmitting the data within a Physical
network link. It is considered the most reliable system for transmitting data from one

node to another node.
3.8.2 FTP (File Transfer Protocol) :

FTP stands for File Transfer Protocol. It is used to transfer large number of files between
the computers or over the network. The protocol that handles these requests iz File Transfer
Protocol or FTP.

3.8.3 PPP (Point to - Point Protocol) :

Point to Point Protocol or PPP is a data link layer protocol that enables transmission of
TCP/IP traffic over serial connection, like telephone line. Using PPP, home users can avail
Internet connection over telephone lines.

3.8.4 SMTP (Simple Mail Transfer Protocol) :

SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol used in sending and receiving
e-mail. However, since it is limited in its ability to queue messages at the receiving end, it is
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usually used with one of two other protocols, POP3 (Post Office Protocol) or IMAP (Internet
Message Access Protocol), that let the user save messages in a server mailbox and download
them periodically from the server. In other words, users typically use a program that uses
SMTP for sending e-mail and either POP3 or IMAP for receiving e-mail.

3.8.5 POP/IMAP Protocols :

Post Office Protocol version (POP3) is a standard mail protocol used to receive emails
from a remote server to a local email client. POP allows yvou to download ernail messages on
your local computer and read them even when you are offline. Note, that when you use POP 1o
connect to your email account, messages are downloaded locally and removed from the email
server. This means that if you access your account from multiple locations, which may not be
the best option for you. On the other hand, if you use POP, your messages are stored on your
local computer, which reduces the space your email account uses on your web server.

The Internet Message Access Protocol (IMAP) is a mail protocol used for accessing email
on a remote web server from a local client. IMAP and POP3 are the two most commonly used
Internet mail protocols for retrieving emails. Both protocels are supported by all modern email
clients and web servers,

POP protocol provides the facility to access email only from one application there as
IMAP allows simultaneous access by multiple clients. This is why IMAP is more suitable for
you if you're going to access your email from different locations or if your messages are
managed by multiple users.

3.8.6 HTTP Protocol :

HTTP means Hypertext Transfer Protocol. HTTP is the underlying protocol used by the
World Wide Web and this protocol defines how messages are formatted and transmitted, and
what actions Web servers and browsers should take in response to various commands. For
example, when you enter a URL in your browser, this actually sends an HTTP command to the
Web server directing il to fetch and transmit the requested Web page. The other main standard
that controls how the World Wide Web works is HTML, which covers how Web pages are
formatted and displayed.

3.9 NETWORE COMPONENT ADDRESSES
3.9.1 MAC Address

Stands for "Media Access Control Address.” and it does not referred to Macintosh
Computers. A MAC address is a hardware identification number that uniquely identifies each
device on a network. The MAC address is manufactured into every network card, such as an
Ethernet card or Wi-Fi card, and therefore it cannot be changed. Because there are millions of
Network-enabled devices are in world and each device has its own Unique MAC address. For
this each MAC address is designed using 6 different two hexadecimal characters separated
with colon.
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For example, an Ethernet card may have a MAC address of 00:00:0A:BB:28:FC. You do
not need (o know this address, as is automatically recognized by most networks.

3.9.2 IP Address

Every machine on a network has a unique identifier. Just as you would address a letter to
send in the mail, computers use the unique identifier to send data to specific computers on a
network. Most networks today, including all computers on the Internet, use the TCP/IP protocol
as the standard for how to communicate on the networl, In the TCP/IP protocol, the unique
identifier for a computer is called its IP address.

There are two standards for IP addresses: IP Version 4 (IPv4) and IP Version 6 (IPv6). All
computers with TP addresses have an TPv4 address, and many are starting to use the new IPv6
address system as well. Here's what these two address types mean:

[Pv4 uses 32 binary bits (o create a single unigue address on the network. An IPv4 address
is expressed by four numbers separated by dots. Each number is the decimal (base-10)
representation for an eight-digit binary (base-2) number, also called an octet. For example:
216.29.62.135.

[Pv6 uses 128 binary bits to create a single unigue address on the network. An [Pv6
address is expressed by eight groups of hexadecimal (base-16) numbers separated by colons.

% Doins To Remember

l. A computer network is a set of computers that are connected together.

3. The devices that filter traffic are called connectivity devices

3. A repealer 15 a network device that 1s used for regenerating the signal and transmitting.
4. A hub 1s basically a multipont repeater.

5. In a computer network, the hubs are categorized in three types such as: Active Hub,

Pagsive Hub and Intelligence Hub

6.  Inanetwork, a Bridge is a device that is used to connect two separate Ethernet networks
into one extended Ethernet.
A Bridge is a 2 port device.
A switch is like a multiport bridge with a buffer that can boost its efficiency and
performance.

9. A routeris a device like a switch that routes data packets based on their [P addresses.

10. A Brouter is a combination of a Bridge and a Router.

11.  Transmission media is of two types: Guided and Un-guided.

12. Optical cables are used to transfer digital data signals in the form of light up to the
distances of hundreds of miles.

13. The media that doesn't use any type of directed or guided media is called unguided
media.
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14.

16.
17.
18.

19.

!.-l

Two Bluetooth devices are connected to each other while using a process called
pairing.

Microwave Transmission is classified in two categories as follows: such as Terrestrial
Microwave and Satellite Microwave.

Satellite communication offers more flexibility than fiber optic and cable systems.
Communication mode is also called the Transmission Modes.

There are three categories of transmission mode: Simplex Mode, Half-Duplex Mode and
Full-Duplex Mode

Network sharing is a feature of a netwerk that allows resources to be shared over a
network, they can be files, documents, folders, media, etc.

Network Protocols are a set of rules governing exchange of informarion in an easy,
reliable and secure way.

"

EXERCISELD

Part-A
Multiple Choice Questions:
I. A computer is a set of computers that are connected together.
a. Network b.  System
¢.  Protocol d. Internet
I A i5 basically a multiport repeater.
a. Hub b.  Switch
¢. Router d. Brdge
. A is a 2 port device.
a.  Hub b.  Switch
¢. Router d. Bndge
IV. 'Wi-Fi stands for
a.  Wireless Field b.  Wireless Fidehty
c Wire Fire d.  Wire Fidelity
V. A is a combination of a Bridge and a Router.
a.  Switch b.  Bridge
¢. Hub d. Brouier
Write Full Forms
I. UTP 1. FTIP
. SMTP Iv. POP
V. HITP VI, MAC
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Fill in the blanks :

L  There are total .................. layers in the OS] Model.
Iy i layer of OSI model manages device addressing,.
T Tevucssssmnss media, data is transmitted using cables.
IV. Bluetooth is an example of ................. media.
V. s communication mode, data communication is unidirectional.
Short Answer Type Questions. (Write the answers in 4-5 lines)
. What is a Network?
1. Wrile different types of OS5I layers.
M. 'What is a Bridge?
IV. Why do we need a network?
V.  What is guided media?
VL What is un-guided media?
VII. Define Protocol.
Part-C

Long Answer Type Questions. (Write the answers in 10-15 lines)
I.  What are network devices? Describe any three network devices.
[1. What is Unguided Media. Write any two media.
[1I. What is a twisted pair cable? Define its advantages and disadvantages.
I'V.  What is Fibre Optic Cable? Define its advantages and disadvantages.
V. 'What is Communication Mode? Define its types.

Lab Activity
Draw a chart to represent different types of Communication Media.
Draw a chart to represent different types of Network Devices.
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4.1 INTRODUCTION TO INFORMATION TECHNOLOGY

We live in the "information world,” so information technology has become important part
of our daily life. Information technology has made the whole earth as village. It has given rise
to a global economy by connecting different economies of the world.

Information Technology (IT) has impacted the lives of all of us. The field of information
technology has gone a long way in the past few years. From moming to night we use many
products, devices and features based on information technology. Today information technology
is being used inside all sectors.

In the past, knowledge about information technology was known to very few people, as I'T
was not expanded at that time. In most places, the collection and exchange of information was
done without computers. Only a few people knew about Information Technology, who worked
in a large organization, where a large amount of data had to be stored and computers were used
for it.

But recently, information technology has spread a lot, with the help of computers and the
Internet. New discoveries based on information technology are being mvented. with which
information technology is constantly advancing.

4.2 DEFINING INFORMATION TECHNOLOGY
Information Technology (IT) 1s a technique under which computers or other physical
devices (hardware, software) are used to create, process. secure and exchange electronmic data.
In other words, Information Technology is used for the study, understanding, planning,
design, construction, testing, distribution, support and operations of software, computers and
computer related systems that exist for the purpose of data, information and knowledge
processing.
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[n simple words, in the Information Technology (I'T), we study and use systems like

computer and telecommunication devices to store, retrieve and exchange information.

Information Technology is the whole field in which computer and technology related work is
done within industry, business or in any organization.

In simple terms, we can say that the use of computer-based systems, networking systems
and other electronic devices to facilitate the transfer of information and data is known as IT

4.3 APPLICATIONS OF INFORMATION TECHNOLOGY
[nformation technology 1s used in each and every field of human life. Few applications of

Information Technology are given below:

58

Business : Technology has changed every aspect of business in a big way. Businesses
can utilize information technology through the use of computers and different
software to run their operations in a smoother fashion.

To be more specific. finance, manufacturing, human resources and security are the
main areas of business in which information technology has affected business.
Businesses use I'l in four ways to support :-

N Information-processing tasks

(2) Decision making

(3) Shared Information through Decentralized Computing and

(4} Innovation

Classroom Education : Education is one of the frontiers of technology and is
growing with technology every day. It's important that education be able to keep up
with the progress happening in technolegy by reaching students in a way that
adequately helps them to prepare for the future. This includes the use of gadgets in
teaching, such as computers, smart electronic boards, mobile phones, and tablets, as
well as the use of the internet as a medium of leamning.

Online Education : Unlike in the past when education was tied to specific
boundaries, now the education sector has changed. With the introduction of online
education services, students can learn from anywhere using the intemet; this has
helped in spreading of essential education materials to all students across the globe,
Online education i3 also being enhanced by the creation of a mobile application
which enables students to access education material via their mobile phones.
Finance : The discovery of computers has transformed the financial industry and
how business deals are transacted. It is possible for accountants to keep large
amounts of data, conduct calculations and manage financial transactions all from a
computer. With an increasing number of transactions happening online, it is important
that financial and security institutions work together to make the internet a safe
place.

Comrurer Scimnce



. Health : With improvements mm information technology, it 18 becoming easier to

reform the health sector. This makes it possible for timely care to be delivered, as
well as lor costs to be reduced. Latest information on medical science 15 readily
accessible through internet and handheld devices like personal digital assistants,
palmtops, and other.
Healthcare facilities, particularly hospitals, are using social media to establish
contact with patients, answer questions aboul practices, launch public awareness
campaigns, and perform community outreach. Nurses and doctors use hand-held
computers to record a patient's medical history and check that they are administering
the correct treatment. Results of lab tests. records of vital signs, and medicine
orders are all electronically pul into a main database that can be referred later.

. Media : Media field has been totally upgraded and transformed by the IT. Now,

media can cover news better and can distribute it for mass consumption on a larger
scale. Apart from TV and radio, online websites have been launched to keep people
up to date.
Transport : Transport sector is also under influence of information technology.
New inventions and innovations have upgraded the transport industry to a great
extent, Roadways, railways, airways, waterways all are revolutionized. It becomes
easy to get information about availability of seats, timings etc. with the help of
internel.

. Telecommunication : The progress of information technology has opened the
doors to many new services in the field of telecommunications. The computer itself
is connected to the telephone network to exchange communication through the
chamnel of e-mail. Radio-TV transmission and World Wide Web has also been made
possible. Telephone and internet services are brought together in mobile internet.
Entertainment : Computer is now an important tool in film, television and
advertisement. The computer allows us innumerable options to handle pictures.

. Defence : Information Technology is the main tool which helps in developing
missiles and other equipment in the defence system. Designing and the maintenance
are possible only through IT. IT fills the communication gap between the soldiers
and commanders through the satellites. Construction of weapons and controlling
their function becomes easy using computers.

4.4 CURRENT TRENDS IN INFORMATION TECHNOLOGY

Information technology has experienced an extraordinary growth over the last few years,
So we need to stay on top of emerging trends and how they operate.

The IT industry never stands still. This rapid, ever-changing stream is full of technologies,
tools, software frameworks and endless ideas. The list of current technology wends can be
infinite. In this chapter. we would like to focus on some of the top current information
lechnology trends.
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4.4.1 Mobile Internet

Mobile internet is an internet connection usually
through 2G or 3G or 4G mobile phone networks, This
is different from ADSL (phone line) or cable (fibre-
optic) broadband. Thus we can say that Mobile internet
uses mobile phone. No routers, cables or telephone
lines are needed.

Mobile internet gives us access to our favourite
social communities like Facebook, WhatsApp elc.
Besides these, we can also access o news, sports, and

entertainment using mternet mobile. Some common

Fig. 4.1

names of mobile internet technologies are: 2G,3G,4G, HSPA (High Speed Packet Access),
LTE {(Long Term Evolution often called 4G LTE), XLTE. VoLTE (voice Long Term Evolution)

etc,
Advantages of Mobile Internet :

Meet people : The use of social media apps like WhatsApp, Facebook, Twitter,

and Instagram has made it easy to [ind and meet peoples.

Knowing Location : With the mobile internet, we can know our location.

. Fast : Mobile internet enable quick access to information on the web.

. Up to Date : With Mobile internet we stay updated.

4.4.2 Wi-Fi Technology

Full form of Wi-Fi is Wireless Fidelity, Wi-Fiis a
technology that uses radio wave for wireless high-speed
Internet and network connections.

Wi-Fi is a network facility through which we
can connect our computer, smartphone, laptop or any
other device with internet wirelessly, but its area is
fixed. We can take advantage of this only within that
area.

An adapter for a Wi-Fi connection can be made a
hotspot that is usually a wireless router and is connected
to other devices such as lapiops, mobiles, game
consoles, or PCs [or Internet access.

Advantages of Wi-Fi:

. We can save the cost of cables and can access internet wirelessly.
. We can connect o any Wi-Fi network nearby us through hotspot.
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4.4.3 Bluetooth technology

Bluetooth is a wireless LAN D -

technology, all types of media Gles can o B o®
be transferred with Bluetooth. This Yo 4 .
technology is used to exchange Gl eeeses (('-'])') cccee s_
information between devices such as e o* ‘ .
phones, laptops, personal computers, o~ e 4
printers, digital cameras, mobile phones, E |:|
etc. within a short distance..

Advantages of Bluetooth Technology: i o

It avoids interference from other wireless devices.

. It has lower power consumption.

. Bluetooth devices are available at very cheap cost.

. No line of sight needed hence can connect through any obstacles.

The technology is adopted in many products such as head set, in car system, printer,
web cam, GPS system, keyboard and mouse.

4.4.4 E-Commerce

Electronic commerce is a way of doing .

business using Internet. The purchase or sale of @‘ ﬁ"
goods or services under e-commerce is through % L/
electronic systems such as the Internet. ﬁg!'g’-'l
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It involves electronically transferring data
or money beiween two or more parties. Some
examples of e-commerce are as follows: Online
Shopping, Electronic Payments, Online Auctions,
Internet Banking, Online Ticketing etc.

Fig. 4.4
Advantages of E-Commerce: e

E-commerce improves the brand image of the company.
E-commerce helps the organization to provide better customer services.

E-commerce helps in simplifying business processes and making them fast and
efficient.

. E-commerce greatly reduces paper work.
4.4.5 M-Commerce Technology

M-commerce, also known as mobile commerce, M-commerce 15 known as the next
generation of e-commerce, M-commerce provides users with online access to the internet
anywhere without the need of a PC or laptop anyvwhere.
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M-commerce is the purchase and sale of goods

and services through cellular telephone and wireless
digital handheld devices such as Personal Digital
Assistants (PDAS) or tablets.

Advantages of M Commerce:

It provides a convenient, secure and
easy communication and distribution
networl:.

It reduces transaction and order
processing costs.

It provides wide reach as most people
use cell phones.

It simplifies all business processes.

4.4.6 GPS Technology

GPS stands for Global Positioning System by which x

anyone can always obtain the position information E
anywhere 1n the world.It also helps us (o search the :
nearby organizations, restaurants, hotels and gas stations —
and 1s very useful for a new place etc. The Global :
Positioning System (GPS) is made possible by a group
of satellites n Earth's orbit.

Fig. 4.6

Advantages of GPS Technology :

62

Real Time Tracking : Most GPS Tracking devices are enabled with real-time
monitoring. Location of the vehicles is tracked on the map as it moves from point to
point.

Trip History : We can track all the trips made by the vehicle graphically on the
map. Information such as kilometers traveled. stoppages, idling, engine time and
average speed 15 displayed.

Alerts : Using vehicle tracking system features like over speeding alert, start of day
alert, route deviation alert and excessive stoppage alert.

Anytime Anywhere Access : The easy anytime, anywhere access with user friendly
app keeps we abreast with our vehicles movement in real time no matter where we
are.

(zeo Fencing : Geo-fencing takes alert customization to the next level, We can
create geographical boundaries called Geo fences on the map around a landmark.
Easy to use, user friendly interface : A simple and infuitive uger interface provides
powertul features like group-wise access without the need for multiple accounts.
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4.4.7 Android Technology

Android is a great operating system, the
Android operating system is a mobile operating
svstem that was developed by Open Handset
Alliance and later owned by Google to be
primarily used for touchscreen devices, cell
phones, and tablets. Android has proved to be a
very good platform for mobile devices. Android
features make it better than any other platforms.

Fig, 4.7
Advantages of Android Technology :
Support different media platform that MP3, MP4 etc.
. It supports various technologies such as camera, Bluetooth, Wi-Fi, speech, etc.

. Multitasking
. Easy Access

It is Platform-independent. It means it supports Windows, Mac, and Linux platforms.

. Large number of users.

4.4.8 Virtual Reality

Virtual Reality is a computer technology that
is used to create a fantasy world that makes us
feel like we are in that world. Virtual reality (VR
means experiencing things through our computer
that do not really exist.

Virtual Reality 18 a technique in which we
experience being in the world generated by the

¥

Fig. 4.8

computer when we watch any 3D movie so that we feel as if everything that is happening in
front of us is in reality. It is our imagination, but actually it does not happen.

Advantages of Virtual Reality

. Virtual reality has made viewing technology more enjoyable than reading.

Doctors take advantage of VR technology to learn about new medical symptoms.
Virtual reality creates a realistic world.
Virtual reality makes education easier.

The use of VR gives the user a great experience.,

4.4.9 Nanotechnology

Namnotechnology, in the context of compuler science. is a Lype of engineering geared toward

building electronic components and devices measured in nano-meters, which are extremely tiny
in size and structure
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Nanotechnology is an area where nanoparticles (microscopic materials) are practiced and
their use is found in a diverse field. Nanotechnology is present in almost all fields, Such as
Nanotechnology in computer science, chemistry, biology, physics, materials science and
engineering etc, for example the processor that is in our Smartphone is an invention of
nanotechnology.

Advantages of Nanotechnology:

. Faster and smaller non-silicon-based chipsets, memory, and processors
. New-science computers based on Quanturn Computing.

. Advanced microscopy and manufacturing systems.

. Faster and smaller telecom switches, including optical switches.

CcPU
% 32nm = 2%7.'3“ —{| CPU CPU
18nm [ ™ 1| 14nm

Fig 4.9 : Nano technology
4.4.10 5G Technology

5G is the next generation wireless technology (after 3G, 4G). It is the latest generation of
cellular mobile communications, 5G will elevate the mobile network 1o not only mnterconnect
people, but also interconnect and control machines, objects, and devices. 5G is much better
than 4G, 3G and 2G technology. 5G can be up to 100 times faster than 4G. Its intemmet speed
will be more than 20 Gbps so that large data can be easily downloaded and uploaded. With this,
HD Movie can be downloaded in 1 minute,
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Advantages of 5G:

5G network will provide high speed internet connection. 5G will provide the most
efficient uploading and downloading speed

Villages and Cities can be made smart through network connectivity.

It will introduce VE(Virtual Reality) and AR (Augmented Reality) in smartphone
sector.

Viewing space, galaxy and other planets will be very easy,

Natural disasters like earthquakes can be detected in advance.

4.4.11 Internet of Things (IoT) Technology

The Internet of Things or (IoT) is an area of technology focuses on making human life
more simplified and comfortable. It 18 a network of interconnected digital devices, machines,

objects etc. provided with unique identifiers (UID) and the ability to connect, collect and

exchange data over a wired and wireless network, with little or no human-to-human or human-

to-computer intervention. Some uses of loT are everyday objects like A.C, refrigerators,
washing machines, TVs, motor-starters, Smart Homes, smart cities, Connected Car etc.

A
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Advantages of loT:

Minimize Human Effort : As the devices of IoT mteract and communicate with
each other and do lot of task for us, then they minimize the human effort.

Improve Security : Now, if we have a system that all these things are interconnected
then we can make the system more gecure and efficient.

Save Time : Az it reduces the human effort then it definitely saves our time. Time
is the primary factor which can save through IoT platform.
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. Useful In Monitoring : It provides an advantage of knowing things in advance. So
it makes efficient management.

. Efficient Resource Utilization : 10T increase the efficient resource utilization.

. Stay Connected : We and our family members, home devices, camera etc. can
always be in the network. We can virtually stay connected.

. Efficient usage of electricity and energy : If our home appliances can operate by
themselves, electricity is utilized in an efficient way.

4.4.12 Multimedia Technology

It refers to any type of technology that can be used in the creation or display of multimedia
content, which usually consists of combinations of images and andio in a single application.
Multimedia technology includes interactive, compuler-based applications that allow people to
communicate ideas and information with digital and print elements. In this field. Professionals
use computer software to develop and manage offline and online graphics and Multimedia
contents,

Advantages of Multimedia technology:

. Increased learning effectiveness. S Jﬂ“

. (Gains and holds attention, ['_*'c; *_J--! | J

. More appealing.

. Reduces training cost. =dil |

SR ) 0 g

. Provides high quality of presentations. ‘

. Multi-sensorial.

o L) d=e

. Realistic Approach.

. Wide Variety of Formats Fig. 4.12
4.4.13 Cloud Computing

It provides us means by which we can access the applications as utilities over the internet.
It allows us to create, configure, and customize the applications online. Some types of cloud
computing technologies are:

. Cloud printing connects digital devices like smartphones, laptops, and tablets, and
workstations with printer stations. Cloud printing apps are available for smartphones
and tablets that work with almost any printer.

. Cloud storage is a way of saving digital things online; allowing we to protect
valuable data from issues and problems that effect things like flash drives, discs,
etc. cloud storage enables applications to uplead data to a network of remote,
connected servers. Applications can then maintain that data and access it from
anywhere.
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Advantages of Cloud Storage:

Data accessibility from any part of the world.

. It increases worlk efficiency.
Public file sharing
. Reduces costs of operations in the longer run.
. Remote data backups as per our own convenience.
. It reduces the costs to setup the disaster recovery and backup units.

Disadvantages of Cloud Storage:
Increased usage of bandwidth to access the data that increases the costs of operations
a bit.

. If our internet connection 15 not having a great speed, we might not be able to
access the data.

. Has security and privacy issues
Higher Internet Utilization.

Lack of total control because data is held offsite by a company we do not have

direct control on it,

‘.'_’g: Deimts To Remember

Information Technology (IT) 15 an area under which computers or other physical devices
(hardware. software) are used to create, process, secure and exchange electronic data.
Businesses use IT in four ways to support (1) information-processing tasks, (2) decision
making, (3) shared information through decentralized computing and (4) innovation.
Full form of Wi-Fi is - Wireless Fidelity.

The Bluetooth is used for voice and data transfer.

E-Commerce involves electronically transferring data or money between two or more
pariies.

M-commerce is the purchase and sale of goods and services through cellular telephone
and wireless digital handheld devices such as Personal Digital Assistants (PDAs) or
Lablets,

GPS iz the full form Global Positioning Systern.

Android operating systemn is a mobile operaling systen.

Cloud computing provides us means by which we can access the applications as utilities
over the internet,

Virtual reality (VR) means experiencing things through our computer that do nol really

exist,
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[ B

Nanotechnology in computer science, chemistry, biology, physics, matenials science and
enginesring etc.

5G will elevate the maobile network to not only interconnect people, but also interconnect
and control machines, objects, and devices.

Part-A
Multiple Choice Questions:
I.  Information Technology (IT) is an area under which computers or other physical

devices (hardware, software) are used to create, , secure and exchange
electronic data.

4. Access b.  process
¢.  define d. save
II.  With the introduction of online education services, students can learn from anywhere
using the
a.  Internet b.  electricity
¢. 3G Technology d. email
III.  Android operating system 18 a operating system.
a. Compuler b. Mobile
¢. Technology d.  Virtoal reality
I'V. Cloud computing is a kind of based compulting,.
4.  Big-data b.  IoT
¢. Internet d.  Bluetooth

Write the Full form of fellowing

. Wi-F

II. VR

M. ToT

v, IT

V. GPS

Fill in the blanks :

L is a technology that uges radio waves for wireless high speed internet
and network-connections.

I means experiencing things through our computer that do not really
ExXist,

II. M-Commerce is also known as COmmerce.

IV, storage 13 a way of saving digital things online.
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Part-B

Short Answer Type Questions. (Write the answers in 4-5 lines)
What 15 Information Technology?

Give name of any four current trends in Information Technology.
Define Bluetooth Technology.

Define GPS Technology.

What do you know about E-commerce 7

Define 5G Technology.

s<zgg8ar

Part-C

Long Answer Type Questions. (Write the answers in 10-13 lines)

I.  What is Information Technology? Describe the various applications of Information
Technology?

I[I. Describe Android Technology with its advantages.

0. Describe Internet of Things (IoT) with its advantages.
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ARTIFICIAL
INTELLIGENCE &

' CHAPTER - 5| EXPERT SYSTEMS

OBJECTIVES OF THIS CHAPTER

3.1 Introduction to Al

5.2  What is Artificial Intelligence?

5.3 Types of Al

5.4 Importance of Al

5.5 Applications of Al

5.6  Purpose or Goal of Al

5.7  Pros and Cons of Artificial Intelligence
5.8  Expert Systems

5.9 Robotics

5.1 INTRODUCTION TO ARTIFICIAL INTELLIGENCE

In this chapter we are going to study the concept of AL It is the branch of Computer
Science in which intelligent machines are created that work like humans. Al refers o a
software technology that makes a robot or a computer act and thinks like a human. The term AT
was first coined by an American Computer Scientist named "John McCarthy” in 1956 at the
Denmark Conference. He i also known as the father of A.L

5.2 WHAT IS ARTIFICIAL INTELLIGENCE?

Artificial intelligence refers to the intellectual ability developed in an artificial way. The
field of Artificial Intelligence (Al systems) encompasses compuler science, natural language
processing, math, psychology, neuroscience, data science, machine learning and many other
disciplines.

Artificial intelligence is coined from two different words:

Artificial + Intelligence
Artificial 18 said to be manmade.
Intelligence is the capacity of mind to understand primciples, truth, facts or meanings,
to acquire knowledge, and apply it to practice. It's the ability to leam and comprehend.

Artificial intelligence is therefore machines crealed by man to make life easy and
comfortable. These are computer programs or machines that help to think and leam.
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Examples of Al are : spam filters in email accounts, predictive text on Google site, smart

cars and drones system. Alexa.

In other words Al could be summarized as follows:

It creates a computer system or a robotic system, which 1s attempted to run based
on the same logic on which the human brain works.

: According to John McCarthy, it is the gcience and engineering ol making intelligent
machines, especially intelligent computer programs, that is, the intelligence displayed
by machines.

It studies about how the homan brain thinks and learns while solving a problem,
how it makes decisions and how it works.
Artificial Intelligence

Prasclic tive Tt Bea
Analytics Speech
e Speach
Learmirg o Tewt
e Spesds

Crala Empart Planning & Habotics
“ Extraction Fystems aptimization

Process

ML) -

Fig: 5.1 Human-Brain ¢embedded in Robol
During the 1940s many scientists started to work upon the possibility of creation of an
artificial brain. In 1950 Alan Mathison Turing, a mathematician, published a paper on the
possibility of creating the machines who can think. After that, artificial intelligence becomes
key area of interest for research work.

5.3 TYPES OF Al

There are vanous types of artificial intelligence. Based upon the capabilities and the
functionality of Al it can be categorize into mainly two types :- Type-1 and Type-2 which are
further divided into subtypes. Following 1is the diagram which shows the types of artificial
mtelligence.

Classification of Al

[Based on Capabilitie

I hility B Fum wty]
Hrartive
: Limfed rmsmnry ol gwarenes
P m hiness
LN

Fig 5.2 Types of Al

5.3.1 Type-1

Tvpe -1 of the artificial intelligence is based upon the capabilities in comparison with the
human being. Level of intelligence of a digital computer or machine is compared with the level
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of the normal human being. So based on this parameter artificial intelligence of Type-1 can be
further classified into three following subtypes-

«  Narrow Al

General Al
Strong Al

So we study the above mentioned subtypes of Al one by one as following:

(i) Narrow Artificial Intelligence (NAI) : It 15 a type of artifigial intelligence in which
specific dedicated tasks are performed with intelligence. It focuses on single set of abilities and
performs that task. These systems cannot perform anything beyvond there defined fields. This is
the reason that narrow Al is also known as Weak Al

Example : Apple Siri is a good example of narrow artificial intelligence. It is software
which takes our commands in our veice and gives suitable answer after analvzing it. Some
other examples are computers playing chess game and the image recognition. Another good
example 15 'video recommendation sysiem' of YouTube.

(i) (reneral Artificial Intelligence (GAIT) : In this type of artificial mtelligence computer
system can perform any generalized task given just like human beings. It has equal efficiency
as of human. It is more complex as compared to narrow Al. However there is no such general
Al system still exist which can perform similar tasks to human.

(éii) Stronmg Artificial Intelligence (SATI) : It is an outcome of the general artificial
intelligence. It is the level of Al in which the computer systems surpass human beings in
intelligence. They can perform any task befter than human. This is also known as Super
artificial intelligence. These have the [ollowing properties like

«  Abilily to think.

«  Ability to reason.

Ability to solve a puzzle.

«  Make plans and judgments.

. Ability to learn, communicate itself.

However it is a hypothetical concept. Still there is lot of work to do in this area. It may be
possible in the near future.

So from the above mentioned three subtypes from TYPE-1 of artificial intelligence, we
can summarize the key points as follows-

+  NAI - performs one specific task.

*  GAI - same ability as human.

SAI - more ability than human.

5.3.2 Type-2
Type -2 of the artificial intelligence 1s totally based upon the functionality and capability
in comparison to the human beings. So TYPE-2 Al is classified into the following four
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categories described below-
Reactive machines
' Limited Memory
Theory of Mind
Self-Awareness

(i) Reactive Machines : Reactive machines are
basic in that they do not store 'memories’ or use past
experiences to determine future actions. They simply
perceive the world and react to it. IBM's Deep Blue,
which defeated chess grandmaster Kasporov, is a
reactive machine that sees the pieces on a chess board
and reacts to them, So they only focus on the
completion of current task in a best possible way.
Because they have no memory so they cannol use
previous data for future tasks. So they behave in the
same manner all the time when the same situation
comes,

Example : Deep Blue System of IBM. Similarly
Google's AlphaGo is another example of reactive
machines.

(ii) Limited Memory Machine : Limited
Memory machines can retain data for a short period
of time. While they can use this data for a specific
period of time, they cannot add it to a library of their
experiences. Many self-driving cars use Limited
Memory technology: they store data such as the recent
speed of nearby cars, the distance of such cars, the
speed limit, and other information that can help them
to navigate on the roads. Example: Self Driving car.

(iif) Theory of Mind : The idea in this artificial
intelligence type is to understand the emotions, beliefs
of people and react according to these. As the name
of this Al is "theory of mind", it is a concept of
understanding the behavior of human beings and then
reacting to it. This is related to human psychology.
However no such machine 15 completely developed.
Researchers are making huge efforts for the making
of these types of machines.
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(iv) Self-Awareness : These machines are a concept of future and have not been developed
vel. These are on theoretical side and are the future of the artificial intelligence. These
machines will have the properties of

*  Sentiments

Self-awareness
Super intelligent
*  CONSCIOUSDESss

This type of Al ¢an be ¢onsidered as the further advanced extension of the Theory of mind
AL This concepl may be possible in near future. However no such super intelligent sell-aware
machine or system is present till now.

5.4 IMPORTANCE OF Al

Artificial Intelligence plays a vilal role now-a-days. It is almost used in every corner of
latest technology. Many new type of automatic computer systems replaced human beings and
thus reduced their workload. Al provides a new concept to this world that how we can achieve
the impossible goals with very ease. Many revolutionary innovations are presented in front of
world due the existence of Al This has a very important role in today's human life and is going
to increase in upcoming time. Areas of importance of Al's are several and here we are going to
discuss some of them as below-

(i) Game Playing : Al plays an important role in strategic games such as chess, poker, fic-
tac-toe, etc. where the machine can think of a large number of possible positions.

As we know a Deep Blue game of chess was made by IBM and after up gradation it even
beat the world chess champions. Today there are number of latest games which are played by
the user are due to the Al

(i) Voice Recognition : This technique transforms the words spoken by the user into text
form. It is also known as speech recognition. For examples applications of Google and other
companies that ask you to speak on the mobile and it will answer you. Apple's Siri s also an
example of speech recognition as it gives the answers to the questions of the user in voice form.

(ifi} Understanding the Natural Language : Al is best used in the area of natural
language processing(NLP).The language which human speaks is known as natural language
like Punjabi, Hindi, English, French etc. So the interaction process between computers and
human 1s known as NLP. The main works of natural language processing is text translation:
grammatical analysis and speech recognitions.

Some examples of NLP are : Dragon Dictation, Evemote for Android, Spell check,
Autocomplete, Voice text messaging, Spam filters,related keywords on search engines, Alexa,
or Google Assistant

(iv) Computer Vision & analysis : Al has an important role in computer vision. Computer
vigion stands for representing three dimensional (3D) real world information into very
understandable form just like human's eye do. Computer vision helps in patiern recognition. It
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automnatically extracts information from the images and provides crucial information. Al's
ability to read both medical images and medical records could save the vast amount of tme
that radiologists and cardiologists spend diagnosing disease.

5.5 APPLICATIONS OF Al

Artificial intelligence Al has a huge impact on many of the fields and some of them are
mentioned below:-

(i) Intrusion Detection System : IDS system can be developed by using artificial
Intelligence. It 15 type of security software designed to automatically alert administration when
someone or something is trying to violate the security system and perform a malicious activity
that can damage the data or system. Example of IDS is firewall that can block unauthorized
sites, email services against spam, Network Intrusion Detection System

(if) Gaming : It plays an important role in strategic games like chess, tic-tac-toe ete. Here
the machine should be able to think of multiple possible steps based on heuristic knowledge.

(fii) Natural Language Processing : Able 1o communicate with the computers that
understand human nsed natural language.

(iv) Machine Learning : Machine learning is an application of artificial intelligence (AI)
that provides systems the ability to automatically learn and improve from experience without
being explicitly programmed. Machine leaming focuses on the development of computer
programs that can access data and use it learn for themselves. The process of learning beging
with observations or data, such as direct experience, or instruction. The primary aim of
machine learning is to allow the computers learn automatically without human intervention or
assistance and adjust actions accordingly.

(v) Expert Systems : There are a few applications which incorporate machine, programming,
and some special data to confer thinking and prompting. They give clarification and exhortation
to the users.

(vi) Vision Systems : These types of systems are able 1o understand, interpret and grasp
visual input on the computer. Ex: A spying plane or drone takes pictures. which are utilized to
make sense of spatial data or guide of the zones and areas.

(vit) Speech Recognition : You will find some systems which are able to understand the
language which is used by humans and talk to them. They can even understand the slang,
background noise, accent etc.

(viti) Handwriting Recognition : This special software will be able to read the text
written either by a pen or stylus on paper or screen respectively. It also understands the letter
shapes and will convert it into editable text.

{ix) Intelligent Robots : Robots are one of the best creations by hwmans. They can do
multiple tasks within no time. Though they cannot be alternate to humans but are very efficient
when doing any tasks. The best part about these systems is that they are adaptable to the
environment around them.
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5.6 PURPOSE OR GOALS OR USES OF ARTIFICIAL INTELLIGENCE
Some of the common goals of Al are given below:
. Al is used to develop reasoning and problem-solving skills.
« Al 1s used for easy representation of knowledge.
Al is used to develop intelligent machines.
Al is used to work with sensors (take mput from sensors) and react accordingly.

« Al is used to improve productivity, efficiency and accuracy.
5.7 PROS AND CONS OF ARTIFICIAL INTELLIGENCE
5.7.1 Pros of Artificial Intelligence

Here are the advantages of using Artificial Intelligence (AI).

(i) It Is Cost-Effective : Unlike humans, robots and machines do not have to get paid
every month for the work they do. Hence, it helps to reduce and to control the cost by using
artificial intelligence.

(if) They Don't Take Rest : machines and robots can perform lengthy and important tasks
in a more effective manner. Unlike humans, machines don't need to rest or take a break. They
don't need to eat or sleep like us and never fell ill or take leaves.

(ii7) It Enhances Efficiency : Artificial intelligence provides work efficiency. Maching
would be able to perform even the most complex tasks without any error.

(iv) Low Error Rate : In Al we have a low error rate as compared to humans, il it is
coded properly.

(v) Work in hostile Environment : Tt can work in even the most hostile environments,
thug able to complete dangerous tasks, explore in space. and endure problems that would injure
or kill us. The A.I robots are used even in mimng and digging fuels that would otherwise be
hostile for humans.

(vi) Good Assistants : It is very good at prediction as in a smart phone it can easily predict
what a user will type, ask, search, and do. They can easily act ay assistants and direct various
actions.

(vii) Make Repetitive task easier : It can perform repetitive task in easy manner whereas
human get bored in doing

(vifi) Machines Don't Have Emotions : Since machines don't have emotions, there are no
chances of any emotional barriers getting in the way of the workplace. Mothing is going to
affect their performance.

5.7.2 Cons of Artificial Intelligence

Cons of Artificial Intelligence are given below:

(i) Machines Cannot Feel Compassion And Sympathy : There is no doubt that machines
are much better when it comes lo working efficiency but they cannot replace the human
connection that makes the team.
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(i) Increase in Unemployment And Jeb insecurity Issues : With more and more
machines being designed, there will be an abrupt increase in unemployment and job security.
Since machines are replacing human resources, the rate of people losing their jobs will
increase.

(iii) Risk of Loss of Important Data : We use computers, smart phones and other devices
to store almost all our important documents, files, pictures, and videos. Once lost, it is not
possible {or very difficult) to retrieve this information. This can cause serious trouble for your
businesses.

(iv) The exploitation/misuse ol artificial intelligence : Misuse or exploitation of anything
is bad. We often hear threats that the misuse of technology can bring the world to a destructive
end. This stands true to a great extent as we have seen in animated movies and films related
with Al of Hollywood. If Al is given into wrong hands, high technology machines can
definitely destroy society.

5.8 EXPERT SYSTEMS

Expert systems are computer programs that are derived from a branch of computer science
research called Artificial Intelligence (Al). The piece of software which uses databases of
expert knowledge to offer advice or make decisions

In other words we can say expert system is a type of software that uses knowledge base to
solve a problem. It is mainly developed using artificial intelligence concepts, tools and
technologies, and possesses expert knowledge n a particular feld, topic or skill. Expert system
1% a computer program which transforms knowledge of an expert into a software.

Expert systems are created to find the solution of complex

problems in particular area,We can depict the working of Expert
Systems as shown in the figure 5.6.

Expert system is decision making software. It gains the knowledge
and capability of problem solving of experts in various fields and [RMeISIg@SR ety
then gives responses, The knowledge which it gains from expert
person is known as knowledge base. So experl systems are the best
example of knowledge based systems. Following are some more

examples of expert system:
DENDRAL : system expert in chemical analysis.
MYCIN : system expert in treating blood infections.
»  CADET : system expert in detecting cancer at early stages.
PXEDS : system expert in detecting degree of lung cancer.
5.8.1 Components of Expert System
The expert system contains the following components which are described below-
[.  User interface
[I. Imference engine,

I, Knowledge base
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(i) User Interface : It is the interface between user and inference engine. This component
takes the questions of the user and then sends it to inference engine. After getiing the result it
send the angwer to the user.

-y

Base
Human Knowledge
Expert Engineer ;

Inference
Engine
User S :
Interface
User
{May not be an expert)

Fig 5.7: Block diagram of expert system

(if) Inference Engine : It is known as the core of the expert system. It takes queries from
user and draw conclusions by watching facts and applying rules. Then it sends the result to user
interface. It is also called the brain of the expert system.

(iti) Knowledge Base : It is a place where the knowledge from the human experts 1is
collected. Inference engine checks the facts and data from the knowledge base and then draw
the conclusions.

5.8.2 Characteristics of Expert Systems

The characteristics of an expert system are as follows-

78

Expertise : The expert system is expert in a particular area. For example MY CIN
expert systern finds the blood infections with high ageuracy. So they are a high level
of expertise.

Quick Reaction Time : Expert systems are quick in their response when questions
are asked by user. Reaction time is very short.

Flexible : It is more flexible in handling questions.

Reliability : It 1s more reliable becavse it does not make any mistake.

Decision Quality : Expert systems make the high quality decisions.

Consistent : They provide consistent answers for the same questions.

Cost effective : It decreases the cost of consulting an expert for varieus domains such
as medical diagnosis.

Successful forms of artificial intelligence (Al) : Expert systems are among the first
truly successful forms of artificial intelligence (A) software.
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5.8.3 Limitations of Expert systems
Dom't have human-like decision making power.
Can't possess human capabilities.
«  Can't produce correct result from less amount of knowledge.

«  Requires excessive (raining,

5.8.4 Comparison between Human and Expert Systems

It is subject to destruction. It is permanent.

Humans are unpredictable. These are consistent.

These are nol easily transferable, These are easily transferable.

e
e Al T

Human experts are expensive. These are less expensive as compared

to human.

5.9 ROBOTICS

The term robotics stands for the study of robats.
Robotics means for the designing, creation, working
and the usability of the robots. Robots are the
machines which do the work for humans. Robotics is
a combination of science and engineering. It includes
the branches of computer science, artificial

intelligence, nanotechnology ete. Fig. 5.8

Robots are very useful for humans. These are providing helping hands to humans. Robots
are replacing the working humans in many areas. Robots are the smart machines which can do
the work by following the instructions themselves. It is the new growing field which has a lot
of oppoertunities for advancement.

We can define robots as the machines with programming which can carry the series of
operations for doing a task, They can react in this real world with the help of sensors.

5.9.1 Generations of Robots

Generally we divide the robots into four generations depending upon the use of hardware
and software technologies.

First Generation Second Generation
{Before 1980) (1980-1990)
Generations of Robots
Third Generation Fourth Generation
(1920 - |ater) (2000 - Beyond)

Fig 5.9: Generations of robois
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(i) First Generation : These are mechanical robots and they don't use external sensors. Al
15 absent in this generation. They have good precision and high speed also.

(if) Second (Generation : These types of robots use various sensors like pressure sensors,
position sensors etc. They have vision system and are programmable.

(iti) Third Generation : These generation robots are autonomous. They use artificial
intelligence. They have speech recognition and navigation techniques.

{(iv) Fourth Generation : These are smart as human beings. They use the advanced level
of Al. These are the foture of robotics.

5.9.2 Applications of Robotics

As we all know that robotics is the latest trends in technology. There are lots of applications
of robotics a3 mentioned below-

«  Military robots : perform military applications such as rescue, search and attack.
Research robots : collect and analyze the data for research work.
Domestic robots : helpful in household.

«  Construction robots : helpful in construction of buildings, brick layving etc.

»  Healthcare robots : used in medical field such as surgery.
Industrial robots : performs repetitive tasks of human beings.

«  Space exploration : provide immense help (o astronauts.

5.9.3 Some Languages used to develop Al are

(i} Python : Python is now most widely used language in Al development due to the
simplicity. The syntaxes belonging to python are very simple and can be easily learnt. Therefore,
many Al algorithms can be easily implemented in it. Python takes short development time in
comparison to other languages like Java, C++ or Ruby.

(i) R : R is one of the most effective language and environment for analyzing and
manipulating the data for statistical purposes.

(iii) Lisp : Ligp is one of the oldest and the most suited languages for the development in
AL Tt was invented by John McCarthy, the father of Artificial Intelligence in 1938.

(iv) Prolog : Prolog is widely used for working on medical projects and also for designing
expert Al systems.

(v) Java : Java can also be considered as a good choice for Al development. Artificial
intelligence has lot to do with search algorithms, artificial neural networks and genetic

programming.

‘2> Dofiuts Fo Remomber

1. Artficial intelligence refers to the intellectual ability developed in an artificial way.
1. Al can be categorized into mainly two Lypes -Type-1 and Type-2.
3. Apple Siri is a good example ol narrow artificial intelligence.
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9.

10.

11.
12.

Reactive machines have no memory and thus unable to store data.
Importance of Al- game playing, voice recognition, NLP, computer vision.
Al is used (o improve productivity, efficiency and accuracy.

Expert system is a computer program which transforms knowledge of an expert into a
software.

Inference Engine is known as the core of the expert system
Dendral, Mycin, cadet are famous expert systems,

User interface, knowledge base and inference engine are the components of expert
system.

The term robot stands for the study of robts.
Some Languages used to develop Al are: Python,R, Lisp,Prolog, Java etc.

ENERCISE ey
Part-A

Multiple Choice Questions:
1. Who brought the concept of Al?

a)  Victor Allis b)  Marvin Minsky
¢)  Alan Taring d) John McCarthy
II.  Which type of Al focuses on single set of abilities &performs a particular task?
a)  Super Al b)  Narrow Al
c¢) General Al d}  None of these,
M.  Which one of Al type does not have memory for data storage
a)  Limited Memory b}  Things of Mind
¢)  Reactive machines d}  Self Awareness

IV.  Brain of expert system 1is :-

a)  Knowledge base b) Inference engine
¢)  User Interface d)  None of these

V.  Place where knowledge from the human expert is collected
a)  Domain expert b) Knowledge Base
c)  User d)  All of these

VL. Robots which provides help for analyzing the collected data are
a)  Healthcare robots b} Domestic robots
c¢)  Military robots d)  Research robots
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Fill in the Blanks:

1.  Artificial Intelligence is divided into two types and
1L is a chess playing computer developed by IBM.
111 18 a good example of narrow artificial intelligence.
IV. machine have no memory.
V. MYUCIN and are examples of earlier expert systems.
VI Generation Robots are smart as humans.,
Wrile the Full form of following:
1. Al . GAI
. NLP IV. SAI

Part-B

Short Answer Tvpe Questions. (Write the answers in 4-3 lines)

I.  What is artificial intelligence?

Il.  What are the types and subtypes of AI7 Depict them with the help of diagram.

[II.  What do you mean by expert systems? Give examples of expert systems.

I'Y.  What is the difference between human system and expert system?

V. Summarize about some computer languages used in the field of AI?

Part-C

Long Answer Type Questions. (Write the answers in 10-15 lines)
I.  What are the applications of artificial intelligence?

II.  What is the importance of Al?

III. What are the Pros and Cons of Artificial Intelligence?

V.

Diiscuss the characteristics of expert sysiems?

Lab Activity

Draw a chart to represent the Block Diagram of Expert System.

B2
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CHAPTER - 6 DIGITIZATION

OBJECTIVES OF THIS CHAPTER

6.1 Introduction to Digitization
6.2 E-Commerce
6.3  Digital or Online Payment

64 E-Leaming
6.5 National Academic Depository (NAD)
6.6  Digilocker

6.1 INTRODUCTION TO DIGITIZATION

Digitization is the process of converting information into a digital (i.e. computer-readable)
format, in which the information is organized into bits. In moderm practice, images, documents,
audio, video, etc. are being converted into digital format and digitally stored with the help of
computer hardware.

By doing this, information can be stored safely for a long time, as well as it become easy
lo access and work on digitized data.

El_E. o (R .. .. D.z::;t?

DOCUIENTS DIGITZATION E,d]:lyl

SCANNING

Fig 6.1: Digitization
Nowadays, approximately every government record is digitized, due to which services
are being provided easily and m a fast way to the ¢itizen. For example, Land record (Farad),
Aadhar, various subjects e-books available on website of Punjab School Education Board,

etc.
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6.2 E-COMMERCE

E-Commerce. also known as electronic comimerce or internet commerce. referred as
buying and selling of goods or services, use of services, monetary transactions, etc. using the
internet. With the facility of E-Commerce, business gets new direction and growth. Examples
of e-commerce websites are: Amazon, Flipkart, eBay, OLX, Quikr, etc.

A * -

. | i ‘-
."":# i L T e
Corntirtre fherein ] g.“_,..'.nw

gﬁi
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Fig 6.2: E-commerce warkflow

6.2.1 Types of E-Commerce

E-Commerce can be classified into four main categories, on the basiz of the parties that are
involved in the transactions.

Fos I’
Business lo ] [ Business to
Business I Customer

N

| L

Types of

TE— E-Commerce .

L% I,
Customer to Customer to
Customer Business
% .

Fig. 6.3 Types of E-Commerce

(i) Business to Business (B1B) : Here the companies are doing business with each
other. The final customer is not involved, only manufacturers, wholesalers, retailers etc. are
involved.

(if) Business to Customer (B2C) : Here companies and customers are involved. Companies
sell their goods and services directly to the customers. The customer can browse company
websites and choose the product or service and pay online directly to the company. The
company ships the goods directly to the customers on their address. Examples are Amazon,
Flipkart, eBay etc.

(fif) Customer to Customer (C2C) : Here customers and seller are in a direct contact
with each other, no company is involved. It helps people sell their personal goods and assets
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directly to each other. Usually, people sell their used or additional goods to the interested
buyer. Example: OLX, Qukr.

{fv) Customer to Business (C2B) : This is the reverse of Busginess to Customer, Here
customer provides a good or some service to the company. Say for example, an IT freelancer
who demos and sells his software to a company.

6.2.2 Advantages of E-Commerce

(i) Overcome Geographical Limitations : E-commerce removes the barrier of geographical
distance i.e. distanl areas. It provides the sellers with a global reach.

(1) Lower Caosts : E-commerce substantially lower the transaction cost, because buyer
purchase the product directly from the manufacturer, which eliminates many fixed costs and
taxes. Moreover, to buy goods buyer need not to go anywhere which cuts the transportation
cost as well.

(iii) Quick and Easy Delivery : It provides quick delivery of goods to the customer on the
given address, Customer complainis are also addressed quickly. It also saves time, energy and
elfort for both the customers and the company.

{iv) Available 24x7 hours : One other great advantage is the convenience of shopping it
offers. A customer can shop anytime, any day. There are no closing days or hours.

(v) Easy shopping : While we are shopping in the market, sometimes shopping becomes
difficult due to heavy crowd whereas on internet, no such thing happens. We may opt for our
required product from the wide range of products over there.

(vi) Easy accessibility : In e-commerce, customer can browse product category pages and
use the site search feature to find the product immediately, compare with other similar producis
and select the best of them.

6.2.3 Disadvantages of E-Commerce

(1) Wait time : If a customer sees an item that he or she likes in a store, the customer pays
for it and then goes home with it. With e-commerce, there is a wait time for the product to be
shipped to the customer's address.

(if) Unsure about the quality : When customer buys an item from store, customer can
check the quality of the item before shopping. One of the biggest problems with buying things
online is that you will have no guarantee of a products’ quality. Customer only comes to know
about the quality of the item after receiving it.

(1i7) Security issues : E-commerce sites record all the important details about the customers
which are to be kept secured. If an unauthorized person or group gains access to such important
details of customer, then customer has to bear heavy financial or personal damage. Customer's
money can be withdrawn without customer’s knowledge and further customer's identity can be
misused.

{iv) Not able to try belore buy : While buying online an item, customer will not have
much ability to inspect physically. For example, if customer goes to a shop to buy cloths,

DiirrizATION 85



customer can (ry or wear the cloths to check if fits properly and suits. But in online shopping,
il 18 not possible.

6.3 DIGITAL OR ONLINE PAYMENT

Digital payment, also called Online Payment or e-payment or electronic payment. It is a
cashless, easy and fast way of payment, which is made through digital modes. In digital
pavmenls, payer and pavee both use digital modes to send and receive money. In today's ame,
online payment method is popular. Money transfer, shopping, mobile or dish recharge, waler or
electricity or phone bills can easily be paid via digital payment mode.

6.3.1 Online Payment Methods

L. Credit Cards 1i. Debit Cards
i.  E-Wallets iv. Net Banking/ Banking Apps
V. Mobile Banking VL BHIM App

(i) Credit Card : It is a form of an e-

avment system in which banks or fnancial '
R . : CREDIT CARD
insiitutions 1ssued their customer "a small

plastic card" with a unique number and a coded F

magnetic strip embedded on it which is used - /

to read credit card via card readers. =27 SIS 35 et © E

When a customer purchases a product via g 1150

¢redit card, credit card issuer bank pays on
behall of the customer and customer has a
cerfain time period in which he/she can pay
the credit card bill. When customers do shopping using credit card then customer has to swipe
hig/her credit card on swipe machine (card reader machine) and has to enter a 4 digit secret pin

Fig. 6.4

number. Payment stands successful if the secret pin is entered correctly. Customer has to keep
secure his/her 4 digit pin number to avoid misuse of his/her credit card.

(if) Debit Card : Debit card, like credit card,
is a small plastic card with a unique number mapped
with the bank account number and a coded magnetic
sirip embedded in it which is used o read credit
card via card readers.It is required to have a bank
account before getting a debit card from the bank.
The major difference between a debit card and a
credit card is that in case of payment through debit
card, the amount gets deducted from the card's
bank account immediately and there should be
sufficient balance in the bank account for the
transaction o get completed.

Fig. 6.5
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(iif} E-Wallets : In this method of payment, digital payment apps are used. These apps
store the credit card/debit card or inked bank account information of the customer for easy
payment. E-wallet 15 the digital version of your physical wallet with more functionality. You
can keep your money in an E-wallet and use it when needed. User name and password is used
to use E-wallet. Examples of E-wallets are: PayTm etc.

(iv) NetbBanking / Banking Apps : NetBanking also called as Internet Banking. This
facility is like a revolution, in the era of the traditional banking systerr, which does not require
customers to visil the bank branch to perform a simple bank transaction.

Put simply; NetBanking 15 an electronic pavment system, that allows the bank account
holder to execute the different types of transaction, such as bank account statement, fund
transfer, bill payments, fund transfer to saving schemes, etc. anytime and anywhere using the
bank's website. To avail this facility, customer has to visit bank branch once and applyfor Net
Banking by filing an application, concerned bank than issues a unique user name and password
to its customer to use NetBanking, This user name and password is very sengitive and important
and must be kept safe by the concerned customer and must be used in a safe and secure
manner. If any unauthorized person gain access to the NetBanking user name and password,
than money from particular account can be stolen. Therefore banks also advice customers to
use NetBanking safely.

OSBI

| Home  Products & Services  How Do

| Login to OnlineS8I

E {CARE: Usotmami i pEseword an

i Liszmiama”

| II How Usar? Beascher harp

.
| Passwors T

Fig. 6.0 NetBanking Login Screen

(v) Mobile Banking : Mobile banking can be described as the facility provided by the
banks to its clients, in which they can access their bank accounts and undertake monetary
transactions remotely such as mini statement, balance etc. using mobiles by sending specific
format SMS (Short Messaging Service). For this, bank issues specific phone numbers on
which customers need to send SMS in prescribed format to get required information or to
perform other transactions. For this bank charge some amount from the customer.
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(vi) BHIM App (Bharat Interface for Money) : BHIM (Bharat Interface for Money) is a
mobile application designed by NPCI (National Payment Corporation of India) and based on
UPI (Unified Payment Interface). It is a simple, easy and fast way of payment, for which UPI
ID or QR (Quick Response) Code of concerned person is used for payment. One ¢an transfer
funds, do bill payments, buy tickets, recharge mobile or dish etc. with the help of this app.

EHIMp

BHARAT INTERFACE FOR MOMNIETY

Mow send & receive money
instantly using your mobile.

Fig. 6.7
6.3.2 Benefits of Online Payment

(i} Easy and convenient : Digital payments are easy and convenient. You do not need to
carry cash always.

(if) Pay or send money from anywhere, anytime : With various digital payment modes,
you can send or receive money from anywhere, anytime.

(it} Cash Back Benefiis/Discounts : Government has announced many discounts to
encourage digital payments.

6.4 E-LEARNING

E-learning is also called as Electronic Learning/Online Leaming/Online Education and it
means to get education through the internet, It's an easy and convenient way to get education,
in which one can opt for desirable course from the wide list of courses and subjects available
online and one can study from home. This technique is very useful for job oriented people and
residents of remote area locations where no nearby educational institute is present. This
lechnigque has removed the geographical hmitations, Learner even can get admission in foreign
school, college or university through online mode and study at home and give online exam also
and if successfully completed the course, can download the course completion certificate
online or can also demand hard copy on his/her address. Concerned institute send all the
required study stuff to the learner through internet in the form of e-books, video or audio
lectures, presentations etc. Learner can download the required study stuff on his computer to
study.

Some of the popular tools for E-Learning:

MOOCs
2. SWAYAM
3. SWAYAM PRABHA
4. PSEB E-Books
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(i) MOOCs (Massive Open Online Courses) : MOOCs (Massive Open Online Courses)
are Tast gaining popularily among students and working professionals as they help them study
at their convenience and time. Here wide list of courses if offered and learner can opt for
interested course, can use study stuff provided there. These courses are available at:
WWW.mooc.org, www.edx.org

(i) SWAYAM (Study Webs of Active-Learning for Young Aspiring Minds) : The
program of Human Resource Development Ministry spells out as Study Webs of Active-
Learning for Young Aspiring Minds (SWAYAM). Like MOQCs, it also offers wide range of
courses. The SWAYAM program offers digital classrooms with the help of internet and satellite
connectivity to the remotest corners in the country. Swayam provides online study material to
students free of cost. This covers courses from class Sth lo post-graduation. To use it, a
SWAYAM Application can be downloaded or from https://swayam.gov.in

(i) SWAYAM PRABHA : The SWAYAM PRABHA is a group of 32 DTH channels
devoted to telecasting of high-quality educational programmies on 24X7 basis using the GSAT-
15 satellite. Every day, there will be new content for at least (4) hours which would be repeated
5 more times in a day, allowing the students to choose the time of their convenience. The
contents are provided by NPTEL, IOTs, UGC, CEC, IGNOU, NCERT and NIOS. The
INFLIBNET Centre maintains the web portal www.swayamprabha.gov.in. This program
covers: Higher and Secondary Education, preparation of various competitive exams.

6.5 NATIONAL ACADEMIC DEPOSITORY (NAD)

The vision of National Academic Depository (NAD) is born out of an initiative o provide
an online store house of all academic awards/certificates. National Academic Depository
(NAD) is a 24X7 online facility. Using NAD one can store his/her documents/awards/certificates
digitally and one can download the same. NAD not only ensures easy access to and retrieval of
an academic award but also validates and guarantees its authenticity and safe storage.

6.6 DIGILOCKER
Digil.ocker is targeted at the idea of paperless governance; Digilocker is a platform for

issuance and verification of documents

& certificates in a digital way, thos CITIZENS

gliminating the use of physical @

documents. Indian citizens, who sign

up for a Digilocker account, get a l

dedicated cloud storage space that is

linked to their Aadhaar (UIDAT) dphely

number. Organizations that are ﬁ & (5 T

registered with Digital Locker can push - = — = E

electronic copies of documents and

B COTLMETS

certificates (e.g. driving hicense, Voter Fig 6.9: DigiLocker
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ID, different certificates) directly into citizens' lockers. It provides 1GB storage space to a
person who registers on it..

6.6.1 How to use DigiLocker

i

Ll

I.

2

Go to htps://digilocker.gov.in website or download Digilocker app on vour
smartphone. Using your Aadhaar number and mobile number vou can create a user
1D using an OTP.

If some organization has uploaded any of your e-documents, you can see it in the
account, You can alse upload your own documents and e-sign theni.

You also get the [acility of sharing docurnents with others by sharing a link to the e-
document,

Note : Donot [orget to logout from your Digilocker account after using it.

%" Dolmfs o Remember

Digitization is the process of converting information into computer readable and storable
form.

E-Commerce means to buy or sell things, use services, monetary transactions using
internet.

Digital Payment is a cashless, easy and fast online mode of payment.

NetBanking is the online facility provided by banks to its customer by which customer
can perform monetary transactions, get account statement, pay bills etc.

E-learning is the simple and convenient way to get education through intemnet from
home,

National Academic Depository is the online initiative where one can upload and store
securely, important documents.

Digil.ocker is a platform for issuance and verification of documents & certificates in a
digital way.

Part-A (Questions carrying 1 Mark each)

Multiple Choice (Questions:

1. __is the process to convert information into computer readable form.
a)  E-learning b) E-commerce
¢)  Digitization d) Net Bankmg
I1. is meant to be online buying and selling of goods.
ay E-commerce b) Dim Locker
¢} Digital Payvment d) None of these
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L  Easiest and convenient way for cashless payment is

a)  Digitization b) Storage
¢)  Offline d)  Digital Payment
v stores only those educational certificates, issued by educational institutes
through digital mode.
al  SWAYAM b) NAD
c) MOOCs d)  Digilocker
V. ______ isatype of eccommerce which involves company and customer.
a) BIB b) B2C
& e2e d}  MNone of these
Write full forms :
. BZB II.  B2C
. czc IV. NAD
V. UPl

Part-B (Questions carrying 3 marks)

Short Answer Type (Questions. (Wriie the answers in 4-5 lines)
What is digitization”

Describe NetBanking.

What you mean by e-commerce 7

Name types of e-commerce.

Write down the benefits of online payment.

Describe Digi Locker.

VII. What is e-learning?

VIIL. What 1s digital or online payment?

S=<<2EFRT

Part-C (Questions carrying 5 marks)

Long Answer Type Questions. (Write the answers in 10-15 lines)
L. Write down the types of e-commerce in detail.

[I. Write down the advantages and disadvantages of E-commerce.
[ Give brief note on various digital or online payment modes.

Lab Activity

Download your 10th class certificate from Digi Locker.

Download E-book of computer science for 11th Class from PSEB website.
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(PART II)

'CHAPTER - 7| E-GOVERNANCE

7.1
1.2
T3
74
1.5
1.6
i
7.8
e

Introduction

OBJECTIVES OF THIS CHAPTER

Concept of E-Governance

Waorking System of E-Governance
Levels of E-Governance

Benefits & Drawbacks of E-Governance
What is Smart Governance?

Sarba Sewa/Sewa Kendra/Sanjh Kendra
Awareness of Aadhar

Information System

7.1 INTRODUCTION
E-Governance stands for electronic governance. It means to implement and organize

government policies, orders and services effectively. After getting its literal meaning it is

important to know that what kind of electronic rule 15 E-Governance and which activities

certified it as an electronic rule. Let's know what in fact E-Governance 157

7.2 CONCEPT OF E-GOVERNANCE

The word Governance refers to the activities of a government. It is the set ol rules and
laws framed by the government that are to be

implemented through the representatives of

the state. To support and simplify governance
for government, citizens and businesses,
E-Governance has been introduced in the

recent times.

E-Governance is an application of
mformation and commumcation technology

which uses mternet (web portals, emails ete.)

and other electronic media (mobiles,

We

E-Governance

WA

computers, tablets etc.) to provide services Fig. 7.1

a2

CoMPUTER SCIENCE



and facilities offered by government to its citizens in a transparent, speedy and cost-effective
way. As meaning of E-Governance clears that E-Governance is a kind of rule done by electronic
media using internet. Today, every work is done online whether it is government or non-
government.Even the facilities and services provided by government to its citizens are online
and payments in return to these services and facilities are also done online.

7.3 WOREKING SYSTEM OF E-GOVERNANCE

As discussed above, E-Governance is a working system in which governments, citizens
and organizations take part in the online facilities and services. They do their activities using
internet in different ways. The working system of E-governance can be divided into following
parts:

E-GOVERNANCE

Fig. 7.2

(7)) G2G (Government to Government) : In this type of E-Governance, data and information
is shared between Central Government and State Governments and vice versa. Further, Govt,
agencies, departments or organisations come under the preview of Government to Government
E-Governance by improving communication, data access and information sharing.

(if) G2C (Government to Citizen) : In this type of E-Governance, government provides
services and facilities to its citizens, additionally, government and citizens, both communicate
with each other. Government provides those services which are directly related to public. These
services are free or provided at minimum charges. For example people can avail services like
apply online for Aadhar Card or PAN Card at very low fees and apply for many services at free
of cost, Further online payment of utility bills and income tax comes under this part of
E-Governance

(i) G2B (Government to Business) : In this type, those services are included which are
provided by government to the business. Through these services government and business
organizalion communicate with each other. Online selling and buying of goods, taxes on goods
or subsidies on business are the services which are provided by government to business. All
these services are provided online through this part of E- Governance,

(iv) GZE (Government to Employee) @ In this type of E-Governance those services and
facilities are included that take place between govemment and its employees. Government
provides many services and facilities to its emplovees for better working conditions, Nowadays,
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salary bills of employees, their service records, their departmental transfers and all other
records relaled lo employees are maintained online by governmenis, Examples: tHEMS,
eHRMS

(#) GIN (Government to NGGOs) : Now a new branch has been added in the E-Govemnance
by which government and non-government organization can communicate with each other. In
this part those services are included by which government certifies these non-government
organizations. The work of registration of these non-government organizations or societies
comes under this part.For example: communication between government and political parties
or NGOs

7.4 LEVELS OF E-GOVERNANCE

The working system of E-govemance is done at different levels.It is important to differentiate
the levels of facilities and services which are provided by different levels of government.So the
different levels of E-governance are:

{a) National Level : The online services and facilities provided at this level,by central
government of India to Indian citizens. All the controls on these services is of central government
and its different departments. The main services and lacilities of this level are:

L Online Passport service

i, Omnline Aadhar card service

iif.  Online PAN card service

tv.  Online Income Tax service

V. Online Life Insurance services

vi.  Online Post services

vii. Online Booking services of railway and air tickets

viii.  Online Voter card services

(b) Domestic Level/State Level : The services and facilities at this level are provided by
state government,and its related departments. Sorne of the important services of this level are:

L. Online service to make birth or death certificate

. Online service of applying for caste certificate

iii.  Online making income certificate

iv.  Online service for registration of vehicles

V. Online complaint registration

vi.  Online verification of any kind of data

vil,  Online applying for transfer

viii.  Online submission of applications

. Online payment ol different kind of bills

X. Online entries of land records

f1.  Online service for applying Driving Licenses
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(¢} International Level : The online services of this level are provided by central or state
government Lo the citizens. These are controlled by government with the help of international
organization. The main services of this level are:

i, Online booking of mtermnational airways tickets

L. Online applying for mternational visa

iii.  Online Import and Export Services

7.5 BENEFITS & DRAWBACKS OF E-GOVERNANCE

As we know everything has its own benefits and drawbacks, Similarly E-Governance also
has 118 benefits and hmitations, Let's have a look on 1(s benefits and drawbacks:

7.5.1 Benefits of E-Governance
Easy to Access : As we know, E-Governance provides online services so that every
citizen can access these services easily. People can get these services at their home
or nearby Sewa or Suvidha Kendra, People can avail various services likke applying
for Aadhar card, PAN card, Passport elc. online.

. Close relationship : As public can gel the services easily 1t develops a close
relationship between government and citizens. It is also an easy way for government
to provide these services to citizens directly.

. Time saving : After E-governance, all works of government are being done in an
easy and fast way. Due to online procedure tasks can be done in less time which
before takes days to complete. Now people do not need to visit offices again and
again which saves their valuable time
Saves money : E-Govemnance reduces paperwork cost, travelling cost of consumers
and government have to employ less manpower, which saves lots of money.

. T'ransparency : E-Governance has created a transparent environment in working
style of all offices. Now people can check the status of their applications online.

. Responsibility : Due to the transparency in online government working system, the
officer responsible for the delay in work will be answerable. In some states, most of
the work is time-bound and the work should be completed in the given time-period.

7.5.2 Limitations of E-Governance
: Not everyone can use E-Services : In India, many people m villages are still
illiterate that do not have knowledge of computers and internet, so they cannot get
full use of government's online facilities and services.
' Availability of internet services is reqguired : E-Governance is implemented or
used only 1f mternet services are available.
. Lack of knowledge and awareness @ As most of population of India lives in

village, these people do not have proper awareness about online services provided
by government.

E-Governance [Paert II) a5



. Start-up cost : One of limitation of E-Governance is its costly establishment and
management. Government have to pay a big amount to provide E-Services o the
public. To open Sewa Kender in every village facilitate with good computers,
internet services and highly qualified faculty is a costly task.

. Security threat : E-Governance is online system, It requires certain measures to
apply security o confidential information. Intemet cannot be considered as fully
secure,as information on the internet can be stolen and mis-used by hackers.

7.6 WHAT IS SMART GOVERNANCE

Smart governance is another form of e -governance. We can say that the modemn name of
e-governance is smart governance. Smart means attractive or active and governance means
tule, so smarl governance is an attractive or aclive rule. Smart governance means any democratic
covernment which provide effective, easy (o get and equal services to citizens that contribute in
the public welfare and economic growth of the nation. On the technical bases using new
technology for good planning and decision by the democratic government is known as smart
technology and it makes the democratic system strong. These are those mobile techniques
which provide government facilities and services to the common people in very easy and fast
way. To implement e-governance services we use ICT techniques like internet, computers and
mobile technelogy, uses of these technologies make e- governance a smart governance. In
simple words we can say thal providing services and lacihties under e-governance with the
help of modern technology in an effective and attractive way is called smart governance. Now
we will discuss some points that present e-governance as smart governance.

. Single Window Services and Facilities : In the government offices such as suvidha
kender / Sewa kender many facilities are provided in a single window, for example:
applying Aadhar card, PAN card, Caste certificate, Income certificate, Birth - Death
certificate etc, For all such certificates a person does not need to go here and there,

all these services are available al a single window/counter.

Smart Governance

Fig. 7.3

. Smart Applications : Nowadays, government provides many smart applications

{(apps) to the citizens related to its services and facilities. With the use of these

applications, citizen can take benefits of many type of services while sitting at
home.
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Vacility of smart cards : Smart cards like driving licence, PAN card, vehicle
registration card (RC), ATM cards and credit cards etc. are issued using smart
gnv&mmme.

Development of Smart Cities and Smart Buildings Central and State Governments
are developing many cities as smart cities by providing high speed internet services
equipped with latest technology.

"'n_l.

i

_'.1
iié%

Fig. 7.4 Fig. 7.5
. Toll free numbers : Governments have issued many toll free numbers for different
purposes to the public to register their complaints or suggestions or to avail services.
People can use these numbers from anywhere and anytime. Examples are: 108 for
ambulance, 1091 for women-helpline, 1098 for chuld-helpline and 112 for police-

helpline.

7.7 SARB SEWA KENDRA/SEWA KENDRA/SANJH KENDRA

To provide services and facilities under E-Governance, centre and state governments of

India take many steps from time to time.Government has opened many help-centres at different
levels (district,tehsils, blocks.cities,villages) 1o providee-services and facilities through

Fig. 7.6
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E- Governance. These help centres are called Sarba Sewa kendra or Sewa kendra. In Punjab. at
district/tehsil/city/village level Suvidha Kendra/Sewa Kendra are established. These Kendras
provide E-Services to citizens. Additionally, to provide administrative E-services, there are
Sanjh Kendras inside the police stations, here people can register their complaints online and
get receipt for further use. Some online services and facilities are as following:

L Online residence certificate

id. Online caste certificate

Online birth or death certificate

iv.  Online certificate regarding income

V. Online Aadhar card

vi.  Online certificate for religion

vii.  Online registries and intkal of land

vili, Deposit electricity , telephone and other kind of bills and fees online

ix. Online issue of vehicle registration certificate (RC)

X% Applying for old age/widow/handicap pension

xi.  Issue online driving Licenses etc.

7.8 AWARENESS OF ADHAR

Aadhar card has become an important and useful identity proof.Students should know the
importance and use of Aadhar cards.Because now a days to fill any kind of form Aadhar card
is mandatory.For example, if student wants to apply for any scholarship scheme, for board
registration or fill any other form Aadhar is a necessary document.

7.8.1 What is an Aadhar 7

An Aadhar is a 12 digit (**** #*#+% #%%%) ynique identity card number that is issued by
Unigue Identification Authority of India (UIDAT)

to the Indian citizens. No two people in India can
have the same Aadhar number. This number is issued m
to Indian citizens after verifying their important

documents. After getting this unique ID number an
Indian citizen get a unique identification. With this

2 -
number verification of information about. Aadhar 7 W
holding person becomes possible.
5P ; )
An Aadhar card includes two type of AADHAAR

information aboul the person. We can get following
information by Aadhar card number:

Unigue ldentification Authority of India
FEanang Commilssion, Government of India

Fig. 7.7

(1) Demographic or Personal Information : Adhaar Card is used as identity and
residential proof as it includes personal particulars and demographic information
{address) of the person.
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(it} Biometric Information : While making of an Adhaar card, biometric information
(scanning of finger prints and iris ie. eye scan and photograph) are stored in
databagze,

Geonrarmrment OF Indls IE@ \'_‘.-l'k Unigjue et cation Authaety O
aia Address
HEM KXMN XEXx AHH HAANK MHHXK WHAK NNAK XAX
X J DOB / xx xx Xx MK MHANH HAMN MMM NHKK HHN
Caa _,-' Ok =e=10] SO0 DO MMM MHHM MRMM MNK
: Sex / xxx e WM MHNN MMMH MMM NMHN
1
AXK KAXK XKXX [=lr XU MXXX XMXNX
Fig, 7.8

7.8.2 Features of Aadhar

As we know that Aadhaar has been certified as an important document and it is used for
many purposes. Now we will discuss its features :

. Unique ldeniification : The first feature of Aadhaar number is that 11 gives an
unique identity to an Indian citizen. One citizen can has only one Aadhaar card
number.

. Proof of Residence : It stores the complete residential address of the concerned
person.

No Expiry Issue : [t does not have any expiry date. There is no need to renew it as
it is a life time document,

. Proof of Identity : As Aadhaar card contains personal information and electromically
biometric information of the concerned person can be validated. Hence it is used as
proof of identity.

. Online Authenfication : Tt is also used for online authentication of Indian citizens.

Today's time for all online factlities such as online banking.gas subsidies etc. Aadhar
number ig used as online authentication.In online process, beneficiary's data is
checked oul with the demographic and biometric data of heneficiaries Aadhar card
data. This process of linking is known as Aadhaar seeding and Mapping.

7.8.3 Uses of Aadhar
Uses of an Aadhar card are as follows:
i To open bank account
L. To get gas connection and subsidies

1i1.  To apply for Pan card
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iv.
V.
vi.
vii.

VI,

To get mobile SIM or telephone connection

To E-verify the Income Tax Return (ITR)

To verify personal and demographic/biometric data.
To get the benefits of welfare schemes

Can be used as an unique identity proofl

7.9 INFORMATION SYSTEM (IS)

Information System(IS) is a system which is used by people,organisations and companies
to collect data, filter data,process data to form into information and share it. Information
system is a software/programme that is used to produce information, store information and
communicate information through computer and internet. Simply we can say that group of ICT
techniques which is used to collect raw data, produce information from raw data and take

decision based on this information is known as information system. A computer based
information system has following components:

100

Information
wechnoloay | Systems |

() Cmer)

Fig. 7.9
Hardware components : This part contains keyboard, menitor, mouse, CPU,
motherboard, hard disks, printers ete. which are combined together to do work.
Software components : It contains that programmes which are used by user to
process data through hardware components,

Database components : This part is used to store relative data in the form of single
file.

Network components @ This is the part through which we can share sources,
information and data.

Procedures : In this part that methods and procedures are used which translate raw
data into meaningful information
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7.9.1 Types of Information System (IS)

=
"

[

ol

Types of Information System

Transaction Decision Executive Management
Processing Support Information Infermation Expert
System System System System System
(TPS) (DSS) (EIS) (MIS)
Fig. 7.10

Types of Information System are as follows:

Transaction Processing System (TPS) : This type of Information system is used in
business organizations for buying or selling, to prepare pay roll and all kind of
business entries and records. For example: banking systems.

Decision Support System (DSS) : This type of Information systemis used by the
management of any organization for taking decisions for the organization based on
collected data.

Executive Information System (EIS) : These information systems are used by the
heads of organizations to control the working system of the organizations in an
efficient manner and it becomes very easy for heads to issue mstructions to the
people working under them.

Management Information System (MIS) : This type of information system plays
an important role in the management of any organization. These systems store all
the records related to organization. For example : Education Department of Punjab
uses MIS to store data of schools, students and staff.

Expert System : These types of systems are used to solve the complicated problems
mostly in science and intelligence departments. These systems enable us to take
major decisions based on collected data on a serious issue. That's why, these are
also called expert decision-making system.

‘% Dot To Remember

The way in which govermment provide online facilities and services to its citizens is
called E-Governance.

The working system of e-governance is divided into G2G, G2C,G2B, G2E, G2N etc.

The levels of E-governance are - national level, domestic level, and international level.

The facilities and services provided by E-Governance through internet in an attractive
way are called smart governance.
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Aadhar 15 a 12 digit unique identity card number which gives a unique identity to each
Indian citizen.

Today. Aadhar card is used for bank account, gas connection, PAN card, income tax
return, sim card etc.

Information system is computer software that is used to get information, communicate
information, to store and share the information.

The main parts of information system are hardware, software, database, network and
procedures,

The types of information systerm are - transaction processing system, decision support
sysiem, executive information system, management information system, expert system
elc.
Some important websites are :-
(i) passportindia.ind.in (For passport services)
(i) incometaxindiaefiling. gov.in (For income tax services)
(iif) widai.gov.in (For Aadhar card services)
(iv) (1) ceopunjab.nic.in (For Voters of Punjab)
(2) eci.gov.in (Election commission of India)

EXERCISE o
Part-A (Questions carrying 1 Mark each)

Multiple Choice QQuestions:
1. The online service of government is called-

a)  Public welfare services b)  democracy services
¢) E-governance d) internet services
IO G2C Stands for -
a) Govemnment to employee b)  Governmeni to citizens
¢}  Government to business man d)  Government to government

III. The modern form of E-Governance services is:
a) E-Business by E-Commerce
¢)  E-Services d)  Smart governance

IV. How many digits are there in Aadhar card number?

a) 14 by 12
¢l 16 d 10
V.  Which one is the part of information system?
a)  Database and procedures b}  network
¢} Hardware and software d) Al of these
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Fill in the blanks:

L The services and facilities of E-governance is divided into parts.
1L gives an unigue identity to Indian citizens.

II. InPunjab at village level mves E-Governance services.

Iv. 18 used to solve difficult problems.

V. Smart cards are symbaol of

Write full forms :

I.  UIDAI
. G2G
. G2E
IV. MIS
V. DSS

Part-B (Questions carrying 3 marks)

Short Answer Type Questions. {Write the answers in 4-5 lines)
I.  What are the three levels of E-gpovernance? Give detail.

II.  In brief describe Smart Governance?

II.  Write down any four uses of Aadhar card?

IV. What are the different parts of information system?

V.  What is the Sewa/Suvidha Kendra? Describe.

Part-C (Questions carrying S marks)

Long Answer Type Questions. (Write the answers in 10-15 lines)

[.  What do you mean by E-Governance? Define its working system?
II. What are the benefits and hmitations of E-Govemance?

[,  What is Aadhar card? Describe its characteristics?

IV.  Write down the list of services provided by Sewa/Suvidha Kendra?
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Lab Activity

Make a list of Websites for the following E Governance activities:

. Website to apply Online passport

. Website to Update vour Aadhar Card

. Website for filing Income tax Return

Website for Booking of Indian railway ticket

Website to apply for Voter Card

Write the Toll-free numbers for the following:

Ambulance Help Line Number

Women Help Line Number

. Children Help Line Number

. Police Help Line Number
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IMAGE EDITING &

A
| CHAPTER - 8 FILE CONVERSION TOOLS

OBJECTIVES OF THIS CHAPTER

8.1  Introduction

8.2  Popular Image Editing Tools/Software
8.3  Working with Image Editor - GIMP
8.4  Working with Image layers

8.5 Image Editing Tools

8.6 Masking
8.7  Image File Conversions

8.1 INTRODUCTION

In present time, we capture lots of images using mobile & digital camera and often we
need to edit them by resizing (increasing or decreasing the dimensions), colour correction,
adjusting the brightness and contrast levels, crop, rotate, flip to make a better image. This
whole process of making changes & corrections is known as image editing or retouching. To
achieve this, we use special software in computer known as Image Editing Software. This
software enables us to produce images of Professional Quality.

8.2 POPULAR IMAGE EDITING TOOLS/SOFTWARE

For image editing, several softwares are available in market. By using these softwares, we
can easily edit images. Some popular softwares are:

Adobe Photoshop
. Corel Draw Graphics Suite
. MS Qffice Picture Manager
. GIMP (GNU Image Manipulation Program)
All above mentioned softwares are similar in nature, if we learn one of these then with
little effort we can leamn any other image editing software,

Adobe Photoshop is very popular image editing software and is widely used as compared
to other image editing softwares but it's not free, we need to purchase 1. Adobe Company
offers different plans of monthly or yearly subscription.
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8.2.1 GIMP (GNU Image Manipulation Program)

This is very popular free software for image
editing. We can download it freely from
www.gimp.org and then we can install it on
OUr compuier system.

8.2.1.1 : GIMP Features:

1.

o Lh fe

=~

| P Startup

It can be used as simple Paint
program.

It can be used as professional
software for image editing.

A seripting language can be used in Fio. 6.1
it, to accomplish complex tasks. I

It can be used as image convertor and format of image can also be changed.

It can open multiple images at one time.

It is cross platform (Windows/Linux/Mac) software means it can be installed and
used on different operating systems.

It is open source software.
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Fig. 8.2
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: GIMP supports these pepular image formats:
.GIF (Graphics Interchange Format)
.PNG (Portable Network Graphics)
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TF (Tagged Image File Format)

JPEG (Joint Photographic Expert Group)
PSD (Photoshop Document)

BMP (Bitmap Picture}

7. XCF(eXperimental Computing Facility)

R

8.2.1.3 GIMP Preferences : In GIMP we can change all settings as per our requirements
like System Resources, Image Import & Export, Tools Options, Interface (Icon, Theme, Toolbox),
Image Windows & Folders.

&l Preferences ”
*', Celor Managernent System Resources
T8 image impon & Export
35 Tool Options Resource Consumplion _
=] E Default Image Mindrnal number of yndo levels r'j .E:'
(D] Defautt Gud Maaimum unda memory. (1034257 5] | Globytes  [~]
B ] ntertace Tie cache sire 37030 ] [ iobytes |
. Maximusm pew image sive 138 5| Megabytes ||
;!' leon Theme = -
i'.r . Nurmber of fhresds to uie 4 é{
"39 Dialog Defaults Hardware Acceleration
&3 Help System [ use OpencL
[ § ] Display CpenCL mmnndn.wp:r!' ore experumenio]
= A exper! siowrdowns and potsdile croshes (please
@mhm Managemaent raparth
B E image Windows "
.EIA e Sz of thumbnails | Normal (1220128) <]
| Title B Stat err e ."-. — .
lE . s Maxzermem fiesize for thumbnaling: |4 »-""_,”'M!lh'h! B
@‘!ﬂwmg |
B M Input Devices Document History
[@ Input Contraliers [ Keep record of used files in the Recent Documents bt
® P Foden
[ b | [ gee [ ok ][ cancet ]

Fig. 8.3

8.3 WORKING WITH IMAGE EDITOR - GIMP
8.3.1 Creating a new image

For creating a new image, click File > New or use shortcut key CTRLAN.

"Create a New Image” dialog box like shown in Figure 8.4 will open, in which values for
width and height can be entered. For more advanced settings, click on Advanced options.
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Note : Canvas is that important area of Window where new image or open image is

displayed and can be edited.

! Create 2 New Image b4

Tr-:":[ll.'l‘..-l .

Irmaagges Sive

Fig. 5.4

8.3.2 Opening an image for editing
To open an existing image. click on File > Open or use shortcut key CTRL+O or double
click in working area of main interface of GIMP.

An open dialog box will appear. Select the image to edit and click open.

Open image >

Fig. 8.5

It 1§ recommended to create a duplicate copy of the original image before editing to avoid
unwanted changes to the ontginal image. For creating duplicate image, click Image > Duplicate
or use shortcut CTRL+D key.
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8.3.3 Saving an image

After editing an image, it can be saved by clicking File = Save or use shortcut key

CTRL4S Whenever image is (o be saved with new name, click File > Save As or use shorteut
key CTRI4+SHIFT+S.

Save Image Dialog box gives us opion to chooge location (o save our image and also

provides us facility 1o create a new folder as well. GIMP uses its default file extension .xcf to
save an image.

B Sove Image x
Larmie PhateFlawed sl

Seve infolden | ¢ 0 Maninder Sngh | |7 Desidop [E Craate Folder
Fleces Hame = Size Modiied | Fy——

7\ Search

B FRecently Used

= Maminder Singh
= Desktop
o= DV W Deeve ()

= MHew Volaome (D)
& WinD_53D (C:)
m Prctures

m Documents

-Im.-gq.—:

& -

[] Starav AN Files

i Sebect File Type fly Extersion)
] Sawe this XCF file with better but dower compreion

. The snage uvet faaturen Tram GIMP 210 and won't be resdable by olde: GIMP versiom.
Metsdais won't be viabbe s GIMP older than veraon 210

tetp Cowe ] concw

Fiz. 8.6

8.3.4 Export As

GIMP provides the facility "Export As" to save images into different file formats. If image
is to be saved in other formats like jpg, png, gif, tif etc. then use File > Export As or use
shottcut key SHIFT+CTRL+E.

To choose different file formats click on "Select File Type" and GIMP will show us

different file formats. We can select the desired file format to save image in that particular
format.
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Fig. 8.7
8.3.5 Image Properties

It iz essential that user must be aware of image properties before editing an image. To view
image properties, click on Image= Properties or use shortcut key ALT+ENTER. Image properties

£ image Propernies

(D) Image Properties
[, T—— .7

Siee I phocls:

Hes s b bow
Color spaces:

Sdres n Ty
Unddo st

Redo steps: |

Mupmbvsr of e
Mumbar of Ly

MNupvlsse O haain

Mumbor o paths; o

Fig. 8.8
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like size in pixels, print size, resolution, file name, location, file size, file type etc. are shown in

image properties dialog window (Fig. 8.8).
8.3.6 Auto Correct

Auto correct means, (0o automatically
correct an unage, GIMP will try to change
colour settings of an image automatically. To olor Tempersture

olor Balance

Ly HueE-Lhromas

use this feature on menu bar, click Colors =
e Saturabion

Auto. There are few options available further
which can be changed as per need.

' Equalize : This will make Shadows- Highlights
[:rll_;hl"-:-:.. L ontrest

brightness level of every pixel
squal.

While Balance : This command is
useful for images in which white
or black color 15 not displayed

correctly. :
. Stretch Contrast @ This command S Wi B icn
further increases the brightness of Desaturat > G Suetch Contrast.

Shetch Contrett HSY

brighter colors and it makes the
darker colors more darler. This will

Codar Enkance

nfo . £ Color Enhance (legscy)

also remove any tinl present in an

image.
Note : Tinl means to mix white color in any color.
. Color Enhance : This command corrects colors by enhancing color intensity
which leads to better looking image.

8.3.7 Brightness and Contrast

Click Colors> Brightness-Contrast to | erightness-Contrast x

adjust the brightness and contrast of the image | ¢} Adjust Brightness and Contrast E
* N jpg-d ([Unesed])
[t is a simple tool that handles bright and =
: : ; Pregets: v| + 8
dark colors alike while advanced versions of
this tool are "Levels and Curves" thal handle | leshtes 0.
bright and dark colors separately, which can | s ok
finely enhance the look of the picture.
. ; : e Edit these Settings as Levels
On image with holding down left mouse
Prae

button and dragging it from top to bottom i Bt L3 e
(vertically) brightness can be increased and Help Beset o Lancel
doing the same from left to right (Horizontal) Fig. 8.10 Adjust Brightness and Contrast
vertices of the image, can increase conltrast. (horizontal)
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To apply these settings, press the Enter key on the keyboard.
Sliders can also be used to decrease or increase brightness and contrast. The previously
vsed settings in the Presets option are automatically saved which we can reuse later.

8.3.8 Crop Settings

Cropping a picture means coiting off unnecessary sections of the image from the corners.
To use this tool, click on Tools > Transform Tools > Crop or click on the crop tool icon from
the toolbox or use shortcut key SHIFT + C.

A box will appear on the piclure, its four corners can be used to reduce or increase the
Cropping area.

Fig. 8.11 Betore Crop Fig. 8.12 After Crop
Alfter setting the correct area, press the Enter key from the keyboard. Image will be
cropped.
8.3.9 Rotate

Rotate tool, 15 used to rotate a picture at a certain angle.

To use it, click on Tooels> Transform Tools > Rotate or ¢lick on the Rotate tool 1con in the
toolbox to select this tool then click on the picture or use SHIFT + R.

Use the slider to rotate the image or we can even enter the angle value directly.

o [1909 ]  Fotate ®
~ §
5 Rotate A B ) e
= [D.0D =
i oge B S
- 1

Center X: | 360,00
Center ¥: | 360.00

Rt Readjust Retate

Fig. 8.13 Fig. 8.14
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[f we want to change the position of the image we can enter the value in Center X and
Center Y, In the end, click the Rotate button. (see fig 8.14)

Click the Reset button to undo the changes.
8.3.10 Flip
The flip means changing the side of the picture, This tool can flip the image vertically or

horizontally, or both. To use it, click on Tools > Transform Tools > Flip or click the icon of flip
tool in the toolbox to select this tool then click on the picture to flip.

Fig. 8.15 (a)
8.3.11 Resize

Sometimes we need to change the size of the image, i.e. to increase or decrease the Width

or Height of the tmage. Changing the 1mage dimensions 15 called resizing. Click on Image >
Scale Image to resize the image.

Adjust Width and Height of image with any unit such as px, percentage. centimetres,
metres, inches, feet etc.

‘¥ Scale Image b4

‘@ Scale Image @

[magei] [imponed).t

Image Size
wa [0 g
Height: 265 = 9 x|+
190 = 265 poasls o
Xresolution: | 300000 =
¥ resolution: | 300000 3| § pocels/in |+ |
Quality
Interpolation:  Cubic E|
Help | Reset Scale Cancel

Fig. 8.15 (b)
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8.3.12 Aspect Ratio (Resolution)

This means proportional relationships such as 1:1, 4:3, 16:9, ete. of the image's width and
height. Generally GIMP resizes the image as per Aspect Ratio of the image itself, meaning that
if we change the height, the width will automatically change and if we change the width, the
value of the height will change automatically. Aspect Ratio has to be unlocked if we want to set
both of these values independently. 5o click on the chain icon so that it appears in (wo sections.
Clicking on this icon again will lock the picture's Aspect ratio setling.

Interpolation : GIMP resizes images using pixel based technique. Let's learn about its

types:

Linear : With thig resize technique the pixel color is set to the nearest 4-pixel
average color. Sometimes this technique 1s also called BiLinear. This technique can
be used to quickly resize an image and the quality does not deteriorate much while
Tesizing.

Cubic : With this resizing technique the pixel color is set to the nearest B-pixel
average color. Sometimes this technique is also called BiCubic. This technique
takes a bit longer to resize the image and improves the quality of the resized image.
Usually this technique is used to resize the picture.

Nollalo : We can also try this technique if we want to enlarge the normal picture at
higher resolution.

LoHalo : If text or text-like objects are present in the picture, this technique will

produce better results.

8.3.13 Compression Settings
If the image has taken up too much space on the hard disk, we can compress the picture.
Compressing a picture does not mean changing its dimensions. During resizing the width and
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height of the image will be reduced or enlarged while compressing the image will decrease its
size (hard disk space) or altering the quality of an image.

If we want to use the image for a web site, we should reduce its size on disk so that web
page gets loaded easily due to its small size. But it should be taken care that the quality of

image is not destroyed. For this, use Export As and set the size and quality of the image as
needed using Quality Slider.

Click File > Export As to compress the image
Click on the "Select File Type" (Extension) option to compress the image in a particular
format and select the Format / Extension and chick on the Export button. (fig 8.17)

B &portimage ¥

[arne | flowerjpg

Save in folden [lﬂmnlﬂdﬂ imghl [ Desktop| Images

Places ~ | |Mame - Sae Modified ~
©, Search m 1313 Saturdey

E Recently Used = Images 2001

TD Meninder Singh = Mankind Friday

P Desktop m PC COMPONENTS 28/07/2019
= DVD RW Drive (H:) § msiPG 95kB  Friday

s New Volume () = msig.jpg 77kE  Friday

£. Win10_550 (C3)
= Pictures

-

[ show All Files

E Select File Type UPEG image)

File Type Extensians Dy
HEIF/HEIC hueic, heif

HTML table hkmilhtm

KISS CEL el
Microsalt Windows icon
MNG animation

OpenEXR irmage ext
S R, X

[ b | [Boor ][ cnca |

Fig. 8.17

Depending on the selected format, GIMP will display a separate dialog box such as JPG
(fig 8.18) or PNG (fig §.19):
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Save thumbnail
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[ Show preview in image window [ Save layer offset
[ save xif data Save resolution
[ save ¥MP data B4 Save creation time

| Seve comment

__| Seve color yslues from transperent pixels

Save calor profile |Mmtlt pleifarmat IF}
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' ) Save Bt data
| O save ¥@ data
: [ Seve IPTC data
[E Advanced Dptions Sawe thumbnail
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| ord Dctauits | | Save Detauits |
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Fig. 8.18

| Hee

Cancel | |_

Cancal

| [ Bpen ||

Fig. 8.19

Use the Quality or Compression level slider to compress the image or enter a direct value

and click on the Export Button.
8.4 WORKING WITH IMAGE LAYERS

Layers mean Stack of Shides, Layers are groups of sheets that look out over one another.
The picture can consist of more than one layer and the number of Maximum Layers depends

on the memory available in the computer. If the computer
is powerful and has a lot of memory, there may be as
many layers as we wantl in one picture. Each Laver can
be edited separately from the rest of the Layers. Layers
are get on top of each other and the bottom layer is the
background of the image. Layers can be easily set to be
on the foreground or back of the other layers. Layers can
also be grouped as needed.

Layers are managed by the Layers Dialog Box, The
Duplicate Layer Tool helps to create duplicate copies of
Active layers.

8.4.1 Layer Properties

Each layer has some important properties such as:
(i)  Name : Each layer has a name. It can be
customized by double click or right click.
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(if)

(HiT)

(iv)

(v}

(wi)

(vif)

8.4.2 Adding Layer

There are several ways to add a layer.
Right click on the opened image, and then
click on the Layer Menu. We can add a new
layer by choose any one of the following

options that appear in the submenu; > Relny Mo
. New Layer :s: :
. New from Visible S ncy i
Trangonm "
Duplicate Layer @ Layer Bgundary Size.
We can also create a new Layer with paste B L= Inbo stie
W Scale Layer.

option (CTRL -+ V or Edit Menu > Paste
options) after using Cut/Copy a layer.

Presence or absence of alpha channel : The alpha channel confirms how transparent
the layer is to each pixel. White completely reflects opacity. Black fully demonstrates
transparency. Grey level represents partial transparencies.

Layer Type : Layer type depends on the presence or absence of Image Type and
alpha channels,

RGB . RGBA . Gray

GrayA . Indexed . IndexedA

Filter Menu : The flters in the Filter Menu only support few layer types. If we
want to apply a filter but that filter is disabled. it means it cannot be selected then
the type of the layer needs to be changed to use that filter.

Visibility : We can turn the layer's visibility on / off for the image to work properly.
Changing this setting means only to toggle the serting by which the layer is hidden
and not deleted. Visibility settings can be changed by clicking on the eye icon in the
Layers dialog box. If Shift + Click 1s used, visibility setting of all the layers except the
Active Layer can be turned off.

Active Layer : The layer that is being worked on is called Active Layer. Usually
the layer is activated by clicking on it. If there are multiple layers. it becomes
difficult for us to know which element belongs to which layer. So if that part of the
picture is clicked by ALT + Mouse-Wheel-Button-Pressed, the corresponding layer
in the Layers dialog box is automatically selected.

Opacity : With this setting we can set the value of the opacity. It can be set from 0
to 100 scales. 0 means that the layers below this layer will be fully visible, 100
means that this layer will not be
trangparent at all and the layers
below it will not be visible at all.

v | 3. Anchor Laywe
} Muerge Dowm

O Crop to Selection
O Crop to Cantent

Fig. 8.21
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8.4.3 Deleting Layer

Right click on the layer to delete and click on "Delete Laver”. Another way is to drag and
drop the layer that we want to delete in the X icon in Layer Dialog Box (See Figure 8.20), the
layer will be deleted.

8.4.4 Merge Layers

Merge layers means making a single layer from multiple layers. To do so use the CTRL+M
shortcut key or click on the Image Menu > Merge Visible Layers option.
Flatten Irnage option in Image Menu also merges all layers after removing Transparency.
Layer Merge Options:

Expanded as necessary : Sometimes Iﬁ

a layer may be larger than the size of
the picture so this option will increase
the size of the image according to
the larger layer.

Sometimes a
layer may be larger than the size of
the picture so this option will cut the
larger layer according to the size of
the picture.

Clipped to image :

This
option clips and (rims the remaining

Clipped to bottom layer :

layers according to the size of the
Bottom Layer.

8.4.5 Scaling a Layer

Scaling means changing the size of the layer. So use the Layer Menu > Scale Layer opiion.
Layer can be scaled by entering Width and Height values as needed.

Merge Layers

. Layers Merge Options
[Morwne] fion promed)—4

X

Final, Merged Layer should be:
@ [Expanded as necessary|
O Clipped to image
O Clipped to bottom layer
< Merge within active group only

[C] Discard invisible layers

| Help Merge || Gancel

Fig. 8.22

The Cubic (Quality > Interpolation) method 15 used to get the best results.
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8.5 IMAGE EDITING TOOLS

GIMP provides many tools for working
on images that can be used to perform
different tasks on images. If the mouse
pointer (arrow) is held over a tool's icon
for 2 seconds, the tool name, what the fool
15 used for, and the shortcut key will be
displayed in tooltip. Let's learn some Lools:

(i) Selection Tools : These tools are
used to select part of the active layer. Each
selection tool has its own set of features.
They can also be selected from the Tool
Menu.

&
Y

Fig. 8.24

& xHM3

Pl K

|
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Rectangle Select : This tool is used to select the part of the layer in the rectangular

shape.

. Ellipse Select : This tool is used to select the part of the layer in the elliptical shape.

' Free Selection : This tool is also known as lasso tool, This ool allows us to select
a drawing note with a free hand. It is used to select part of the image by drawing a
picture with the help of a mouse pointer.

'Inpts' Filters Windows Help
E M“RT“*E: P | [ Rectangle Select R
Paint Tools o Ellipse Select E
Transform Tools ¥ O FreeSelect F
[a Paths B {3 Foreground Select
A Tet T IS gy Selact U
GEGL Opesstion... M By Color Select Shifts 0
& Color Picker O | en Intelligent Scissors I
A Measure Shift+M
Q Zoom z
Toolbox Ctrl+B
¥ Default Colors D
% Swap Colors X
Fig. 8.25

' Fuzzy Select : This tool is also known as the Magic Wand tool. Wiih this tool, the
area is selected on the basis of "Similarity of color”. Usually the selections made
with this tool are continuous, 1.e. connected parts.

By Color Select : This tool works similarly to the Fuzzy (Magic Wand) tool, but

any part of the picture that matches the color similarity is selected.
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. Intelligent Scissors : This tool is used for automatic selection where there is a
contrast of color which means the two parts are clearly separated. Clicking the
mouse creates the Selection Nodes on the edges of the area we want to select.

(if) Eraser Tool : This tool is used to
delete the area of the active layer. If the image
has no alpha channel then this tool will erase
the area with background color.If the image
has an alpha channel then this tool will erase
the area with transparent color and no color
will be used.

(ifi) Text Tool : This tool is used for
writing text on pictures. Use the Tools > Text
command to access this wol. This tool ¢an also
be activated by clicking on the symbol A in
the tool box.

When thisg tool 15 activated, a toolbar will
appear which allows us to use Bold, Italic,
Underline, Strikethrough options.

To change the font, delete the font in the

box and start typing the name of the font we S Bath from Tt
want to select, GIMP will start showing the /' Test plong Path
installed fonts in the computer through the * From left to nght
Dropdown list from which we can select the From nght to left
font.
Use CTRL + A to select all the text. The
color box can be used to change the color of Vertcal, left to nght (uprght onentstion)
the text. By Right clicking on text, we can Input Method
cha.nge the orieniation of the text from given Fig. 8.26 Text Tool
ophions.

{iv) Move Tool : This tool is used to
move the selections, i.e. textures, layers etc.
To use this tool, use the Tools > Transform
Tools = Move command or click on the Move
tool icon in the Tool Box.

[T a layer is selected and we just want to
move that selection, use CTRL + ALT + Mouse
Drag. The selected area will be moved and the
lower layer portion will appear instead.
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(v} Align Tool : This tool is used to align layers with image objects. To access this tool use
the Tools > Transform Tools > Align command or click on the Align tool icon in the Tool Box.
For example, open a picture and make a duplicate layer from the Layer Box (right click of the
layer> Duplicate Layer) and move it slightly and left click on this duplicate layer. Now select
the Align tool. At the bottom left of the toolbox, we will see some alignment tool options, click
on any one we need and we will get duplicate layer alignment.

Tools Fites Windows Help

Selection Tools ' L, Toct Options % Devices 4= Undo =]
£|int_Tu-n[|.I v Align
~ Transform Taols. ¥l = Align Q] en
Fa Pathe B | e Move M |Reistive 10 F'““"":EI
A Tedt T |8 Crop Shift+C p I
= & e |2
GEGL Operatien,.. N Rotate Shift+ R [[] ! |*l - [Il
& Colot Pickes o | W Seale swittes | (5] [%| [bed]|
A Measure Shiftyl | M Shear ShifteH | oo
Q Zoom 7 | B Penspective Shift+ P < ol 7]
Toolbox Ctrl=8 ; s ==
¥ Hendle Transform  Shiftel T = & | Ei)
- , -
| Default Colors 1] m Fis pE 220 Al | = _]
N o N $ Cage Transform Shift+G OffmX |0 &
& Warp Transform W Offwe v |0 g
Fig. 8.28 Fig. 8.29

(vi) Scale Tool : This tool is used to scale layers & objects. Use Tools = Transform Tools
>5cale command or SHIFT + S to use this tool.

Use File > Open As Layers, to open another image as layer and it will open a new image
as layer. Activate the Scale tool, we will see a dialog box. We can scale the layer with the
mouse, to scale in Agpect Ratio hold down the Shift button.

= Scale AR
Width: 353 [ fg
Height: (353 15 3 | |v
353 x 353 pocels
300 ppi
Reset Readjust Scale
Fig. 8.30

(vii) Blur / Sharpen Tool : This tool is used to blur or sharpen any part or object of a
picture, This tool uses a brush. This tool enhances effect when repeatedly used in one place,
The CTRL key is used to toggle between Blur and Sharpen.
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Use the Tools > Paint Tools > Blur / Sharpen command to select this tool.

If any part or object is looking too strong, use Blur to soften it. If we need to sharpen
(increasing contrast) a part or object, use Sharpen option.

Tool Options -’
. To Otions | =

Blur § Sharpen

(viii) Bucket Fill Tool : This tool fills
the Toreground color in the selected area,

- ok | Baink Teshs W o ucke ra Shned |
il CTRL + Click 15 uged then the tool will e e 5
fill the background color. Fi Paths B|, Penci nE
Y : A Tent T | # Bainthrush i
Using the ALT key will toggle the | = oo ion. e o
foreground and background colors in this |+ o picke o | Bebrush A
: e ; ; A M Shittad | off Ink K
tool. Using the Shift key will fill in the 3 In::" 2 ol u
selected color all at once. == cotop | e Done c
Use the Tools > Paint Tools > Bucket |® Defsut Colon o |% b r
. . . % Syap Colon i | 1B Qemsprtive Cloms
Fill command Lo select this tool. : O Bip / Sharpen Shifts Ll
& Smudge 5
& Dodge/Burn Shift-0
Fig. 8.12
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8.6 MASKING

Masking or mask means a new separate layer

: ‘ 8, Add Layer Mask P
that is created for another layer so that the Dpﬂl.“:ll}' 7 Add a Mask to the Layer EI
(transparency) of that layer can be set. By using 1 (L 5L 5LIPG-57 (1 (3545 (mponsdl)
layers, Masks hide some part of the main layer that Initiafize Layer Mask tos
we want 1o edit. So the editing that will be done after @ Wihae (full opacity)
applying the mask will be applicable on only that O Black (full transparency)
part of the main layer that is set by the mask. ) Layer's alpha channel
Layer masks are different from opacity sliders/ O Transfer tayer's alpha channel
settings. They allow us to work on different parts of O Selection
the picture layer. i.e. the optional parts. Using a mask g gg:t SRy
does not damage the main layer, when we make | ]
changes. O et ot

8.6.1 Adding Layer Mask
It's very easy to add a layer mask. Right click on | Help r Goncel |

the layer in the Layer box, now click on the option of
Add Layer Mask from the menu. Fig. 8.33

8.7 IMAGE FILE CONVERSION

There are several formats of pictures such as .jpg. .png, .gif, tif etc. Each format has its
own specific properiies and we can use these formats as needed. Different Softwares can be
used to convert one image format (o another, or we can conyert pictures from one [ormat to

another using spectfic websites available on the Internet. Generally, we can change the format
using the Save As option. After changing the format, the appearance of the image does not only
vary but its properties also change. Some formats are good for using pictures on the Internet,
some for painting pictures, some for viewing on computers or electronic devices or some for
printing. In GIMP software, we can also change the format of the pictures.

Some of the more popular free image converter softwares are:
1. FastStone Image Viewer

2, FasiStone Batch Resizer

3. Irfan View

4 XnConvert

‘2> pefimts o Remember

"3 -y

1. Changes and modifications made as needed in an image are called image editing or
retouching.

Adobe Photoshop, Corel PaintShop Pro, MS Office Picture Manager and GIMP are
popular softwares for image editing.

()
.
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GIMP's full name is the GNU Image Manipulation Program.

Use CTRL + N or File > New to create a new picture,

Double click with the mouse on the image window or use CTRL + O or File > Open to
open the image.

To do image editing, always create a Duplicate Image / Copy so that the original image
does not change.

Cropping an image means eliminating unnecessary sections it corners.

Use CTRL + Z to undo and CTRL + Y shorteut keys o redo.

Exporting a picture means saving the image in another format, while the Save or Save As
option saves the image in a Native formal only.

Having a resolution of 300 ppi (pixel per inch) gives the picture a good quality print.
GIMP saves the image in its original .xcf format.

Usually the jpeg (Joini Photographic Expert Group) format is used for an image which is
popular and widely used in the world.

The quality of the image decreases when it is scaled.

EXERCISESS
Part-A (Questions carrying 1 Mark each)

Multiple Choice Questions:

L. tool allows us to select a drawing with a free hand.
a, Fuzzy Selection b. lasso
c. Text d.  Bucket Fill

II. SHIFT + C is a shortcul for

a.  To Create Duplicate Image b.  To Delete Layer
¢.  To Copy of an image d.  To Crop an Image
II. Scale option is used to change the of an image.
a. Color b.  Size
c. Area d.  All of the above
Iv. is known as group of sheets looking at each other.
a.  Masking b.  Tools
c¢. Layers d.  None of the above
V. helps to make a duplicate copy of the active laver
4.  Smudge Tool b. Daodge Tool
c.  Perspective Tool d.  Duplicate Layer
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Fill in the blanks:

1.  To resize the layer tool 15 used.

To move the layers Lool is used.

1L

L. The quality of the picture decreases when the picture is

IV.  An important part of the Image Window is where the picture is
shown.

3. Write shoricnt keys :

I.  For eveating New File.

II.  For opening a File.

L. For creating duplicate Image.

V. For viewing Image Properties.

V.  For cropping the image.

V1. For merging layers.

Part-B (Questions carrying 3 marks)

4.  Short Answer Type Questions. (Write the answers in 4-5 lines)

I.  What is Image Editing?

[I. What are layers in GIMP ?

[II. How can a duplicate image be made?

IV. How image is opened in GIMP !

Part-C (Questions carrying 5 marks)

5. Long Answer Type Questions, (Write the answers in 10-15 lines)
1.  Wriie down the names of any 4 tools of GIMP and explain the usage.
II. How to resize a picture in GIMP?

Lab Activity

*  Take a picture and perform the Image Editing Operations explained in this chapter using
any Image Editing Soflware
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AUDIO AND VIDEO

CHAPTEF{ -9 EDITING

OBJECTIVES OF THIS CHAPTER

9.1 Introduction

9.2  Audio Converter

0.3  Free Audio Converter - Fre:ac
9.4  Video Editing

9.5 Working with Video Editors
9.6  Free Video Cutter Joiner

9.1 INTRODUCTION

We all listen to audio or music on computers. Sometimes we listen to music from audio
CDs or play audio files like mp3, wav, flac, mda, aac, ogg, wma using any media player
software. The computer requires separate audio codecs o play these audio files, Some software
installs these audio codecs on the computer along with them, but sometimes, We face problenis
because some media players are unable to play a particular audio file format. This is vsually
due to the codec not being available on the computer for that file type in player.

Codecs are files that enable a software to play different types of audio formats or assist in
the compression and decompression of a digital audio data stream, i.e. Audio file.

9.2 AUDIO CONVERTER

There are many audio file formats that can be played on a computer or other devices. Each
format can be somehow better than the other. As we all know that mp3 (MPEG AUDIO
LAYER 3) format is a common audio format that is widely plaved on electronic devices
mcluding mp3 players, mobiles, tablets and more.

A software that 18 used to convert one audio file format to another is called audio
converter. This software requires codec to complete this conversion. If audio file cannot be
played on the computer then one of the 3rd party codec packs, which are available free of
charge on the internet, can be used.

Ome such codec pack is K-Lite Codec Pack which is the most popular free codec pack that
can be downloaded from the internet and easily installed on the windows operating systern. It
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comes in four versions basic, standard, full and mega. This pack also installs a player known as
the Media Player Classic (MPC) with it. With this player we can play almost any kind of audio
or video file on the computer. Other software may also automatically use codecs installed with
this codec pack, for this setting in this codec-pack can also be changed.

Some of the most popular audio converter software are: Xilisoft Audio Converter, Switch

Audio Converter, Ashampoo Music Studio, Format Factory, Freemake Audio Converter And
Fre:Ac

9.2.1 Codec

Codec is a file or program used to compress & decompress a digital media file. The codecs
can be divided into two parts: the encoder and the decoder. Encoder performs the compression
(encoding) function and the decoder performs the decompression (decoding). Some codecs
contain both of these components, and some codecs include only one of them. For example,
when a song is ripped from an audio CD to our computer, Windows Media Player uses the
andio codec to compress the song by default to .wma (Windows Media Audio) file and when
~wma file is played, Windows Media Player uses the audio codec to decompress the file so that
audio can be played correctly.

9.2.2 CD ripping:

Songs on audio CDs are stored in Compact Disc Audio (.CDA) format in tracks, and these
tracks are used when playing the audio CD and play audio of very good quality. The audio CD
can be played directly to the HiFi audio systems, in-car audio players, home theatres, and
more. Usually only 5 to 10 tracks are stored on the audio CD and cannot be saved on the
computer simply via copy / pasie manner. Specialized software are required to accomplish this
task.,

The process of copyinglextract) audio tracks from audio CDs to computer and storing
them in commonly used and playable file formats (such as mp3, wav, etc.) is called CD
Ripping. This process is done using specialized software that facilitates CD Ripping.

[T the audio files in the CD are stored in .mp3 format, then this CD 15 called mp3 CD not
an audio CD.

9.2.3 Encoder Settings

Audio encoder is a program or file that helps to play an audio file format correctly and
converling to another format. It compresses digital audio data according to audio formal, It is
usually used to reduce the file size and 1o keep the quality according to file size. The encoder
is the part of codec. The encoder uses algorithm in a special way to encode.

There are generally two types of audio encoders:

(@)  That vses Lossy Conipression

(h) That uses Lossless Compression.
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9.2.3.1 Lossy Audio : This 1z a compression technique which 18 irreversible and does not
decompress audio files according to the amount of their original data, but it compresses large
amounts of audio data, resulting in smaller file size. In this technique, some of the sound
elements are removed, which affects the sound quality in an audio file and in result the audio
guality is reduced.

Lossy Audio Codecs: Aundio codecs which use lossy compression include:

1. AAC 2. AC3

3. ADPCM 4.  ATRAC

5. DTS 6. MP3

7. OGG VORBIS 8. WMA

9.2.3.2 Lossless Andio : This is a compression technique which is reversible and preserves

original data amount. This technique compresses large amounts of audio data but does not
reduce file size or sound quality, This technigue is used by professionals for andio files,

Luossless Audio Codecs:Audio codecs which use lossless compression include:
Free Lossless Audio Codec (FLAC)

Apple LosslessAudio Codec (ALAC)

Direct Stream Transfer (DST)

LA (LOSSLESS AUDIO}

WMA Lossless

Lossless Transform Audio Compression

RealAudio Lossless

WavPack Lossless

9. Lossless Predictive Audio Compression (LPAC)

9.2.3.3 Uncompressed Audio : This technique does not apply any compression to the

Bh: o3 a0 W dhe A bk R

audio file and 1s only of the quality in which the audie was recorded. Examples: pem, aiff, and
wav formats.

We usually use .mp3 audio files to play audio. Mp3 compression uses perceplual coding,
a technique based on psychological models that remove audio components (elements) from
audio files that humans are unable to hear but that results in low audio quality outpul and small
size. Usually the mp3 file is made at 128 / bps or 192 / bps. (bps: bits per second)

9.3 FREE AUDIO CONVERTER - fre:ac

Fre:ac is a free audio converter and CD ripper that supports various popular audio formats
and encoders. It ¢can convert between mp3, mp4 [ mda, wma, ogg (vorbis), flac, aac, wav
formats. With Fre:ac we can easily rip and convert our audio CDs to mp3 or wma files. This
software can be downloaded from www.freac.org.
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Figure 9.1 : Fre:ac Main Interface

9.3.1 Features Fre:ac

This is a portable application that can be copied to a pen drive and we can run it from
there.

It is easy to learn and use.

Multi-core optimized encoders are used to speed up conversion.

It has the convenience of cd ripping.

It also has full UNICODE support for tags and file names.

It can convert mp3, mp4 / mda, wma, ogg vorbis, [lac, aac, wav formats.

It is completely free and open source software.

9.3.2 Add Files to Software

To convert the files, we first need to add the files to the soltware. There are the following

COmmon
1.
2.
3.

ways o do so:

File menu — Add — Audio files or Ctrl + A
File — Add — Audio file (3) — From folder
From toolbar, using Add audio files button
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Figure 9.2 : Fre:ac adding files to software

9.3.3 Removing Files

Sometimes we need to delete some files that we accidentally added into the software to
convert. To delete files, first select the files we want to delete then use File menu — Remove or
the shortcut key Crrl + Shift + R.

9.4 VIDEO EDITING
Video editing is the process of joining video clips, photos, and audio files to make a
movie. This is usually done on a computer with video editing software known as non-linear
editors or NLE, which means we watch & edit the video without having to play the entire
video.
Generally, the task of making a movie is divided into three stages:
«  Pre-Production : This is the initial stage where the script is written, the working
people are organized, and then the shots are planned.
Production : This includes video shooting.
Post-Production : This is where video editing, audio editing and special effects are
put on video in video editing software.

9.4.1 Popular Video Editing Software
Here are some popular video editing software that can be used to edit videos (on computets
and mobile):
«  For Windows OS : Filmora Pro, Virtualdub, Pinnacle Video Spin, Sony Vegas Movie
Studio, Windows Movie Maker, OpenShot, Adobe Premiere Pro Cc, Cyberlink
PowerDirector

Android OS ; Adobe Premiere Pro. PowerDirector Video Editor, KineMaster, Viva
Video, Funimate. FilmoraGO

= i05 : LumaFusion. InShot, Adobe Premiere Rush, Splice, Magisto, iMovie

9.5 WORKING WITH VIDEO EDITORS

Almost all video editors work in the same way, so if we learn to use any one of them, we
can easily use any other video editor software. Therefore, this chapter discuszes the general
imformation about video editors.
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9.5.1 Project

Whenever we wanl to make a movie in video editing software, we should create a file and
save all settings, location of imported files, so that whenever we open the movie in the video
editing software,we can resume the work where it was left off. The file in which all these
settings are saved is called Project File. This project file can usually be saved using File —
Save, Every video editing software saves a project file with its own separate file extension. The
project file contains all information about the media files used, the story board/timeline
settings, and other important settings for special ediling environment.

9.5.2 Import Files (Audio/Video/Images)

It is useful to import all required audio, video and image files into the video editing
software so that they can be accessed from within the software. We can import new media files
and remove the imported files as needed at any time. Different software provides placeholders
(specific places) to display such imported fles, and these placeholders are given a specific
name #uch as collection panes, media files, project files, etc. From here, these files can be
dragged-and-dropped on the tracks and timeline for video editing. Normally, we can import
files by chcking on import/add using the toolbar or the file menu in the software.

9.5.3 Video Transitions

Video transition controls how a video clip will get displayed after a video clip or picture
has been played. This effect is implemented between two objects. We may apply transitions
between two pictures, video clips or titles that have been added in the story board or timeline.
Transition runs after the end of one clip and before the beginning of next clip, but many
transition effects can also be overlapped. We have to apply transition effects on the media files
added in the tracks. Transition time can also be set as required.

9.5.4 Video Effects

In video editing, video effects allow us to add a special effect to our movie. A video effect
determines how pictures, video clips, and titles are displayed in our project and in the final
movie. A video effect applies to the complete duration of pictures, video clips, or titles, (means
as long as the object is playing). Some editing software also facilitates us to set duration of this
effect.

9.5.5 Titles

Titles help us to make owr movie better by adding text-based captions to the movie. We
can include titles in the movie to indicate any type of information, such as the movie name,
release date, actor names, etc. We can also apply animation effects on titles to make a movie
more attractive.
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Figure 9.3 : Titles
9.5.6 Storyboard and Timeline

Generally, in video editing, there are two methods used in project to illustrate the lavout of

video clips. These are known as storyboard and timeline:

. Storvboard : It 1s a panel of pictures or other video-clips to make a story of movie.
It shows the sequence of photos and video clips that will be shown in the movie. We
can also rearrange the pictures or videos by dragging them in the story board.
Transition effects also do appear on it but storyboard iz not very useful when timeline
1s available.

+  Timeline : It is used (o edit the timing of clips in our project. Audio clips that we
added to our movie project are not displayed on the storyboard. They can be displayed
in the timeline panel. In the timeline view, we can also trim ¢lips and add effects,
titles, transitions and audio. It has been noted that timeline offers a more accurate
view of the project, displayving clips and events over time. It includes tracks as
needed.

9.5.7 Video Preview (Monitor)

This is the place where we can watch video clips and our movie with all the effects,
changes and more with audio, we applied using seftware, This allows us to see how the movie
will play after the final step of export/produce. This allows us to view that whatever effects are
put into the movie, how and for how long they will show up while playing the movie. There are
also some basic buttons on the monitor such as play, pause, stop, forward, rewind or to take

screenshol (caplure current [rame)

132 CoMputer Sciexon



- o=

Figure 9.4 : Monitor/Player in video editing sofiware
9.5.8 Tracks

When we import / add the video on tracks in any video editing software, the video is
splitted into 2 parts:

a.  Visual

b. Audio

The visual part has only video (without audio) and audio part has only sound/voice. These
video and audio parts are put on different video and audio tracks where we can edit them. We
can use different tracks for different audio and video parts. All video editing software provides
separate tracks for audio and video, and we can add as many tracks as we need. Tracks can be
very useful when we need to edit audio / video for a particular part. It 15 not possible to put two
clips on the same track in one place. If we want to include audio in our video as well, we need
to use more than one track. Multi-track editing is used for organizational reasons. When
working with many types of media, for example, audio, voice-over and videos from different
sources, it is a useful, efficient and easy way to use different tracks for all types of media. The
number of tracks depends on the video editing software. The best video editing software allows

the use of unlimited tracks.

00000430

Figure 9.5 ; Tracks in timeline view
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9.5.9 Export Video

The last step is to make the final movie file when we have finished editing i.e. after
applying effects, transitions, animation, titles etc, and after we have finished arranging all
media files as needed on the timeline / storyvboard and already have set their playing duration.
Each editing software provides the export facility to either export or produce and this option is
generally available i the File menu of the software,

In Exporl settings, we can select video resolution, quality, format and encoder settings.
There are also other advanced settings that we can adjust as required.
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snle | advarced |
Select 2 Profile to start;
Prothe: [naFerman =
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Target e .26 o |
Viebeo Profhe, [0 SMOp 23, 000 i (1920w 1000 =

Qualey: T - |

Figure 9.6 : Export Video

We can also select output location and file name before exporting our final video file. After
doing export, we can save our movie m PC, mobile, websites and formats hike.

MP4 - MPEG Laver 4

AVI - Audio Video Interleave

FLV - Flash Video

WMV - Windows Media Video

In the simple words, we can say that meaning of Export or Produce is to create a playable
file, which is the last step in video editing.

9.5.10 Saving & Opening Projects

Saving a project is different from Export. We should save our project after a short period
of time while working. It is best practice 1o save the project before starting the process of
exporting the video file. We can easily open a saved project file later. We can start editing right
where we left off, When we open our saved project, all the media files, storyboard / timeline
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setlings are restored for us to edit. Usually, options for saving and opening projects can be
found in the "File" menu of the soltware.

9.5.11 Video File Formats
Different file formats are generally used for different tasks. We can choose the file format
for video file as per our requirement. The file format can be changed either when exporting the
video in the video editing software or later by using the video converter software.
A common video file in digital format is made up of two parts, codec and container.
*  Video Codec is a video file used to compress and decompress. Examples of video
codecs are fimpeg. divx, xvid, and x264.
Containers on the other hand, are a set of files that store information about digital
files. It's a combination of both audio and video data in a single file that allows us to
play the same video track with andio playback at the same time. Some popular types
of containers are avi, flv, wmv, mkv, mp4, and mov.
Video File Formats used by various Platforms:
«  For Social Media : mp4 is used by Facebook, Twitier, Instagram, IgTv, and Youtube.
. For TVs and Computers : avi, moy, and mkv are the best video quality formats that
make them great option for big screen streaming.
For Websites : The webm and HTMLS video formats are used on personal and

private websites.

9.5.12 Video Cutting
Video cutting means adjusting the video to desired length as needed. Sometimes the
unwanted video needs o be removed from the beginning or from the end of the video, or
sometimes only a section of the video is required, or some part of video is to be removed, the
process of removing all such parts of video is called video cutting. Following are some of the
terms related with the video cutting:
Trim : When we trim our video, we remove some part of the clip's head (start) or tail
{end).
= Cut : This means cutting off a portion of the video clip.
= Split : When splitting longer videos into smaller sections, this is called splitting the
video.
Most video editing software includes features for trim, cul. spht, and these features can be
used while making a movie in the soltware.

9.5.13 Video Joining (Merge)

When we combine two or more videos or clips together, this is called video merge or join.
The video can be joined with the second video's head (start) or tail (end). Files of differemt
video formats can be merged il the required codecs are installed on the computer. We should
lake care of resolution when joining so that the video remaing of the same display size after
jorming.
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9.6 FREE VIDEO CUTTER JOINER

There are several software available to cut / join videos such as Free Video Cutter Joiner,
mpdtools, Format factory, Bandicut. Avidernux, Vidculter. Among these, Free Video Cutter
Joiner is a commonly used and [ree software that can be downloaded using the internet from
the web site www.dvdvideomedia.com and can be installed on a windows based computer. We
can cut and join video files easily with the help of this software.

Bl Frie Vidio Cutter Jisner VIDS -

Viden CULtEr  Yiteo Jomner bt by s B 3 oBwmre brgusge Eﬂ!!l" "

+ @ @ 00:00:00:000 | DO:00:00:000

St Pani: End PontL: Eharammn;
s

Figure 9.7 - Main Interface

9.6.1 Cutting / Splitting Video Files Using Free Video Cutter Joiner

Step 1 : Add Files : Use the Add Video File button to
add files to the software, After adding video files using the L
Add Video File button, the preview of the added file can be "
seen within the application. !

Step 2 : Set Start Point and End Point : Drag the
button on the progress bar to set the start and end point of the
video for cutting. For setting these points, click on the [ {(Square Left Brackel) button to set
starting point and click on the | (Square Right Bracket) button to set the end point for cutting
video.

Fig. 9.8 : Add Button

+ @ @ @ 00:00:00:000 { 00:00:00:000

Figure -9.9 Progress Bar with Starting and End Point Buttons

Tip : We can also enter "start point" and "end point" values directly into time boxes as
shown in figure 9.10, its format is hh:mm:ss:fff
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Start Point: End Point: Duration:
00:00:00.000 00:00:00.000 FD!DD!DD.WH

Figure -9.10 Start Point and End Point Time Values

Step 3 : Cutting Yideo File : After Setting the Start and

End Point for cutting the video, click on the "cut”
button.Following dialog box will appear and select appropriate
option. If video file is not playing properly by using option

"1.Direct Cut", then use the option "2. Indirect Cut".

As shown in the below figures, we can select different

Fig. 9.11 : Cut Button

video formats and then adjust their audio/video parameter
settings as per our requirement i.e. video file format, video size (resolution), audio quality etc.
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Figure -9.12 Direct/In-Directed Encoding
& Output/Save Window

Figure -9.13 Video Format Window

9.6.2 Join/Merge Video Files Using Free Video Cutter Joiner:

To join/merge videos using Free Video Cutter Joiner,
first of all select the "Video Joiner"tab by clicking on it, as

shown in the figure 9.14.

Step 1 : Add or Remove Files : Several Files can be
imported at once by clicking on the Add File button.If a file
has been added by mistake, select that file first and then

Bl Free Video Cutter Joiner V10.9
Video Cutter Video Joiner

T Source file \

Fig. 9.14 : Video Joiner Tab

click on Remove Bulton, The selected fle will be removed.
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Fig. 9.15 : Adding Files
Step 2 : JoinVideo Files : Select the files that we want to combine and Click on the "Join”
button.A dialog box,as shown in the figure 9.16, will appear on the screen in which we can
select settings as required.
Now, Click on Start Join Button to join/merge selected videos.
Output File Setting:
Click the browse button, set the output folder and then type the name of the file that we

want to set. The file, after joining the videos, will be saved at the selected output folder/
location.

Free Video Cutter Joiner x
Prafie;

() 1.Drect JoniNo+e-eroodng mode, very fast, only Spport same-type fis joreg)

8] 2. rdrect Joni{Re-encodng mode, very siowly, support any format, any type fle)

Video Format

(P4 - PPEGA AAC) MPEGA ("o ) g &
Widen Qualiy Viden Sire
|

3000 ks at | 10240 o
Feame Bate

LIS v

Au sty Sample Bale

e ~] IO

Fig. 9.16 : Encoding Settings
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“2> Doiits To Remember

e e
Codecs are files that enable software to play different audio file formats.
MP3 (MPEG Audio Layer 3) format is a common audio format that is widely played on
electronic devices including mp3 players, mobiles. tablets and more.
Audio files stored on the audio CD are in .CDA format. This audio format is a standard
format for compact discs.
The process of copying audio files from an audio CD to a computer is called CD ripping.
Audio encoder is a program that compresses and decodes digital audio data.
The main purpose of audio encoder is to provide the best possible audio output with a
minimum number of bits,
Video editing is the process of adding clips, photos, and audio altogether to make a
movie,
There are three stages for making a movie: pre-production, production, post-production
By splitting we can divide the video clip into several parts.

By merging we can join multiple video clips into one big video file.

EXERCISE &

Part-A
Multiple Choice Questions:
1.  In order for the computer to play audio files, different are required.
a.  Video codecs b.  Audio Codecs
¢. Botha&hb d. None
1L format 15 a common audio format that is played extensively on
electronic devices.
a  wmy b. avi
¢. mp3 d. cda
L. Audio files are stored on the Audio CD in format.
a. fv b. aac
¢.  mov d. cda

IV. The effect applied between two video-clips is called
a.  sound b.  video
¢.  video transition d. photo

V. The process of dividing the video into sections is called

#.  merging b.  spliting

¢, compressing d.  decompressing
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Write True or False:

I The process of making a movie is divided into five stages.
II.  Video editing works with only one video clip.
II. Merging a video means splitting the clip into several parts.
IV. Itis advisable to save the project before starting the process of exporting a video file.
V. MPEG-4 video format uses different compression for audio and video tracks.
Write the Full Forms of the Following:
L. MP4 ML WMV
.  AVI IV. FLV
Part-B

Short Answer Type Questions. (Write the answers in 4-5 lines)
[.  Write the names of the three stages of making a movie.

I.  Write down the names of three video editing sottware.

L. What are Audio converters ?

V. 'What do you mean by video split?

Part-C

Long Answer Type Questions. (Write the answers in 10-15 lines)
I.  What are tracks?

. Explain the video transitions.

I Write in detail: Storvboard, Timeline, Titles,

Lak Activity

Perform Audio and Video Editing Operation using any Audio and Video Editing Sofiwares

of your choice.
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Lab Activity for Typing Practice in English

APPENDIX -1

EXERCISE I
asdfg  ;ligh asdfg  :ligh asdfg  :ligh asdfg skjh asdfg
asdfg  ;lkjh asdfg Jkjh asdfg Jdkjh asdfg JIkjh asdfg
asdfg  :lkjh asdfg  :lkjh asdfzg  :lkjh asdfg Jlgh asdfg
asdfg  ;lkjh asdfg  ;ligh asdfg  :lkjh asdfg Akjh asdfg
asdfg  ;lkjh  asdfg  :lkjh  asdfg  :lkjh asdfg slkjh asdfg
EXERCISE II
Ask Fad Alsas  Shad Lads  Flags Flask
Jag Fag Fall Hash Glad  Galls Salad
Jak Had Gall Dash Gall Flash Slash
Sad Lad Adds  Lash Hall Lakhs Dhalls
Dad Asgks Alas Dall Fall Glass Shall
EXERCISE I
gwert  poiuy gwert  poiuy qwert  poiuy  qwert poiuy  qwert
poiuy  gqwert poiuy  gwert peoiny  gwert  poiuy qwert  poiuy
gwerlt  poluy  gwert  poluy gwerl  poluy gwerl poiuy  gwerl
poiuy gwert poiuy  (wert poiny  gwert  poiuy gwert  poiuy
gwert  poiuy  gwert  poiny  gwerl  poiuy  gwerl poiuy  gwert
poiuy  gwert poiuy gwerl pomy  gwerl  poiuy qwert poiuy
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EXERCISE IV

awerqfa L0iupj: awerqfa :oiupj; awerfa roiupj:
awergfa J0Iup); awergfa OIUPY: awerqfa ;oiupj:
awerqfa -0iupj; awerqfa ;olupy; awercfa ;0iupj;
awerqfa solupj: awergfa Joiupj: awergfa solupj;
awergla ;olup]; awergfa soiupi; awerqfa soiup];
EXERCISE V
Fish Drirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usnal Sales Filed Legal
Lease Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would Alpine
Taded Liked Equip Quail Jokes Asked Walks
Fiddle  Saddle Dead Filed Lakes Leaze Legal
EXERCISE VI
azxcvf lkkmnhbj azxcvl lkkmnbj azxcvl lkmnbj
azxevf Ikmmnbyj azxevl lkmnbj azxcvf lkmnbj
azxevl lemnbj azxcvl lkmnbj arxevi Ikmnbj
azxcvi Ikminh;j azxcvl Ikmnhj azxcvt lkmnhj
azxevl lkmnnbj azrxevf lkmnbj azxevl lkmnbj
EXERCISE VI
Cat Jack Colour Neither Enemy Boat Caleutta
Naot Have  Joints Calling Voted Very Yineyard
Met Wind  Nerves Enlarge Money Move Material
Men Verb Verbal Someone Marry Give Sterling
Bent  Joimt  Jackets  Examine  Thousand  Cylinder  Assessment
King Carry  Jumbled Examined  Struggle Possible Beginning
Zeal Night Booklet  Gracious Grizzled Frequent Meanings
Zero Tonic ~ Cutting  Becoming  Zodiacal Exponent  Doubtless
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EXERCISE VIII

12345 098767 12345 (98767 12345 098767
12345 098767 12345 D98767 12345 098767
12345 098767 12345 098767 12345 098767
12345 098767 12345 098767 12345 098767
12345 098767 12345 (98767 12345 008767

EXERCISE IX

Type the following sentences 5 times:

Lost time is never regained

Get-up early and do your work

Today's yvouth and tomorrow's old

Age is a virtue when wisdom i with it.
Measure your word belore it goes out of you
My steps are measured

A friend in need is a friend indeed

Children are innocent and should be guided rightly.

o 08 =1 o b B LR

Our Land has great sages who knew the eternal truth.

—_—
&

Truth never fails

—_—
—_—

The Quick Brown Fox Jumps Over A Lazy Dog

EXERCISE X

Type the following paragraph 10 times:

Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE is
the symbaol of purity, love and peace. GREEN is the symbol of plenty and joy. We hoist
and salute our flag. We are ready to make sacrifices for our country. We want peace and
progress, We want o be pure.
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APPENDIX - II

Lab Activity for Typing Practice in Punjabi (Using Anmol Lipi Fonl)

Sresar  ®aAg Gresar ®mEwg Brogar mawg  Svesar mEwo
Sresar maag Sresar wmeAe Onegar mawag  GResar mEA9
Gresar ®BaAg GFesd maAg Gregar maAg  GResar mEHO
ST mEAY Oresar BEAY Srvsar ®mEag  Svesar B9
oo maEAg Sresar  maAd Grezar ®ang  Gwesar  mER9
HOME ROW EXERCISE - 11
HEUEW [ BHY HHOBEW BuY HHOEW [BYY HWHOSW &Y
HETRW BYY wHUSW BYY WHOSW ®YT MATEW BT
WHUEW BUg WHTEW [BYE WHTEW ®YT HHOEW [ BHY
WHUSW  BUg HATEW  BYY WMHTEW BT HATEY SUY
HEUSW BHY WHTEW Yy WATEW BYY HHTEW  BUY
SECOND ROW EXERCISE-III
FriEsy uy-f = ITfEgz ¥ s L Irfggz (Bt A
grfeges uf_ ™ grfegz o] 2oy S gTtfeae 0
Ivfege yuyf_ '+ 3Trfegs 3 it i grfgge 5 dE Rl
grfege y - f_~ grfege yf > grfege il
g fege y f_—- 3grfege y>f > grfege g e
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SECOND ROW EXERCISE-IV

gt&'s g™t gtE€ 5 e 1. ®FfE'® -l
gt6:'s i gt & -l L - s
gt g 3 R gt€ & e Tt wtEs gy T
TG 5 . il e : i e " wtgs . S oL
: U o - TG, & T 1" miEw R gl
HOME ROW AND SECOND ROW EXERCISE-V
Greazv Cfouw; Greggs @ N
Gregzs @ Cfouw; Gregzz e cfouw;
regzzd Cfouw; Greagzzs g i o
Gregzz @ T Gregsse R R T
Q@regzz€ S T i Grrazz€ o e O

HOME ROW AND SECOND ROW EXERCISE-VI

=g gfgaw T BEERe  wuumE  uEbeE v@wmn g9l
Sfew sgeee mEfe  _AG® HE®ER efmewe BEGE
zebwe B5Er  wEfsE TAmEw wasSe sloam  HERW
TaaH TdE mafss | uEE WaSHA T _omE  wsufse
yBere  wfaee E=fu a8fs Er) wHaEee  "@sen
efoemy geeser  uefe efmee wEeer wERRE  wEagw
HOME/SECOND/THIRD ROW EXERCISE -VII

Gasg=g FAHEEA HATEITE mE'gy
S B i TAHETEA HATETT TH'gy
Gazg=z TEAHEEA HIATESITE sg'ay
Cw=zo=w TAHNEEA HATETE mi'gy
Grzwesz EEHEEHA HIATEITE si'gy
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FOURTH ROW EXERCISE-VIII

-

12345 098767 | #4% HE*()
12345 098767 T HA% HE*()
12345 098767 S #4% HE*()
12345 098767 1 #4% HE*()
“12345 N98767 Tl #4% HE*()
EXERCISE - IX
wrier LLC W B9 feam
afuges fargme AgS U Ufires
HE™ HOT&T EEICIES fegtur favria
ECIE fefaam afeg feam Ut
faet s A3t W IHarg
wat=afret At Ut &7 HEH Gl CES Hates
HHat HETHE UASeHs ey AUSHIE
A Guaféar frrrey fes afoe
THSET AT Frer YHT Hy=
gar g5 wy AT farzmat
fedu= feier e Frargd wfeTe
EXERCISE - X
e gat=ainel ufeasr € Sein 9% 37, 7Aus i & ferr fagent w3 demet

fegmar € Wit . su=is fiw, . ssee iy 9w, 37. @feee fiw o »Eee fée
aufont g, Iafees fw w2 7. g9adte flw & f-fedter a0 @ sifaer reeenie
foowma st & faw ot ==t avew 3 fewrer enge AW fiees ¢ 3 09 faF =t uarst
fag fouzr 5oz fur T farur 91 68 39 far ot wiru=t o0 St wus faw fitzg at o
< FEs 3 Unret f&w g9 maw 71 falfe feo e god Jvrdl gatds &2 (=)
&= & w95 &t Agez Gusey geeger I
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APPENDIX - III

ab Activity for Typing Practice in Punjabi {Using Raavi Unicode Font)

o

El

= o =xdn Al

lgd R o awa ufges ega ugx Iva ava wue gee9 fag faa uga 339

EC)
2u vaa fge o3 Bz By g5 I 593 bR e
93 e day f339 fagqg 399 @ 393 wda 999 fa=g
W foe ofe wow wa3 Aw@ N T AW o\ fg e
g2 dgad v y ue O fae daa fee Fw awd [Ba3 hig da9
yga faq e fou Ju w9a8 Tod @09 99 ogd | 999 fags
e 92 A3 wue fwag 393 fue awe fee 899 303 93 day ule fee

: ® ] [
; Enter

4 Erdd & ERY reEmn o SEE

g N NE Fgu
g flme g gan
g U@ Imqmgy o
u_-‘ﬂrl!:u_:n!u

w

d M ny g ¥
D"m""l'-lf.u:ﬁ‘

Y P g A A AS P e Q@ e e i
wow B oW ow owou oy oa owm P

-

n#iﬂ.i:ﬂfl‘
E.:ii.::ﬂ nﬂ
I\ﬂlﬁﬁl'?mﬂ g.ﬂ

m:ﬂtui?ﬂ
o ¥ e g g
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504 wuuz e Q3 wzeQ wibd sumit seue o09 wde eus @9 wIQ g
wes wus usef wa@ w@ sz wsQ uwz 3 P3 6u fw s6n ume @5 Q@
e @@ Qo fomy ude @ Qe seve My we seus @5 wiftd seue wd
ygw W@ »firg vz otz oG wWQ va vz @ smm Gesu usw Iw soafe
M 30 Q@ waQ wus wa@ W@ 20w Q5 M weQ ow Q9 wwE ud
BYS g2 g3 bean 200 uz by 23 sesll wilbe eudz sexll Gz wifbg
3§ @y 83 o3 u3f Guzu Zowe fim o2 wiftg oty =9 Gesn wofte um
EF' @ e Hel Hd8 &w abd &GH <@ wHs @4 HAQ Hue dHae (b k@
&8 yaw ot senfe senfc ©es @7 sow Tus 50u wQ um
nifed nifex sas 2@ w#ift \uy fonwied seefE Wt gEs

wifrs
#ifr e me wifr wift wiv G Gy sus PE uE Seus um

Z
&£
ET
[

B . ® * oo@e Qe T 0w m A" @ * B e W g @ @|F o
® o @y o 222 T o@wma w e L ama e a e W
B & ¢« ¢ & = A a8 5 q B L= ar @ ' & s W W =
@l @ g oa AAaS R T g o 3o gAog oS 2 FE A =
o L NS T - (O A < BT N - - B T T - | @3 o8’ 5 5
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W W ¥ W OW o 9 " ¥ & o 5 . - = v a4 = ¥ = L. - |
g A | o4 | oA oo ool c W oo " < S &8 ™8 g W S g W T WD

MW oo A P I e oww v A gge O

A R et w o g
A o ol e 3 g s e aE A dle Sl modll o s SE ed
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He gwE I o O 9@E 2 T T ¢ OF OHaw 9 W F T Fa W It e
sl il ool evdll aretd) dige el e HE Setdl ar o clla 3 S8 Ao 3
B g gfwE and Fen o dta S ogae Bowm o= 9 @w o# A e srar o e
UoH oA i A am G S ] agm 2 o=l Fen dis e hergl =it
#Ma oga Sa de el g wge e oawesdl g A @ ol sred g 3 sar @

H

donT wE Fe o w it s 5 ot el @R A F el # e @\ o v
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e ¢ v on v & vm o wde wo v i om o H Bw P 8 8 ot oo
Har vog 9 dOF TR OVME O gito W TE O O Ogm ¥ OvE v W @ Gt s
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I Row (Upper Row) — Practice Lesson using Shift Key

ad | wai || Ewr e || TQ@ ||z ||us || 1w || og || prs || {= }w I
L q wd |leo || rat || cg || v® ud i & 0d pA |lLL¥ || 12 A
fewAensoesd@wessedAGgyweRswyusy
W oe e oop 3 8@ wesd A d oweE w A e e s g Ioe
8§ 1§37 e3P IYeTISSEI NS W ITLYEITETT T ES
W E @ EE T A AT W TN NI W T W oA T EE
Boorw A RETwowr AT TH TG TN H WA W T oW
@ W gy 99w w g Qe ygawmy owEs d G ey s d ou o
T wAgw I IITITGUSTIEUTRERNT YR G
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W owhes wsEH 59 e ws @39l wed ves W TeYn veEvn ge slEnm ves
Aum we ws ooy AQ wm@d] W@ wly we vin dlum S0 s wos e
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APPENDIX - IV

COMMONLY USED FULL FORMS

ACRONYM FULL FORM

Al ARTIFICIAL INTELLIGENCE

ARPANET ADVANCED RESEARCH PROJECT AGENCY NETWORK
BMP BITMAF PICTURE

bpi BITS PER INCH

CD COMPACT DISK

CPU CENTRAL PROCESSING UNIT

CSS CASCADING STYLE SHEET

CUl CHARACTER USER INTERFACE

DOS DISK OPERATING SYSTEM

DRAM DYNAMIC RANDOM ACCESS MEMORY

DSL DIGITAL SUBSCRIBER LINE

DVD DIGITAL VIDEO DISK

E COMMERCE ELECTRONIC COMMERCE

EEPROM ELECTRONICALLY ERASABLE PROGRAMMABLE READ

ONLY MEMROY

EMAIL ELECTRONIC MAIL

EPROM ERASABLE PROGRAMMABLE READ ONLY MEMROY
FTP FILE TRANSFER PROTOCOL

GB GIGABYTE

GIF GRAPHICS INTERCHANGE FORMAT

GUI GRAPHICAL USER INTERFACE

HTML HYPER TEXT MARKUP LANGUAGE

IAP INTERNET ACCESS PROVIDER

IBM INTERNATIONAL BUSINESS MACHINE

IC INTEGRATED CIRCUIT

ISDN INTEGRATED SERVICES DIGITAL NETWORK
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ISP

INTERNET SERVICE PROVIDER

IT

INFORMATION TECHNOLOGY

JPEG JOINT PHOTOGRAFHIC EXPERTS GROUP

KB KILOBYTE

MB MEGABYTE

MIDI MUSICAL INSTRUMENT DIGITAL IDENTIFIER
MODEM MODULATER DEMODULATER

MPEG MOVING PICTURE EXPERTS GROUP

MROM MASKED READ ONLY MEMORY

NIC NETWORK INTERFACE CARD

PB PETA BYTE

P PERSONAL COMPUTER

PNG PORTABLE NETWORK GRAPHICS

POP POST OFFICE PROTOCOL

PROM PROGRAMMABLE READ ONLY MEMORY
RAM RANDOM ACCESS MEMORY

ROM READ ONLY MEMORY

RTF RICH TEXT FORMAT

SERP SEARCH ENGINE RESULT PAGE

SMTP SIMPLE MAIL TRANSFER PROTOCOL

SRAM STATIC RANDOM ACCESS MEMORY

B TERABYTE

TCP/P TRANSMITION CONTROL PROTOCOL/INTERNET PROTOCOL
ULSI ULTRA LARGE SCALE INTEGRATED CIRCUIT
UPS UNINTERRUPTIBLE POWER SUPPLY

LURL UNIFORM RESOURCE LOCATER

USB UNIVERSAL SERIAL BUS

VLSI VERY LARGE SCALE INTEGRATED CIRCUIT

wWww

WORLD WIDE WEB
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APPENDIX - V

COMMONLY USED SHORTCUT KEYS
(MS WORD)

Shorteut Key Used for
Crl+A Select All

Ctrl+B Bold the selected text

Corl+C Copy the selected contents
Crl+D Opens the Font Dialog Box
Crrl+E Center Align text

Ctrl+F Find text

Cirl+G Goto line/page no etc.

Crrl+H Replace text

Ctrl+l [talic the selected text

Ctrl+J Justify paragraph

Crrl+K Create Hyperlink for the selected text
Ctrl+L Left Align the paragraph
Cul+M Increase Indent

Crrl+N Create a New File

Cirl+0 Open Existing File

Ctrl+FP Print File

Crrls0 Clear Indents and Tabs

Curl+R Right Align the text

Crrl+8 Save File

Ctr+ T Increase Hanging Indent

Cirl+U Underline the selected contents
Ctrl+V Paste the contents from the clipboard
Cul+W Close File

Cirl+-X Cut the selected contents
Ctrl+Y Redo the last action (if possible)
Ctrl+-Z LUndo the last operation

Cirl+1 Single Line Spacing

Cirl+2 Double Line Spacing

Cirl+5 1.5 Line Spacing
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Cirl+] Increase Font Size

Ctrl+[ Decrease Font Size

Citrl+Shifi+C Copy the Formats of selected text
Cirl+Shifi+V Paste the copied Formats on selected text
Shift+F3 Change Case

F7 Spelling and Grammar Check

Al+F4 Close Program
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COMMONLY USED SHORTCUT KEYS
(MS EXCEL)

Shortcut Key Used for

Crl + A Select the entire worksheet. If the cursor is currently placed within a
table, press once to select the table, press one more time to select the
whole worksheet.

Cul + B Bold Text of Selected Cell/Cells

Cil + C Copy the contents of the selected cells to Clipboard.

Cul +D Copy the contents and format of the first ¢cell n the selected range mto
the cells below, If more than one column i3 selected, the contents of
the topmost cell in each column will be copied downwards.

Cil+ F Display the "Find" dialog box.

Curl + Fl Show [ hide the Excel Ribbon,

Cul + G Open the "Go to" dialog. Pressing F5 displays the same dialog.

Cul+ N Create a new workbook.

Ctrl + O Open an existing workbook.

Cirl + P Open the "Print" dialog.

Cul+ 5 Save the active workbook.

Col+T "Convert selected cells to a table,

Cul +V Pate contents of the Clipboard into the selected cell(s).

Crd+ W Close the active workbook.,

Cil + X Cut the contents of the selected cells to Chipboard.

Crl +Y Repeat (Redo) the last action. if possible.

Ciul+ Z Undo last action.

Ctrl + 1 Open the "Format Cells” dialog.

Crrl +° Toggle between displaying cell values and formulas.

Ctrl +; Enter the current date,

Ctrl + Shift + ;

Enter the current time

F2 Edit the current cell.

F4 Cycle through various combinations of formula reference types. Place
the cursor within a cell and hit F4 to gel the needed reference type:
absolute, relatve or mixed

F12 Displays the Save as dialog box.

Home Return to the 1st cell of the current row in a worksheet.

Tab Autocomplete the function mame.
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Ctrl + End

Move to the last used cell of the current worksheet

Cirl + Home Move to the beginming of a worksheet

Ctrl + Pghown Switch to the next worksheet

Cirl + Pglip Switch to the previous worksheet

Alt + Enter In cell editing mode, enter a new line (carriage return) into a cell.

Crrl + Space

Select the entire column,

Shift + Space

Select the entire row.
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